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 1
I n t r o d u c t i o n  
This guide introduces you to LiveLink for MATLAB, which extends your 
COMSOL modeling environment with an interface between COMSOL 
Multiphysics and MATLAB. The COMSOL Java API Reference Guide provides 
additional documentation of the API.
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Abou t  L i v e L i n k  f o r  MAT LAB

LiveLink for MATLAB connects COMSOL Multiphysics to the MATLAB scripting 
environment. Using this functionality you can do the following.

S E T  U P  M O D E L S  F R O M  A  S C R I P T

LiveLink for MATLAB includes the COMSOL API Java, with all necessary functions 
and methods to implement models from scratch. For each operation you do in the 
COMSOL Desktop there is a corresponding command you can type at the MATLAB 
prompt. This is a simplified Java based syntax, which does not required any knowledge 
of Java. Available methods are listed in the COMSOL Java API Reference Guide. The 
simplest way to learn this programing syntax is to save the model as a M-file directly 
from the COMSOL Desktop.

You can read more about building a model using the command line in the chapter 
Building Models.

U S E  M AT L A B  F U N C T I O N S  I N  M O D E L  S E T T I N G S

Use LiveLink for MATLAB to set model properties with a MATLAB function. For 
instance define material property or boundary condition as a MATLAB routine that is 
evaluated while the model is solved.

How you can do this in the COMSOL Desktop is described in chapter Calling 
MATLAB Function.

L E V E R A G E  M AT L A B  F U N C T I O N A L I T Y  F O R  P R O G R A M  F L O W

Use the API syntax together with MATLAB functionality to control the flow of your 
programs. For instance implement nested loops using for or while commands, or 
implement conditional model settings with if or switch statements. You can also 
handle exceptions using try and catch. Some of these operations are described in the 
sections Running Models in Loop and Handling Errors And Warnings, which you find 
in the chapter Working With Models.

A N A L Y Z E  R E S U L T S  I N  M AT L A B

API wrapper functions included with LiveLink for MATLAB make it easy to extract 
data at the command line. Functions are available to access results at node points or 
arbitrary location. You can also obtain low level information of the extended mesh, 
such as finite element mesh coordinates, or connection information between the 
1 :  I N T R O D U C T I O N



elements, and nodes. Extracted data is available as MATLAB variables, ready to be used 
with any MATLAB function. See the sections Extracting Results and Retrieving Xmesh 
Information from the chapter Working With Models.

C R E A T E  C U S T O M  I N T E R F A C E S  F O R  M O D E L S

Use the MATLAB Guide functionality to create a user defined graphical interface that 
is combined with a COMSOL model. Make your models available for others by 
creating graphical user interfaces tailored to expose settings and parameters of your 
choice.
A B O U T  L I V E L I N K  F O R  M A T L A B  |  9
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He l p  and Do cumen t a t i o n

In this section:

• Getting Help

• Where Do I Access the Documentation and the Model Library?

• Typographical Conventions

Getting Help

COMSOL and LiveLink for MATLAB contains several sources of help and 
information.

• To get started with LiveLink for MATLAB, it is recommended that you read the 
Introduction to LiveLink for MATLAB. It contains detailed examples about how 
to get you started with the product.

• Save models as an M-file. 

Use the COMSOL Desktop to get your first model implemented using the COMSOL 
Java API. 

Set-up the model using the graphical user interface, then save the model as a M-file. 
To proceed go to the File menu and select Save as M-file. This generates a M-function 
that you can run using COMSOL with MATLAB. 

• Study the LiveLink for MATLAB Model Library

LiveLink for MATLAB includes a model library with detailed example models. Use 
the function mphmodellibrary at the command line to get a list of available 
models, which includes: 

- In the model domain_activation_llmatlab you can see how to activate and 
deactivate domain alternatively during a transient analysis.

- The model homogenization_llmatlab shows how to simulate a periodic 
homogenization process in a space-dependent chemical reactor model. This 
homogenization removes concentration gradients in the reactor at a set time 
interval.

- The model pseudoperiodicity_llmatlab you can see how to simulate convective 
heat transfer in a channel filled with water. To reduce memory requirements, the 
model is solved repeatedly on a pseudo-periodic section of the channel. Each 
solution corresponds to a different section, and before each solution step the 
 1 :  I N T R O D U C T I O N



temperature at the outlet boundary from the previous solution is mapped to the 
inlet boundary.

- The model thermos_llmatlab shows how to use MATLAB function callback. 
This example solves for the temperature distribution inside a thermos holding hot 
coffee.

- Finally in the model busbar_llsw_llmatlab you can see perform geometry 
optimization using COMSOL, MATLAB, and SolidWorks.

Do not forget to check the ones listed below to get you up-to-speed with modeling:

• Access the on-line documentation with the function mphdoc.

• Read this user guide to get detailed information about the different parts of the 
model object and how these are accessed from MATLAB. The Command Reference 
chapter describes the function available for use with LiveLink for MATLAB.

• The COMSOL Java API Reference Guide contains reference documentation that 
describes the methods in the model object.

Where Do I Access the Documentation and the Model Library?

A number of Internet resources provide more information about COMSOL 
Multiphysics, including licensing and technical information. The electronic 
documentation, Dynamic Help, and the Model Library are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N

The COMSOL Multiphysics User’s Guide and COMSOL Multiphysics Reference 
Guide describe all interfaces and functionality included with the basic COMSOL 
Multiphysics license. These guides also have instructions about how to use COMSOL 
Multiphysics and how to access the documentation electronically through the 
COMSOL Multiphysics help desk.

If you are reading the documentation as a PDF file on your computer, the 
blue links do not work to open a model or content referenced in a 
different user’s guide. However, if you are using the online help in 
COMSOL Multiphysics, these links work to other modules, model 
examples, and documentation sets.

Important
H E L P  A N D  D O C U M E N T A T I O N  |  11
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To locate and search all the documentation, in COMSOL Multiphysics:

• Press F1 for Dynamic Help, 

• Click the buttons on the toolbar, or

• Select Help>Documentation ( ) or Help>Dynamic Help ( ) from the main menu

and then either enter a search term or look under a specific module in the 
documentation tree.

T H E  M O D E L  L I B R A R Y

Each model comes with documentation that includes a theoretical background and 
step-by-step instructions to create the model. The models are available in COMSOL 
as MPH-files that you can open for further investigation. You can use the step-by-step 
instructions and the actual models as a template for your own modeling and 
applications.

SI units are used to describe the relevant properties, parameters, and dimensions in 
most examples, but other unit systems are available.

To open the Model Library, select View>Model Library ( ) from the main menu, and 
then search by model name or browse under a module folder name. Click to highlight 
any model of interest, and select Open Model and PDF to open both the model and the 
documentation explaining how to build the model. Alternatively, click the Dynamic 

Help button ( ) or select Help>Documentation in COMSOL to search by name or 
browse by module.

The model libraries are updated on a regular basis by COMSOL in order to add new 
models and to improve existing models. Choose View>Model Library Update ( ) to 
update your model library to include the latest versions of the model examples.

If you have any feedback or suggestions for additional models for the library (including 
those developed by you), feel free to contact us at info@comsol.com.

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 
support@comsol.com. An automatic notification and case number is sent to you by 
email.
 1 :  I N T R O D U C T I O N
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Typographical Conventions

All COMSOL user’s guides use a set of consistent typographical conventions that make 
it easier to follow the discussion, understand what you can expect to see on the 
graphical user interface (GUI), and know which data must be entered into various 
data-entry fields.

In particular, these conventions are used throughout the documentation:

Main Corporate web site www.comsol.com 

Worldwide contact information www.comsol.com/contact 

Technical Support main page www.comsol.com/support 

Support Knowledge Base www.comsol.com/support/knowledgebase 

Product updates www.comsol.com/support/updates 

COMSOL User Community www.comsol.com/community 

CONVENTION EXAMPLE

text highlighted in blue Click text highlighted in blue to go to other information 
in the PDF. When you are using the online help desk in 
COMSOL Multiphysics, these links also work to other 
modules, model examples, and documentation sets.

boldface font A boldface font indicates that the given word(s) appear 
exactly that way on the COMSOL Desktop (or, for toolbar 
buttons, in the corresponding tip). For example, the Model 
Builder window ( ) is often referred to and this is the 
window that contains the model tree. As another example, 
the instructions might say to click the Zoom Extents button 
( ), and this means that when you hover over the button 
with your mouse, the same label displays on the COMSOL 
Desktop.

Forward arrow symbol > The forward arrow symbol > is instructing you to select a 
series of menu items in a specific order. For example, 
Options>Preferences is equivalent to: From the Options 
menu, choose Preferences.

Code (monospace) font A Code (monospace) font indicates you are to make a 
keyboard entry in the user interface. You might see an 
instruction such as “Enter (or type) 1.25 in the Current 
density field.” The monospace font also is an indication of 
programming code or a variable name. 
H E L P  A N D  D O C U M E N T A T I O N  |  13
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K E Y  T O  T H E  G R A P H I C S

Throughout the documentation, additional icons are used to help navigate the 
information. These categories are used to draw your attention to the information 
based on the level of importance, although it is always recommended that you read 
these text boxes. 

Italic Code (monospace) 
font

An italic Code (monospace) font indicates user inputs and 
parts of names that can vary or be defined by the user.

Arrow brackets <> 
following the Code 
(monospace) or Code 
(italic) fonts

The arrow brackets included in round brackets after either 
a monospace Code or an italic Code font means that the 
content in the string can be freely chosen or entered by the 
user, such as feature tags. For example, 
model.geom(<tag>) where <tag> is the geometry’s tag 
(an identifier of your choice). 

When the string is predefined by COMSOL, no bracket is 
used and this indicates that this is a finite set, such as a 
feature name. 

ICON NAME DESCRIPTION

Caution A Caution icon is used to indicate that the user should proceed 
carefully and consider the next steps. It might mean that an 
action is required, or if the instructions are not followed, that 
there will be problems with the model solution.

Important An Important icon is used to indicate that the information 
provided is key to the model building, design, or solution. The 
information is of higher importance than a note or tip, and the 
user should endeavor to follow the instructions.

Note A Note icon is used to indicate that the information may be of 
use to the user. It is recommended that the user read the text.

Tip A Tip icon is used to provide information, reminders, short 
cuts, suggestions of how to improve model design, and other 
information that may or may not be useful to the user.

See Also The See Also icon indicates that other useful information is 
located in the named section. If you are working on line, click 
the hyperlink to go to the information directly. When the link is 
outside of the current PDF document, the text indicates this, 
for example See The Laminar Flow Interface in the 
COMSOL Multiphysics User’s Guide. Note that if you are in 
COMSOL Multiphysics’ online help, the link will work.

CONVENTION EXAMPLE
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Model The Model icon is used in the documentation as well as in 
COMSOL Multiphysics from the View>Model Library menu. If 
you are working online, click the link to go to the PDF version 
of the step-by-step instructions. In some cases, a model is only 
available if you have a license for a specific module. These 
examples occur in the COMSOL Multiphysics User’s Guide. 
The Model Library path describes how to find the actual model 
in COMSOL Multiphysics, for example 

If you have the RF Module, see Radar Cross Section: Model 
Library path RF_Module/Tutorial_Models/radar_cross_section

Space Dimension Another set of icons are also used in the Model Builder—the 
model space dimension is indicated by 0D , 1D , 1D 
axial symmetry , 2D , 2D axial symmetry , and 3D 

 icons. These icons are also used in the documentation to 
clearly list the differences to an interface, feature node, or 
theory section, which are based on space dimension.

ICON NAME DESCRIPTION
H E L P  A N D  D O C U M E N T A T I O N  |  15
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 2
G e t t i n g  S t a r t e d
This chapter has these sections:

• The Client-Server Architecture

• Running COMSOL with MATLAB

• Calling a MATLAB Function From the COMSOL Desktop
 17
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Th e  C l i e n t - S e r v e r  A r c h i t e c t u r e

LiveLink for MATLAB uses the client-server mode to connect COMSOL Multiphysics 
and MATLAB. When starting COMSOL with MATLAB, two processes are started— 
a COMSOL server and the MATLAB desktop. The MATLAB process is a client 
connected to the COMSOL server using a TCP /IP communication protocol.

The first time you start COMSOL with MATLAB, you are requested to provide login 
information. This information is stored in the user preferences file and is not requested 
for later use of COMSOL with MATLAB. The same login information may be used 
when exchanging the model object between the COMSOL server and a COMSOL 
Desktop.

The communication between the COMSOL server and MATLAB is established by 
default using port number 2036. If this port is in use, port number 2037 is used 
instead, and so on.

The COMSOL Desktop is not involved.

Note

You can manually specify the port number. See COMSOL Server 
Commands in the COMSOL Multiphysics Installation and Operations 
Guide for more information on the COMSOL server start-up properties.

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

To locate and search all the documentation for this information, in 
COMSOL, select Help>Documentation from the main menu and either 
enter a search term or look under a specific module in the documentation 
tree.

See Also

Important

Tip
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Runn i n g  COMSOL w i t h  MAT LAB

The command to run COMSOL with MATLAB automatically connect a COMSOL 
process with MATLAB. You can also connect the process manually. This section 
describe the procedures to start COMSOL with MATLAB both automatically and 
manually. You will also see how to change the MATLAB path in the COMSOL 
settings.

In this section:

• Starting COMSOL with MATLAB on Windows / Mac OSX / Linux

• Connecting the COMSOL Server and MATLAB Manually

• Changing the MATLAB Version

Starting COMSOL with MATLAB on Windows / Mac OSX / Linux

To run a COMSOL model at the MATLAB prompt you need to start COMSOL with 
MATLAB.

• On Windows use the COMSOL with MATLAB shortcut icon that is created on the 
desktop after the automatic installation. In addition, you can find a link in the 
Windows start menu, under All Programs > COMSOL 43 > COMSOL 4.3 with MATLAB.

• On Mac OS X, use the COMSOL with MATLAB application available in the application 
folder.

• On Linux enter the command comsol server matlab at a terminal window.

See the COMSOL Multiphysics Installation and Operations Guide to 
get a complete description on how to start COMSOL with MATLAB on 
the different supported platforms. See Also
R U N N I N G  C O M S O L  W I T H  M A T L A B  |  19
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Connecting the COMSOL Server and MATLAB Manually

You can also manually connect MATLAB to a COMSOL server. This can be useful if 
you need to start first MATLAB stand-alone and then connect to a COMSOL server, 
or if you need to connect MATLAB and a COMSOL server running on different 
computers.

To manually connect MATLAB to a COMSOL server you need first to start MATLAB 
and a COMSOL server. 

To start a COMSOL server: 
• On Windows go to the start menu All Programs>COMSOL 4.3> Client Server>COMSOL 

Multiphysics 4.3 server. 

• On Mac OS X or Linux enter comsol server at a terminal window.

To connect MATLAB to the COMSOL server :
1 In MATLAB, add the path of the COMSOL43/mli directory. 

2 Enter the command below at the MATLAB prompt:

mphstart(<portnumber>)

Where <portnumber> is the port used by the COMSOL server. If the COMSOL 
server is listening on the default port, 2036, you do not need to specify the port 
number.

A D J U S T I N G  T H E  M AT L A B  J A V A  H E A P  S I Z E

You may need to modify the MATLAB Java heap size to be able to manipulate the 
model object and extract data at the MATLAB prompt. See the section Improving 
Performance for Large Models.

The first time COMSOL with MATLAB is started, you are asked for login and 
password information. This is necessary to establish the client/server 
connection. The information is then saved in the user preference file and 
is not requested again. 

If you want to reset the login information, add the flag -login force to 
the icon target path on Windows or, for Mac OS X and Linux operating 
systems, enter the command comsol server matlab -login force at 
a system command prompt.

Note
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C O N N E C T I N G  M AT L A B  A N D  T H E  C O M S O L  S E R V E R  O N  D I F F E R E N T  

C O M P U T E R S

To connect MATLAB and a COMSOL server that are running on different computers, 
specify in the function mphstart the IP address of the computer where the COMSOL 
server is running:

mphstart(<ipaddress>, <portnumber>)

I M P O R T I N G  T H E  C O M S O L  C L A S S

Once you have manually connected MATLAB and the COMSOL server, the 
COMSOL class needs to be imported. Enter the following command at the MATLAB 
prompt:

import com.comsol.model.*
import com.comsol.model.util.* 

Disconnecting MATLAB and the COMSOL Server
To disconnect MATLAB and the COMSOL server, run the command below at the 
MATLAB prompt:

ModelUtil.disconnect;

Changing the MATLAB Version

The path of the MATLAB version connected to COMSOL is defined during the initial 
COMSOL installation. You can change the MATLAB root path using the preferences 
file:

1 In the COMSOL Desktop, go to the Options menu and select Preferences. 

2 In the Preferences window, go to LiveLink products.

3 Set the MATLAB root directory path in the MATLAB installation folder field.

4 Windows OS users also need to click Register MATLAB as COM Server button, 
otherwise the specified MATLAB version may not start when calling external 
MATLAB function from the COMSOL model.

This operation requires the specific license type called Floating Network 
License (FNL).

Note
R U N N I N G  C O M S O L  W I T H  M A T L A B  |  21
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5 Click OK.

6 To update the preferences file, close the COMSOL Desktop.
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Ca l l i n g  a  MAT LAB Fun c t i o n  F r om t h e  
COMSOL De s k t o p

Use LiveLink for MATLAB to call MATLAB functions from within the model when 
working in the COMSOL Desktop. The procedure is slightly different than 
implementing a model using a script as you do not need to run COMSOL with 
MATLAB. 

Start COMSOL as a stand-alone. The external MATLAB function needs to be defined 
in the COMSOL model so that a MATLAB process can automatically start when the 
function needs to be evaluated. The result of the function evaluation in MATLAB is 
then sent back to the COMSOL environment.

Calling MATLAB Function
See Also
C A L L I N G  A  M A T L A B  F U N C T I O N  F R O M  T H E  C O M S O L  D E S K T O P  |  23
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  2 :  G E T T I N G  S T A R T E D



 3
B u i l d i n g  M o d e l s  
This chapter gives an overview of the model object and provides an introduction 
to building models using the LiveLink interface. In this chapter:

• The Model Object

• Working with Geometry

• Working with Meshes

• Modeling Physics

• Creating Selections

• The Study Node

• Analyzing the Results
 25
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Th e  Mode l  Ob j e c t

While working with the LiveLink interface in MATLAB you work with models 
through the model object. Use methods to create, modify, and access your model.

In this section:

• Important Notes About the Model Object

• The Model Object Methods

• The General Utility Functionality

• Loading and Saving a Model

• Exchanging Models Between MATLAB and the COMSOL Desktop

Important Notes About the Model Object

The following information should be considered regarding the model object:

• All algorithms and data structures for the model are integrated in the model object.

• The model object is used by the COMSOL Desktop to represent your model. This 
means that the model object and the COMSOL Desktop behavior are virtually 
identical.

• The model object includes methods for setting up and running sequences of 
operations to create geometry, meshes, and for solving your model.

LiveLink for MATLAB includes the COMSOL Java API, which is a Java-based 
programming interface to COMSOL. In addition, the product includes a number of 
M-file utility functions, that wrap API functionality for greater ease of use.

The Model Object Methods

The model object provides a large number of methods. The methods are structured in 
a tree-like way, very similar to the nodes in the model tree in the Model Builder 
window on the COMSOL Desktop. The top-level methods just return references that 
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support further methods. At a certain level the methods perform actions, such as 
adding data to the model object, performing computations, or returning data.

The General Utility Functionality

The model object utility methods are available with the ModelUtil object. These 
methods can be used, for example, to create or remove a new model object, but also 
to enable the progress bar or list the model object available in the COMSOL server.

M A N A G I N G  T H E  C O M S O L  M O D E L  O B J E C T

Use the method ModelUtil.create to create a new model object in the COMSOL 
server:

model = ModelUtil.create('Model');

This command creates a model object Model on the COMSOL server and a MATLAB 
object model that is linked to the model object.

It is possible to have several model objects on the COMSOL server, each with a 
different name. To access each model object you need to have different MATLAB 
variables linked to them, each MATLAB variable having a different name.

Create a MATLAB variable linked to an existing model object with the method 
ModelUtil.model. For example, to create a MATLAB variable model that is linked to 
the existing model object Model on the COMSOL server, enter the command:

Detailed documentation about model object methods is in the About 
General Commands section in the COMSOL Java API Reference 
Guide.

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

To locate and search all the documentation for this information, in 
COMSOL, select Help>Documentation from the main menu and either 
enter a search term or look under a specific module in the documentation 
tree.

See Also

Important

Tip
T H E  M O D E L  O B J E C T  |  27
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model = ModelUtil.model('Model');

To remove a specific model object use the method ModelUtil.remove. For instance 
to remove the model object Model from the COMSOL server enter the command:

ModelUtil.remove('Model');

Alternatively remove all the COMSOL objects stored in the COMSOL server with the 
following command:

ModelUtil.clear

List the names of the model objects available on the COMSOL server with the 
command:

list = ModelUtil.tags

A C T I V A T I N G  T H E  P R O G R E S S  B A R

While running COMSOL with MATLAB, by default no progress information is 
displayed. You can manually enable a progress bar to visualize the progress of 
operations such as loading a model, creating a mesh, assembling matrices, or 
computing the solution. Enter the command:

ModelUtil.showProgress(true);

To deactivate the progress bar enter:

ModelUtil.showProgress(false);

Loading and Saving a Model

L O A D I N G  A  M O D E L  A T  T H E  M AT L A B  P R O M P T

To load an existing model saved as an MPH-file use the function mphload. For 
example to load the Busbar model from the Model Library enter:

model = mphload('busbar.mph');

This creates a model object Model on the COMSOL server that is accessible using the 
MATLAB variable model.

The progress bar is not supported on Mac OS X.

Note
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If there is already a model object Model linked to a MATLAB variable model, you can 
load the model using a different name with the command:

model2 = mphload('busbar.mph','Model2');

When using the function mphload, the model history is automatically disabled, to 
prevent large history information when running a model in a loop. If you want to turn 
model history on you can use the function mphload as follows:

model = mphload('busbar.mph','-history');

The history recording can be useful when working using the COMSOL Desktop. All 
the operations are then stored in the saved model M-file.

S A V I N G  A  M O D E L  O B J E C T

Use the function mphsave to save the model object linked to the MATLAB object 
model:

mphsave(model,'filename')

If the filename specified 'filename' does not provide a path the file is saved relatively 
to the local MATLAB path. The file extension determines which format to use (*.mph, 
*.m or *.java).

Alternatively you can use the save method:

model.save('filename');

If 'filename' does not provide a path the file is saved relatively to the local COMSOL 
server path.

Any files saved in the MPH format can be loaded by the COMSOL Desktop. In 
addition you can save your model as a Model M-file:

model.save('model_name','m');

Exchanging Models Between MATLAB and the COMSOL Desktop

It is possible to alternate between the MATLAB scripting interface and the COMSOL 
graphical user interface in order to edit and/or modify the model object. When 

The models are not automatically saved between MATLAB sessions.

Note
T H E  M O D E L  O B J E C T  |  29
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running COMSOL with MATLAB, the model object is stored on the COMSOL 
server. You can directly load the model object in the COMSOL Desktop from the 
COMSOL server or, conversely, export the model object available in the COMSOL 
Desktop to the COMSOL server.

E X P O R T I N G  F R O M  T H E  C O M S O L  D E S K T O P  A  M O D E L  T O  M A T L A B

In the COMSOL Desktop, use the option Export to Server from the File menu to send 
the model object to the COMSOL server that is connected with MATLAB. Once the 
model object is on the COMSOL server, create a link in the MATLAB prompt.

Follow the steps below to export a model from the COMSOL Desktop to MATLAB:

1 Open a model in the COMSOL Desktop.

2 From the File menu, choose Client Server>Export Model to Server.

3 Make sure that the Server and the Port fields are set with the correct information 
(default values are localhost and 2036). To establish the connection between the 
COMSOL Desktop and the COMSOL server enter a Username and a Password; 
these are defined the first time you connect to the COMSOL server.

4 Enter the name of the model object to export (the default name is Model).

5 Click OK.

6 In MATLAB, create a link to the model object on the COMSOL server with the 
command:

model = ModelUtil.model('Model');

If the model has been exported to the COMSOL server using a different 
name, replace Model with the correct name of the exported model. Use 
the command: ModelName = ModelUtil.tags to obtain the list of 
model objects available on the COMSOL server.Note
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I M P O R T I N G  A  M O D E L  I N  T H E  C O M S O L  D E S K T O P  F R O M  M AT L A B

To import a model from a COMSOL server to the COMSOL Desktop, choose Client 

Server>Import Model from Server from the File menu. This dialog box is similar to the 
Client Server>Export Model to Server dialog box. 

The COMSOL server may hold several models, this is why it is mandatory 
to enter the name of the model for the import procedure.

Important
T H E  M O D E L  O B J E C T  |  31
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Work i n g  w i t h  Geome t r y

This section describes how to set up and run a geometry sequence. In this section:

• The Geometry Sequence Syntax

• Displaying the Geometry

• Working with Geometry Sequences

• Exchanging Geometries with the COMSOL Desktop

• Importing and Exporting Geometries and CAD Models from File

• Retrieving Geometry Information

• Modeling with a Parameterized Geometry

• Images and Interpolation Data

The Geometry Sequence Syntax

Create a geometry sequence by using the syntax

model.geom.create(<geomtag>, sdim);

where <geomtag> is a string that you use to refer to the geometry. The integer sdim 
specifies the space dimension of the geometry, it can be either 0, 1, 2 or 3.

To add an operation to a geometry sequence, use the syntax

model.geom(<geomtag>).feature.create(<ftag>, operation);

• Geometry Modeling and CAD Tools in the COMSOL Multiphysics 
User’s Guide

• Geometry in the COMSOL Java API Reference Guide

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

See Also

Important
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where <geomtag> is the string you defined when creating the geometry. The string 
<ftag> is a string that you use to refer to the operation. 

You may want to set feature property with different values than the default. Use the 
set method as in the command below:

model.geom(<geomtag>).feature(<ftag>).set(property, <value>);

where <ftag> is the string defined when creating the operation. 

To build the geometry sequence, enter

model.geom(<geomtag>).run;

Alternatively you can also build the geometry sequence up to a given feature ftag with 
the command:

model.geom(<geomtag>).run(<ftag>);

Displaying the Geometry

Use the function mphgeom to display the geometry in a MATLAB figure

mphgeom(model);

You can also specify the geometry to display with the command:

mphgeom(model, <geomtag>);

When running mphgeom the geometry node is automatically build. Set the build 
property to specify how the geometry node is supposed to be built before displaying 
it. Use this command:

mphgeom(model, <geomtag>, 'build', build);

For a list of geometry operations, see About Geometry Commands in the 
COMSOL Java API Reference Guide.

Note

For a property list available for the geometry features see Geometry in the 
COMSOL Java API Reference Guide.

Note
W O R K I N G  W I T H  G E O M E T R Y  |  33
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where build is a string with the following value: 'off', 'current', or the geometry 
feature tag <ftag>, which, respectively, does not build the geometry, builds the 
geometry up to the current feature, or builds the geometry up to the specified 
geometry feature node.

Use the parent property to specify the axes handle where to display the plot:

mphgeom(model, <geomtag>, 'parent', <axes>);

The following property is also available to specify the vertex, edge, or face rendering: 
edgecolor, edgelabels, edgelabelscolor, edgemode, facealpha, facelabels, 
facelabelscolor, facemode, vertexlabels, vertexlabelscolor, vertexmode.

Use mphgeom to display a specified geometry entity. To set the geometry entity, enter 
the entity property and set the geometry entity index in the selection property to:

mphgeom(model, <geomtag>, 'entity', entity, 'selection', <idx>);

where entity can be either 'point', 'edge', 'boundary', or 'domain', and <idx> 
is a positive integer array that contains the list of the geometry entity indices.

Working with Geometry Sequences

This section shows how to create geometry sequences using the syntax outlined in The 
Geometry Sequence Syntax.

C R E A T I N G  A  1 D  G E O M E T R Y

From the MATLAB command prompt, create a 1D geometry model by adding a 
geometry sequence and then add geometry features. The last step is to run the 
sequence using the run method.

Before starting, create a model object:

model = ModelUtil.create('Model');

Then continue with the commands

geom1 = model.geom.create('geom1',1);

i1=geom1.feature.create('i1','Interval');

For more information about 1D geometry modeling, see Creating a 1D 
Geometry Model in the COMSOL Multiphysics User’s Guide. 

See Also
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i1.set('intervals','many');
i1.set('p','0,1,2');

geom1.run;

To create a geometry sequence with a 1D solid object consisting of vertices at x  =  0, 1, 
and 2, and edges joining the vertices adjacent in the coordinate list.

Then enter

p1=geom1.feature.create('p1','Point');
p1.set('p',0.5);

geom1.run;

to add a point object located at x  =  0.5 to the geometry.

To plot the result, enter

mphgeom(model,'geom1','vertexmode','on')

C R E A T I N G  A  2 D  G E O M E T R Y  U S I N G  P R I M I T I V E  G E O M E T R Y  O B J E C T

Creating Composite Objects
Use a model object with a 2D geometry.

model = ModelUtil.create('Model');

For more information about 2D geometry modeling, see Creating a 2D 
Geometry Model in the COMSOL Multiphysics User’s Guide.

See Also
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geom2 = model.geom.create('geom2',2);

Continue by creating a rectangle with side length of 2 and centered at the origin:

sq1 = geom2.feature.create('sq1','Square');
sq1.set('size',2);
sq1.set('base','center');

The property size describes the side lengths of the rectangle, and the property pos 
describes the positioning. The default is to position the rectangle about its lower left 
corner. Use the property base to control the positioning.

Create a circular hole with a radius of 0.5 centered at (0, 0):

c1 = geom2.feature.create('c1','Circle');
c1.set('r',0.5);
c1.set('pos',[0 0]);

The property r describes the radius of the circle, and the property pos describes the 
positioning. The property pos could have been excluded because the default position 
is the origin. The default is to position the circle about its center.

Drill a hole in the rectangle by subtracting the circle from it: 

co1 = geom2.feature.create('co1','Compose');
co1.selection('input').set({'c1' 'sq1'});
co1.set('formula','sq1-c1');

A selection object is used to refer to the input object. The operators +, *, and - 
correspond to the set operations union, intersection, and difference, respectively.

The Compose operation allows you to work with a formula. Alternatively use the 
Difference operation instead of Compose. The following sequence of commands 
starts with disabling the Compose operation.

co1.active(false)

dif1 = geom2.feature.create('dif1','Difference');
dif1.selection('input').set({'sq1'});
dif1.selection('input2').set({'c1'});

Run the geometry sequence to create the geometry and plot the result

geom2.run;
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mphgeom(model,'geom2');

Trimming Solids
Continue with rounding the corners of the rectangle by the Fillet operation.

fil1 = geom2.feature.create('fil1','Fillet');
fil1.selection('point').set('dif1', [1 2 7 8]);
fil1.set('radius','0.5');

Run the sequence again:

geom2.run;

The geometry sequence is updated with rounded corners. To view the result, enter

mphgeom(model,'geom2');
W O R K I N G  W I T H  G E O M E T R Y  |  37



38 |  C H A P T E R
C R E A T I N G  A  2 D  G E O M E T R Y  U S I N G  B O U N D A R Y  M O D E L I N G

Use the following commands to create six open curve segments that together form a 
closed curve.

model = ModelUtil.create('Model');

g1 = model.geom.create('g1',2);

w=1/sqrt(2);

c1 = g1.feature.create('c1','BezierPolygon');
c1.set('type','open');
c1.set('degree',2);
c1.set('p',[-0.5 -1 -1;-0.5 -0.5 0]);
c1.set('w',[1 w 1]);

c2 = g1.feature.create('c2','BezierPolygon');
c2.set('type','open');
c2.set('degree',2);
c2.set('p',[-1 -1 -0.5;0 0.5 0.5]);
c2.set('w',[1 w 1]);

c3 = g1.feature.create('c3','BezierPolygon');
c3.set('type','open');
c3.set('degree',1);
c3.set('p',[-0.5 0.5; 0.5 0.5]);

c4 = g1.feature.create('c4','BezierPolygon');
c4.set('type','open');
c4.set('degree',2);
c4.set('p',[0.5 1 1; 0.5 0.5 0]);
c4.set('w',[1 w 1]);

c5 = g1.feature.create('c5','BezierPolygon');
c5.set('type','open');
c5.set('degree',2);
c5.set('p',[1 1 0.5; 0 -0.5 -0.5]);
c5.set('w',[1 w 1]);

c6 = g1.feature.create('c6','BezierPolygon');
c6.set('type','open');
c6.set('degree',1);
c6.set('p',[0.5 -0.5; -0.5 -0.5]);

The objects c1, c2, c3, c4, c5, and c6 are all curve2 objects. The vector [1 w 1] 
specifies the weights for a rational Bézier curve that is equivalent to a quarter-circle arc. 
The weights can be adjusted to create elliptical or circular arcs.

Convert the curve segments to a solid by the following conversion command.
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csol1 = g1.feature.create('csol1','ConvertToSolid');
csol1.selection('input').object('g1');
csol1.selection('input').set({'c1' 'c2' 'c3' 'c4' 'c5' 'c6'});

Then issue a final run command.

g1.run;
mphgeom(model,'g1');

C R E A T I N G  3 D  G E O M E T R I E S  U S I N G  S O L I D  M O D E L I N G

This section demonstrates how to create 3D solids using workplanes and Boolean 
operations.

Create a 3D geometry with an xy work plane at z = 0:

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1', 3);

wp1 = geom1.feature.create('wp1', 'WorkPlane');
wp1.set('planetype', 'quick');
wp1.set('quickplane', 'xy');

Add a rectangle to the work plane, then add fillet to its corners:

r1 = wp1.geom.feature.create('r1', 'Rectangle');
r1.set('size',[1 2]);

For more information about 3D geometry modeling, see Creating a 3D 
Geometry Model in the COMSOL Multiphysics User’s Guide.

See Also
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geom1.run

fil1 = wp1.geom.feature.create('fil1', 'Fillet');
fil1.selection('point').set('r1', [1 2 3 4]);
fil1.set('radius', '0.125');

geom1.runCurrent;

ext1 = geom1.feature.create('ext1', 'Extrude');
ext1.set('distance', '0.1');

Add another yz work plane, at x = 0.5:

wp2 = geom1.feature.create('wp2', 'WorkPlane');
wp2.set('planetype', 'quick');
wp2.set('quickplane', 'yz');
wp2.set('quickx', '0.5');

b1 = wp2.geom.feature.create('b1', 'BezierPolygon');
b1.set('type', 'open');
b1.set('degree', [1 1 1 1]);
b1.set('p', 
{'0.75','1','1','0.8','0.75';'0.1','0.1','0.05','0.05','0.1'});
b1.set('w', {'1','1','1','1','1','1','1','1'});

wp2.geom.feature.create('csol1', 'ConvertToSolid');
wp2.geom.feature('csol1').selection('input').set({'b1'});

Revolve the triangle from the yz work plane:

rev1 = geom1.feature.create('rev1', 'Revolve');
rev1.selection('input').set({'wp2'});
rev1.setIndex('pos', '1', 0);

Add the difference operation that computes the final 3D geometry.

dif1 = geom1.feature.create('dif1', 'Difference');
dif1.selection('input').set({'ext1'});
dif1.selection('input2').set({'rev1'});

To run the sequence, enter

model.geom('geom1').run;

To view the geometry enter
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mphgeom(model);

Exchanging Geometries with the COMSOL Desktop

E X C H A N G I N G  A  G E O M E T R Y  F R O M  C O M S O L  D E S K T O P

To transfer a geometry from the COMSOL Desktop to the LiveLink interface in 
MATLAB use one of these methods:

• Export the geometry as a COMSOL Multiphysics binary (.mphbin) file from the 
COMSOL Desktop. Right-click geometry node and select Export to File. Then 
create a geometry import feature from MATLAB

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1', 3);

imp1 = geom1.feature.create('imp1','Import');
imp1.set('filename','geometryfile.mphbin');
imp1.importData;

geom1.run;

• Save the model containing the geometry sequence from the COMSOL Desktop. 
Create a model object from MATLAB and load the file into it.

• Export the model containing the geometry sequence to the COMSOL server.
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Importing and Exporting Geometries and CAD Models from File

With COMSOL Multiphysics, you can import and export geometries in a variety of file 
formats. Below is a short summary of the various file formats.

C O M S O L  M U L T I P H Y S I C S  F I L E S

A natural choice for storing geometries in 1D, 2D, and 3D is the native file format of 
COMSOL’s geometry kernel (.mphtxt and .mphbin). 

2 D  C A D  F O R M A T S

COMSOL Multiphysics supports import and export for the DXF ® file format, a data 
interchange format of the CAD system AutoCAD ®. You can also import files in the 
neutral GDS format. ECAD geometry file format requires either the AC/DC Module 
or the RF Module.

3 D  C A D  F O R M A T S

It is possible to import surface meshes in the STL and VRML formats. With a license 
for the CAD Import Module, or one of the LiveLink for CAD products, you can 
import most 3D CAD file formats: Parasolid®, ACIS® (SAT®), STEP, IGES, Pro/
ENGINEER®, Autodesk Inventor ®, and SolidWorks ®. See the individual user guides 
for detailed information.

Retrieving Geometry Information 

Start by creating a simple 3D geometry:

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1', 3);
geom1.feature.create('blk1','Block');

The .mphtxt or .mphbin file formats are only used for geometry and 
mesh objects. It is not the same as a Model MPH-file (.mph).

Note

To retrieve the detailed information about the geometry in a model, see 
Geometry Object Information in the COMSOL Java API Reference 
Guide.Note
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geom1.feature.create('con1','Cone');
geom1.run;

To visualize the geometry in a MATLAB figure window enter:

mphgeom(model)

The model object contains general geometry information methods. For example to 
determine the space dimension of the geometry, enter:

geom1.getSDim

There are also methods for determining the number of geometrical entities; for 
example, to inquire about the number of domains, and the number of boundaries:

geom1.getNDomains
geom1.getNBoundaries

Another group of geometry information methods concern adjacency properties of the 
geometric entities, for example, the number of up and down domain information on 
each boundary:

geom1.getUpDown

There are also methods for evaluating properties, like coordinate values and curvatures 
on faces and edges. The following example evaluates coordinates on face 1 for the face 
parameters (2, 0.005)

geom1.faceX(1,[2,0.005])

To get the parameters of a given face, use the method faceParamRange(N), where N 
is the face number. For example:

geom1.faceParamRange(1)
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returns the parameters for face 1.

To get the parameter range of an edge you can use the edgeParamRange(N) method. 
For instance to get the length of edge number 3 enter:

geom1.edgeParamRange(3)

To get the coordinate and the curvature data along a specified edge enter: 

geom1.edgeX(2,0.5)
geom1.edgeCurvature(2,0.5)

There are also methods for getting information about the internal representation of 
the geometry, for example, the coordinates of the geometry vertices:

geom1.getVertexCoord

In addition, you can fetch geometry information from elements in the geometry 
sequence. To do this, you can, for example, enter

geom1.object('blk1').getNBoundaries

Modeling with a Parameterized Geometry

COMSOL has built-in support for parameterized geometries. Parameters can be used 
in most geometry operations. To exemplify parameterizing a geometry, the following 
script studies the movement of a circular source through two adjacent rectangular 
domains:

model = ModelUtil.create('Model');
model.param.set('a','0.2');

geom1 = model.geom.create('geom1',2);

r1 = geom1.feature.create('r1','Rectangle');
r1.set('size',[0.5 1]);
r1.set('pos',[0 0]);

r2 = geom1.feature.create('r2','Rectangle');
r2.set('size',[0.6 1]);
r2.set('pos',[0.5 0]);

c1 = geom1.feature.create('c1','Circle');
c1.set('r',0.1);
c1.set('pos',{'a','0.5'});

geom1.run;
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mphgeom(model);

Change the position of the circle by changing the value of parameter a:

model.param.set('a','0.5');

geom1.run;

mphgeom(model);

Create a loop that changes the position of the circle in increments:

for a=0.2:0.1:0.5
  model.param.set('a',a);
  geom1.run;
end

Create a mesh:
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model.mesh.create('mesh1', 'geom1');

Add a Weak Form PDE interface:

w = model.physics.create('w', 'WeakFormPDE', 'geom1');
w.feature('wfeq1').set('weak', 1, '-test(ux)*ux-test(uy)*uy');

dir1 = w.feature.create('dir1', 'DirichletBoundary', 1);
dir1.selection.set([1 2 3 6 7]);

src1 = w.feature.create('src1', 'SourceTerm', 2);
src1.set('f', 1, '1');
src1.selection.set([3]);

Then, create a stationary study step:

std1 = model.study.create('std1');

stat1 = std1.feature.create('stat1', 'Stationary');

Create a parametric sweep feature:

p1 = model.batch.create('p1','Parametric');
p1.set('pname', 'a');
p1.set('plist','range(0.2,0.1,0.8)');
p1.run;

Alternatively, you can run the parametric sweep using a MATLAB for loop:

for a=0.2:0.1:0.8
  model.param.set('a',a);
  std1.run;
end

Notice that after updating a parameter that affects the geometry, COMSOL detects 
this change and automatically updates the geometry and mesh before starting the 
solver. The geometry is associative, which means that physics settings are preserved as 
the geometry changes.

Images and Interpolation Data

This section describes how to generate geometry from a set of data points by using 
interpolation curves, and how to create geometry from image data.

C R E A T I N G  A  G E O M E T R Y  U S I N G  C U R V E  I N T E R P O L A T I O N

Use the interpolation spline feature to import a set of data points that describe a 2D 
geometry. To create an interpolation spline feature enter:

model.geom(<geomtag>).feature.create(<ftag>,'InterpolationCurve')
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Then specify data points in a table:

model.geom(<geomtag>).feature(<ftag>).set('table',<data>)

Where <data> can either be a 2xN cell array or a 2xN array.

Control the type of geometry generated by the operation with the command:

model.geom(<geomtag>).feature(<ftag>).set('type',type)

Where type can either be 'solid' to generate a solid object, 'closed' to generate a 
closed curve or 'open' to generate an open curve.

Example 
Create a set of data points in MATLAB, then use these to construct a 2D geometry. 

1 Create data points that describe a circle, sorted by the angle, and remove some of 
the points:

phi = 0:0.2:2*pi;
phi([1 3 6 7 10 20 21 25 28 32]) = [];
p = [cos(phi);sin(phi)];

2 Add some noise to the data points.

randn('state',17)
p = p+0.02*randn(size(p));

3 Create a 2D geometry with a square:

model = ModelUtil.create('Model');

4 Add a square geometry:

geom1 = model.geom.create('geom1', 2);

sq1 = geom1.feature.create('sq1', 'Square');
sq1.set('base', 'center');
sq1.set('size', '3');

5 Now add an interpolation curve feature:

ic1 = geom1.feature.create('ic1', 'InterpolationCurve');

6 Use the variable p for the data points:

ic1.set('table', p');

7 Specify a closed curve:

ic1.set('type', 'closed');

8 Finally plot the geometry with the mphgeom command:
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mphgeom(model);

C R E A T I N G  G E O M E T R Y  F R O M  I M A G E  D A T A

Use the function mphimage2geom to create geometry from image data. The image data 
format can be M-by-N array for a grayscale image or M-by-N-by-3 array for a true 
color image.

If you specify the image data and the level value that represents the geometry contour 
you want to extract, the function mphimage2geom returns a model object with the 
desired geometry.

model = mphimage2geom(<imagedata>, <level>)

where imagedata is a C array containing the image data and level is the contour level 
value used to generate the geometry contour.

Specify the type of geometry object generated.

model = mphimage2geom(<imagedata>, <level>, 'type', type)

See the MATLAB function imread to convert an image file to image data.

Note
 3 :  B U I L D I N G  M O D E L S



where type is 'solid' if you want to generate a solid object, 'closed' to generate a 
closed curve object, or 'open' to generate an open curve geometry object.

With the property curvetype you specify the type of curve to use to generate the 
geometry object.

model = mphimage2geom(<imagedata>, <level>, 'curvetype', curvetype)

where curvetype can be set to 'polygon' if you want to use polygon curve. The 
default curve type creates a geometry with the best suited geometrical primitives. For 
interior curves it uses Interpolation Curves, while for curves that are touching the 
perimeter of the image Polygon curve is used.

To scale the geometry use the scale property.

model = mphimage2geom(<imagedata>, <level>, 'scale', scale)

where scale is a double value.

Set the minimum distance between coordinates in curve with the mindist property.

model = mphimage2geom(<imagedata>, <level>, 'mindist', mindist)

where mindist is a double value.

Set the minimum area for interior curves.

model = mphimage2geom(<imagedata>, <level>, 'minarea', minarea)

where minarea is a double value.

In case of overlapping solids the function mphimage2geom automatically create a 
Compose node in the model object. If you do not want such a geometry feature, you 
can set the property compose to off:

model = mphimage2geom(<imagedata>, <level>, 'compose', 'off')

You can create a rectangle domain surrounding the object generated with the property 
rectangle:

model = mphimage2geom(<imagedata>, <level>, 'rectangle', 'on')

Example: Convert Image Data to Geometry
This example illustrates how to create geometry based on gray scale image data. First 
generate the image data in MATLAB and display the contour in a figure. Then, create 
a model object including the geometry represented by the contour value 40.

Enter the commands below at the MATLAB prompt:

p = (peaks+7)*5;
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[c,h] = contourf(p);
clabel(c, h);
model = mphimage2geom(p, 40);
figure(2)
mphgeom(model)

 

Use the property type to create closed or open curves. For example, to create a 
geometry following contour 40 with closed curves enter:

model = mphimage2geom(p, 40, 'type', 'closed');
mphgeom(model)

To scale the geometry, use the scale property. Using the current model scale the 
geometry with a factor of 0.001 (1e-3):

model = mphimage2geom(p, 40, 'scale', 1e-3);
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mphgeom(model)

You can also insert a rectangle in the geometry to have an outer domain surrounding 
the created contour. Set the property rectangle to on as in the command below:

model = mphimage2geom(p, 40, 'rectangle', 'on');
mphgeom(model)
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Work i n g  w i t h  Me s h e s

This section describes how to set up and run meshing sequences in a model.

• The Meshing Sequence Syntax

• Displaying the Mesh

• Mesh Creation Functions

• Importing External Meshes and Mesh Objects

• Measuring Mesh Quality

• Getting Mesh Statistics Information

• Getting and Setting Mesh Data 

The Meshing Sequence Syntax

Create a meshing sequence by using the syntax

model.mesh.create(<meshtag>, <geomtag>);

where <meshtag> is a string that you use to refer to the sequence. The tag geomtag 
specifies the geometry to use for this mesh node.

To add an operation to a sequence, use the syntax

model.mesh(<meshtag>).feature.create(<ftag>, operation);

• Creating Meshes in the COMSOL Multiphysics User’s Guide

• Mesh in the COMSOL Java API Reference Guide

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

See Also

Important
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where the string <ftag> is a string that you use to refer to the operation. 

To set a property to a value in a operation, enter

model.mesh(<meshtag>).feature(<ftag>).set(property, <value>);

Finally to build the mesh sequence, enter

model.mesh(<meshtag>).run;

Alternatively you can run the mesh node up to a specified feature node <ftag>:

model.mesh(<meshtag>).run(ftag);

Displaying the Mesh

To display the mesh in a MATLAB figure, use the function mphmesh. Make sure that 
the mesh is built before calling the command below:

mphmesh(model);

If you have several meshes in your model specify the mesh to display as in the command 
below:

mphmesh(model, <meshtag>);

Use the parent property to specify the axes handle where to display the plot:

mphmesh(model, <meshtag>, 'parent', <axes>);

The following properties are also available to specify the vertex, edge or face rendering: 
edgecolor, edgelabels, edgelabelscolor, edgemode, facealpha, facelabels, 
facelabelscolor, facemode, meshcolor, vertexlabels, vertexlabelscolor, 
vertexmode.

See About Mesh Commands in the COMSOL Java API Reference 
Guide.

See Also

For more details on available operations and properties in the sequence, 
see Mesh in the COMSOL Java API Reference Guide.

See Also
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Mesh Creation Functions

M E S H  S I Z I N G  P R O P E R T I E S

The Size attribute provides a number of input properties that you can use to control 
the mesh element size such as:

• The maximum and minimum element size.

• The element growth rate.

• The resolution of curvature.

• The resolution of narrow regions

These properties are available both globally and locally.

There are nine predefined settings you can use to set a suitable combination of values 
for many properties. To select one of these settings, use the property hauto and pass 
an integer from 1 to 9 as its value to describe the mesh resolution:

• Extremely fine (1)

• Extra fine (2)

• Finer (3)

• Fine (4)

• Normal (5)

• Coarse (6)

• Coarser (7)

• Extra coarse (8)

• Extremely coarse (9)

The default value is 5, that is, the Normal mesh settings.

Example—Creating a 2D Mesh with Triangular Elements
Generate a triangular mesh of a unit square:

model = ModelUtil.create('Model');

For details about predefined mesh size settings and mesh element size 
parameters, see Size in the COMSOL Java API Reference Guide.

See Also
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geom1 = model.geom.create('geom1',2);
geom1.feature.create('r1','Rectangle');

mesh1 = model.mesh.create('mesh1','geom1');
ftri1 = mesh1.feature.create('ftri1','FreeTri');
mesh1.run;

mphmesh(model);

Figure 3-1: Default mesh on a unit square.

The default size feature is generated with the property hauto set to 5, that is, 

mesh1.feature('size').set('hauto','5');

To override this behavior, set hauto to another integer. You can also override by 
setting specific size properties, for example, making the mesh finer than the default by 
specifying a maximum element size of 0.02:

mesh1.feature('size').set('hmax','0.02');
mesh1.run;

mphmesh(model);

This value corresponds to 1/50 of the largest axis-parallel distance, whereas the default 
value is 1/15.
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Figure 3-2: Fine mesh (maximum element size = 0.02).

Sometimes a nonuniform mesh is desirable. Make a mesh that is denser on the left side 
by specifying a smaller maximum element size only on the edge segment to the left 
(edge number 1):

mesh1.feature('size').set('hauto','5');

size1 = ftri1.feature.create('size1','Size');
size1.set('hmax','0.02');
size1.selection.geom('geom1',1);
size1.selection.set(1);

mesh1.run

mphmesh(model);
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Figure 3-3: Nonuniform mesh.

The Free Meshing Method
The default method for generating free triangle meshes in 2D is based on an advancing 
front algorithm. To switch to a Delaunay algorithm use the value del for the method 
property. Follow the example below, where you start by creating a geometry.

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1',2);

geom1.feature.create('r1','Rectangle');

c1 = geom1.feature.create('c1','Circle');
c1.set('r','0.5');

co1=geom1.feature.create('co1','Compose');
co1.selection('input').object('geom1');
co1.selection('input').set({'c1' 'r1'});
co1.set('formula','r1-c1');

geom1.runAll;

mesh1 = model.mesh.create('mesh1','geom1');

ftri1 = mesh1.feature.create('ftri1','FreeTri');
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ftri1.set('method','del');

mesh1.run;

mphmesh(model,'mesh1')

Figure 3-4: Mesh created with the Delaunay method.

Example—Creating a 2D Mesh with Quadrilateral Elements
To create an unstructured quadrilateral mesh on a unit circle enter:

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1',2);

geom1.feature.create('c1','Circle');

mesh1 = model.mesh.create('mesh1','geom1');

mesh1.feature.create('ftri1','FreeQuad');

mesh1.run;

mphmesh(model)
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Figure 3-5: Free quad mesh.

C R E A T I N G  S T R U C T U R E D  M E S H E S

To create a structured quadrilateral mesh in 2D, use the Map operation. This operation 
uses a mapping technique to create the quadrilateral mesh. 

Use the EdgeGroup attribute to group the edges (boundaries) into four edge groups, 
one for each edge of the logical mesh. Using the Distribution attribute you can also 
control the edge element distribution, which determines the overall mesh density.

Example—Creating a Structured Quadrilateral Mesh
Create a structured quadrilateral mesh on a geometry where the domains are bounded 
by more than four edges:

model = ModelUtil.create('Model');
geom1 = model.geom.create('geom1',2);
geom1.feature.create('r1','Rectangle');
r2 = geom1.feature.create('r2','Rectangle');

Map in the COMSOL Java API Reference Guide
See Also
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r2.set('pos',[1 0]);
c1 = geom1.feature.create('c1','Circle');
c1.set('r','0.5');
c1.set('pos',[1.1 -0.1]);
dif1 = geom1.feature.create('dif1', 'Difference');
dif1.selection('input').set({'r1' 'r2'});
dif1.selection('input2').set({'c1'});
geom1.run('dif1');

mesh1 = model.mesh.create('mesh1','geom1');

map1 = mesh1.feature.create('map1','Map');

eg1 = map1.feature.create('eg1', 'EdgeGroup');
eg1.selection.set(1);
eg1.selection('edge1').set([1 3]);
eg1.selection('edge2').set(2);
eg1.selection('edge3').set(8);
eg1.selection('edge4').set(4);

eg2 = map1.feature.create('eg2', 'EdgeGroup');
eg2.selection.set(2);
eg2.selection('edge1').set(4);
eg2.selection('edge2').set([6 9 10]);
eg2.selection('edge3').set(7);
eg2.selection('edge4').set(5);

mesh1.run;
mphmesh(model);

Figure 3-6: Structured quadrilateral mesh (right) and its underlying geometry.

The left-hand side plot in Figure 3-6 is obtained with the following command:

mphgeom(model, 'geom1', 'edgelabels','on')
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The EdgeGroup attributes specify that the four edges enclosing domain 1 are 
boundaries 1 and 3; boundary 2; boundary 8; and boundary 4. For domain 2 the four 
edges are boundary 4; boundary 5; boundary 7; and boundaries 9, 10, and 6.

B U I L D I N G  A  M E S H  I N C R E M E N T A L L Y

You can create meshes in a step-by-step fashion by creating selections for the parts of 
the geometry that you want to mesh in each step. The following example illustrates 
this:

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1',2);
geom1.feature.create('r1','Rectangle');
geom1.feature.create('c1','Circle');
uni1 = geom1.feature.create('uni1', 'Union');
uni1.selection('input').object('geom1');
uni1.selection('input').set({'c1' 'r1'});
geom1.runCurrent; 
del1 = geom1.feature.create('del1', 'Delete');
del1.selection('input').object('geom1', 1);
del1.selection('input').set('uni1', 8);
geom1.run('del1');

mesh1 = model.mesh.create('mesh1','geom1');

dis1 = mesh1.feature.create('dis1', 'Distribution');
dis1.selection.set([2 4]);
dis1.set('type', 'predefined');
dis1.set('method', 'geometric');
dis1.set('elemcount', '20');
dis1.set('reverse', 'on');
dis1.set('elemratio', '20');

dis2 = mesh1.feature.create('dis2', 'Distribution');
dis2.selection.set([1 3]);
dis2.set('type', 'predefined');
dis2.set('method', 'geometric');
dis2.set('elemcount', '20');
dis2.set('elemratio', '20');

map1 = mesh1.feature.create('map1','Map');
map1.selection.geom('geom1', 2);
map1.selection.set(2);
mesh1.feature.create('frt1','FreeTri');

mesh1.run;

mphmesh(model);
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The final mesh is in Figure 3-7. Note the effect of the Distribution feature, with 
which the distribution of vertex elements along geometry edges can be controlled.

Figure 3-7: Incrementally generated mesh (right).

The left-hand side plot in Figure 3-7 is obtained with the following command:

mphgeom(model, 'geom1', 'edgelabels','on')

To replace the structured quad mesh by an unstructured quad mesh, delete the Map 
feature and replace it by a FreeQuad feature. 

mesh1.feature.remove('map1');
mesh1.run('dis1');
fq1 = mesh1.feature.create('fq1', 'FreeQuad');
fq1.selection.geom('geom1', 2).set(2);
mesh1.run;

Analogous to working with the meshing sequence in the Model Builder, inside the 
COMSOL Desktop, new features are always inserted after the current feature. Thus, 
to get the FreeQuad feature before the FreeTri feature you need to make the dis1 
feature the current feature by building it with the run method.

Alternatively, you can selectively remove parts of a mesh by using the Delete feature. 
For example, to remove the structured mesh from domain 2 along with the adjacent 
edge mesh on edges 3 and 4, and replace it with an unstructured quad mesh, enter 
these commands:

del1 = mesh1.feature.create('del1','Delete');
del1.selection.geom('geom1', 2).set(2);
del1.set('deladj','on');
frq1 = mesh1.feature.create('frq1','FreeQuad');
frq1.selection.geom('geom1', 2).set(2);
mesh1.run;
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R E VO L V I N G  A  M E S H  B Y  S W E E P I N G

Using the Sweep feature you can create 3D volume meshes by extruding and revolving 
face meshes. Depending on the 2D mesh type, the 3D meshes can be hexahedral 
(brick) meshes or prism meshes.

Example—Revolved Mesh
Create and visualize a revolved prism mesh as follows:

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1', 3);
wp1 = geom1.feature.create('wp1', 'WorkPlane');
wp1.set('planetype', 'quick');
wp1.set('quickplane', 'xy');
c1 = wp1.geom.feature.create('c1', 'Circle');
c1.set('pos', [2, 0]);
rev1 = geom1.feature.create('rev1', 'Revolve');
rev1.set('angle2', '60').set('angle1', '-60');
rev1.selection('input').set({'wp1'});
geom1.run('rev1');

mesh1 = model.mesh.create('mesh1', 'geom1');
mesh1.feature.create('ftri1', 'FreeTri');
mesh1.feature('ftri1').selection.geom(2);
mesh1.feature('ftri1').selection.set(2);
mesh1.runCurrent;

swe1 = mesh1.feature.create('swe1', 'Sweep');
swe1.selection.geom(3);
swe1.selection.add(1);

mesh1.run;
mphmesh(model)

To obtain a torus, leave the angles property unspecified; the default value gives a 
complete revolution.

For further details on the various commands and their properties see the 
COMSOL Java API Reference Guide.

See Also
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Figure 3-8: 3D prism mesh created with the Sweep feature.

E X T R U D I N G  A  M E S H  B Y  S W E E P I N G

To generate a 3D prism mesh from the same 2D mesh by extrusion and then to plot 
it, enter the following commands:

model = ModelUtil.create('Model');
geom1 = model.geom.create('geom1', 3);
wp1 = geom1.feature.create('wp1', 'WorkPlane');
wp1.set('planetype', 'quick');
wp1.set('quickplane', 'xy');
c1 = wp1.geom.feature.create('c1', 'Circle');
c1.set('pos', [2, 0]);
ext1 = geom1.feature.create('ext1', 'Extrude');
ext1.selection('input').set({'wp1'});
geom1.runAll;

mesh1 = model.mesh.create('mesh1', 'geom1');

ftri1 = mesh1.feature.create('ftri1', 'FreeTri');
ftri1.selection.geom('geom1', 2);
ftri1.selection.set(3);

dis1 = mesh1.feature.create('dis1', 'Distribution');
dis1.selection.set(1);
dis1.set('type', 'predefined');
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dis1.set('elemcount', '20');
dis1.set('elemratio', '100');

swe1 = mesh1.feature.create('swe1', 'Sweep');
swe1.selection('sourceface').geom('geom1', 2);
swe1.selection('targetface').geom('geom1', 2);

mesh1.run;
mphmesh(model);

The result is shown in Figure 3-9. With the properties elemcount and elemratio 
you control the number and distribution of mesh element layers in the extruded 
direction.

Figure 3-9: Extruded 3D prism mesh.

Distribution in the COMSOL Java API Reference Guide
See Also
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C O M B I N I N G  U N S T R U C T U R E D  A N D  S T R U C T U R E D  M E S H E S

Swept meshing can also be combined with free meshing by specifying selections for the 
meshing operations. In this case, start by free meshing domain 2, then sweep the 
resulting surface mesh through domain 1.

model = ModelUtil.create('Model');
geom1 = model.geom.create('geom1', 3);
cone1 = geom1.feature.create('cone1', 'Cone');
cone1.set('r', '0.3');
cone1.set('h', '1');
cone1.set('ang', '9');
cone1.set('pos', [ 0 0.5 0.5]);
cone1.set('axis', [-1 0 0]);
geom1.feature.create('blk1', 'Block');

mesh1 = model.mesh.create('mesh1', 'geom1');

ftet1 = mesh1.feature.create('ftet1', 'FreeTet');
ftet1.selection.geom('geom1', 3);
ftet1.selection.set(2);

swe1 = mesh1.feature.create('swe1', 'Sweep');
swe1.selection('sourceface').geom('geom1', 2);
swe1.selection('targetface').geom('geom1', 2);

mesh1.run;
mphmesh(model);

Figure 3-10: Combined structured/unstructured mesh.

The left-hand side plot in Figure 3-10 is obtained with the following command:

mphgeom(model,'geom1','facemode','off','facelabels','on')
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C R E A T I N G  B O U N D A R Y  L A Y E R  M E S H E S

For 2D and 3D geometries it is also possible to create boundary layer meshes using the 
BndLayer feature. A boundary layer mesh is a mesh with dense element distribution 
in the normal direction along specific boundaries. This type of mesh is typically used 
for fluid flow problems to resolve the thin boundary layers along the no-slip 
boundaries. In 2D, a layered quadrilateral mesh is used along the specified no-slip 
boundaries. In 3D, a layered prism mesh or hexahedral mesh is used depending on 
wether the corresponding boundary layer boundaries contain a triangular or a 
quadrilateral mesh.

If you start with an empty mesh, the boundary-layer mesh uses free meshing to create 
the initial mesh before inserting boundary layers into the mesh. This generates a mesh 
with triangular and quadrilateral elements in 2D and tetrahedral and prism elements in 
3D. The following example illustrates the procedure in 2D:

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1', 2);
r1 = geom1.feature.create('r1', 'Rectangle');
r1.set('size', [10, 5]);
c1 = geom1.feature.create('c1', 'Circle');
c1.set('pos', [3.5 2.5]);
dif1 = geom1.feature.create('dif1', 'Difference');
dif1.selection('input2').object('geom1');
dif1.selection('input').object('geom1');
dif1.selection('input').set({'r1'});
dif1.selection('input2').set({'c1'});
geom1.runAll;

mesh1 = model.mesh.create('mesh1', 'geom1');

bl1 = mesh1.feature.create('bl1', 'BndLayer');
bl1.feature.create('blp1', 'BndLayerProp');
bl1.feature('blp1').selection.set([2 3 5 6 7 8]);

mesh1.run;
mphmesh(model);
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Figure 3-11: Boundary layer mesh based on an unstructured triangular mesh.

It is also possible to insert boundary layers in an existing mesh. Use the following 
meshing sequence with the geometry sequence of the previous example:

bl1.active(false);

fq1 = mesh1.feature.create('fq1', 'FreeQuad');
fq1.selection.set([1]);

mphmesh(model)

bl1 = mesh1.feature.create('bl2', 'BndLayer');
bl1.feature.create('blp2', 'BndLayerProp');
bl1.feature('blp2').selection.set([2 3 5 6 7 8]);
mesh1.run;
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mphmesh(model);

Figure 3-12: Initial unstructured quad mesh (left) and resulting boundary layer mesh 
(right).

R E F I N I N G  M E S H E S

Given a mesh consisting only of simplex elements (lines, triangles, and tetrahedra) you 
can create a finer mesh using the feature Refine. Thus

mesh1.feature.create('ref1', 'Refine');

refines the mesh.

By specifying the property tri, either as a row vector of element numbers or a 2-row 
matrix, you can control the elements to be refined. In the latter case, the second row 
of the matrix specifies the number of refinements for the corresponding element.

The refinement method is controlled by the property rmethod. In 2D its default value 
is regular, corresponding to regular refinement, in which each specified triangular 
element is divided into four triangles of the same shape. Setting rmethod to longest 
gives longest edge refinement, where the longest edge of a triangle is bisected. Some 
triangles outside the specified set might also be refined in order to preserve the 
triangulation and its quality.

In 3D the default refinement method is longest, while regular refinement is only 
implemented for uniform refinements. In 1D the function always uses regular 
refinement, where each element is divided into two elements of the same shape.

For stationary or eigenvalue PDE problems you can use adaptive mesh 
refinement at the solver stage with the solver step adaption. See 
Adaption in the COMSOL Java API Reference Guide.Note
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C O P Y I N G  B O U N D A R Y  M E S H E S

Use the CopyEdge feature in 2D and the CopyFace feature in 3D to copy a mesh 
between boundaries. It is only possible to copy meshes between boundaries that have 
the same shape. However, a scaling factor between the boundaries is allowed. The 
following example demonstrates how to copy a mesh between two boundaries in 3D 
and then create a swept mesh on the domain.

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1', 3);
wp1 = geom1.feature.create('wp1', 'WorkPlane');
wp1.set('planetype', 'quick');
wp1.set('quickplane', 'xy');
c1 = wp1.geom.feature.create('c1', 'Circle');
c1.set('r', 0.5);
c1.set('pos', [1, 0]);
rev1 = geom1.feature.create('rev1', 'Revolve');
rev1.set('angle1', '0').set('angle2', '180');
rev1.selection('input').set({'wp1'});
geom1.run('wp1');

mesh1 = model.mesh.create('mesh1', 'geom1');

size1 = mesh1.feature.create('size1', 'Size');
size1.selection.geom('geom1', 1);
size1.selection.set(18);
size1.set('hmax', '0.06');

ftri1 = mesh1.feature.create('ftri1', 'FreeTri');
ftri1.selection.geom('geom1', 2);
ftri1.selection.set(10);

cpf1 = mesh1.feature.create('cpf1', 'CopyFace');
cpf1.selection('source').geom('geom1', 2);
cpf1.selection('destination').geom('geom1', 2);
cpf1.selection('source').set(10);
cpf1.selection('destination').set(1);

sw1 = mesh1.feature.create('sw1', 'Sweep');
sw1.selection('sourceface').geom('geom1', 2);
sw1.selection('targetface').geom('geom1', 2);

mesh1.run;
mphmesh(model);

The algorithm automatically determines how to orient the source mesh on the target 
boundary, and the result is shown in Figure 3-13.
 3 :  B U I L D I N G  M O D E L S



Figure 3-13: Prism element obtained with the CopyFace and Sweep features.

To explicitly control the orientation of the copied mesh, use the EdgeMap attribute. 
The command sequence

em1 = cpf1.feature.create('em1', 'EdgeMap');
em1.selection('srcedge').set(18);
em1.selection('dstedge').set(2);
mesh1.feature.remove('sw1');
mesh1.feature.create('ftet1', 'FreeTet');

mesh1.run;
mphmesh(model);

copies the mesh between the same boundaries as in the previous example, but now the 
orientation of the source mesh on the target boundary is different. The domain is then 
meshed by the free mesh, resulting in the mesh shown Figure 3-14. In this case it is 
not possible to create a swept mesh on the domain because the boundary meshes do 
not match in the sweeping direction.
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Figure 3-14: Free tetrahedral mesh after the use of the CopyFace feature.

C O N V E R T I N G  M E S H  E L E M E N T S

Use the Convert feature to convert meshes containing quadrilateral, hexahedral, or 
prism elements into triangular meshes and tetrahedral meshes. In 2D, the function 
splits each quadrilateral element into either two or four triangles. In 3D, it converts 
each prism into three tetrahedral elements and each hexahedral element into five, six, 
or 28 tetrahedral elements. You can control the method used to convert the elements 
using the property splitmethod. The default value is diagonal, which results in two 
triangular elements in 2D and five or six tetrahedral elements in 3D.

The example below demonstrates how to convert a quad mesh into a triangle mesh:

model = ModelUtil.create('Model');
geom1 = model.geom.create('geom1', 2);
geom1.feature.create('c1', 'Circle');
geom1.feature.create('r1', 'Rectangle');
int1 = geom1.feature.create('int1', 'Intersection');

For additional properties supported, see Convert in the COMSOL Java 
API Reference Guide.

See Also
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int1.selection('input').object('geom1');
int1.selection('input').set({'c1' 'r1'});

mesh1 = model.mesh.create('mesh1', 'geom1');
mesh1.feature.create('fq1', 'FreeQuad');
mesh1.runCurrent;
mesh1.feature.create('conv1', 'Convert');
mesh1.run;
mphmesh(model);

The result is illustrated in the Figure 3-15:

Figure 3-15: Mesh using free quad elements (left) and converted mesh from quad to 
triangle (right).

Importing External Meshes and Mesh Objects

It is possible to import meshes to COMSOL Multiphysics using the following formats:

• COMSOL Multiphysics text files (extension .mphtxt)

• COMSOL Multiphysics binary files (extension .mphbin)

• NASTRAN files (extension .nas or .bdf)

For a description of the text file format see the COMSOL Multiphysics Reference 
Guide.

I M P O R T I N G  M E S H E S  T O  T H E  C O M M A N D  L I N E

To import a mesh stored in a supported format use the Import feature. The following 
commands import and plot a NASTRAN mesh for a crankshaft:

model = ModelUtil.create('Model');
model.geom.create('geom1', 3);

mesh1 = model.mesh.create('mesh1', 'geom1');
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imp1 = mesh1.feature.create('imp1', 'Import');
model.modelPath('dir\COMSOL43\models\COMSOL_Multiphysics\
Structural_Mechanics')
imp1.set('filename','crankshaft.nas');
mesh1.feature('imp1').importData;

mesh1.run;
mphmesh(model);

Where dir is the path of root directory where COMSOL Multiphysics 4.3 is installed.

The above command sequence results in Figure 3-16.

Figure 3-16: Imported NASTRAN mesh.

For additional properties supported, see Import in the COMSOL Java 
API Reference Guide.

See Also
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Measuring Mesh Quality

Use the stat method on the meshing sequence to get information on the mesh 
quality. The quality measure is a scalar quantity, defined for each mesh element, where 
0 represents the lowest quality and 1 represents the highest quality.

The following commands illustrate how to visualize the mesh quality for a mesh on the 
unit circle:

model = ModelUtil.create('Model');
geom1 = model.geom.create('geom1', 2);
geom1.feature.create('c1', 'Circle');
geom1.runAll;

mesh1 = model.mesh.create('mesh1', 'geom1');
mesh1.feature.create('ftri1', 'FreeTri');
mesh1.run;

meshdset1 = model.result.dataset.create('mesh1', 'Mesh');
meshdset1.set('mesh', 'mesh1');

pg1 = model.result.create('pg1', 2);

meshplot1 = pg1.feature.create('mesh1', 'Mesh');
meshplot1.set('data', 'mesh1');
meshplot1.set('filteractive', 'on');
meshplot1.set('elemfilter', 'quality');
meshplot1.set('tetkeep', '0.25');
mphplot(model,'pg1');
meshplot1.set('elemfilter','qualityrev');
meshplot1.run;
mphplot(model,'pg1');

These commands display the worst 25% and the best 25% elements in terms of mesh 
element quality. See how in Figure 3-17 the triangular mesh elements in the plot to 
the right are more regular than those in the left plot; this reflects the fact that a quality 
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measure of 1 corresponds to a uniform triangle, while 0 means that the triangle has 
degenerated into a line.

Figure 3-17: Visualizations of the mesh quality: worst 25% (left) and best 25% (right).

Getting Mesh Statistics Information

Use the function mphmeshstats to get mesh statistics and mesh information. 

stats = mphmeshstats(model);

where stats is a structure containing the mesh statistics information. The statistics 
structure contains the following fields:

• meshtag, the tag of the mesh feature.

• isactive, Boolean variable that indicates if the mesh feature is active (1) or not (0).

• hasproblems, Boolean variable that indicates if the mesh feature contains error or 
warning nodes (1) or not (0).

• iscomplete, Boolean variable that indicates if the mesh feature is built (1) or 
not(0).

• sdim, the space dimension of the mesh feature.

• types, the element types present in the mesh. The element type can be vertex (vtx), 
edge (edg), triangle (tri), quad (quad), tetrahedra (tet), pyramid (pyr), prism 
(prism), hexahedra (hex). The type can also be of all elements of maximal 
dimension in the selection (all).

• numelem, number of elements for each element type.
• minquality, minimum element quality.
• meanquality, mean element quality.
• qualitydistr, distribution of the element quality (20 values).
• minvolume, minimum element volume/area.
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• maxvolume, maximum element volume/area.
• volume, total volume/area of the mesh. 

In case of several mesh case are available in the model object, you can specify the mesh 
tag:

stats = mphmeshstats(model, <meshtag>);

Getting and Setting Mesh Data

The function mphmeshstats also returns the mesh data, such as element coordinates. 
Use the function with two output variable to get the mesh data.

[meshstats,meshdata] = mphmeshstats(model);

In the above, meshdata is a MATLAB structure containing the following fields:

• vertex, which contains the mesh vertex coordinates.

• elem, which contains the element data information.

• elementity, which contains the element entity information for each element type.

E X A M P L E :  E X T R A C T  A N D  C R E A T E  M E S H  I N F O R M A T I O N

You can manually create a mesh based on a grid generated in MATLAB. In this 
example before inserting this mesh into the model, you generate a default coarse mesh 
and get the mesh information. With this information you can understand the 
requested mesh structure to use with the createMesh method. Finally construct a 
complete mesh and store it in the meshing sequence. If the geometry is not empty, the 
new mesh is checked to ensure that it matches the geometry. Thus, to create an 
arbitrary mesh you need to create an empty geometry sequence and a corresponding 
empty meshing sequence and construct the mesh on the empty meshing sequence.

Start by creating a 2D model containing a square, and mesh it with triangles.

model = ModelUtil.create('Model');
model.modelNode.create('mod1');
geom1 = model.geom.create('geom1', 2);
geom1.feature.create('sq1', 'Square');
geom1.run;
mesh1 = model.mesh.create('mesh1', 'geom1');
mesh1.feature.create('ftri1', 'FreeTri');
mesh1.feature.feature('size').set('hmax', '0.5');
mesh1.run('ftri1');
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mphmesh(model);

To get the mesh data information, enter:

[meshstats,meshdata] = mphmeshstats(model);

meshdata = 
        vertex: [2x12 double]
          elem: {[2x8 int32]  [3x14 int32]  [0 5 7 11]}
    elementity: {[8x1 int32]  [14x1 int32]  [4x1 int32]}

The mesh node coordinates are stored in the vertex field:

vtx = meshdata.vertex

vtx =
  Columns 1 through 7
         0    0.5000    0.3024         0    0.6314    1.0000    0.3511 
         0         0    0.3023    0.5000    0.3632         0    0.6397 
  Columns 8 through 12
0    0.6730    1.0000 0.5000    1.0000
1.0000    0.6728    0.5000 1.0000    1.0000

In the elem field you retrieve the element information, such as the node indices (using 
a 0 based) connected to the elements.

tri = meshdata.elem{2}
tri =
  Columns 1 through 5
           0           3           1           1           6
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           1           0           4           5           3
           2           2           2           4           2
  Columns 6 through 10
           6           7           6           5           9
           2           3           4           9           8
           4           6           8           4           4
  Columns 11 through 14
          10          10           9          11
           7           6          11          10
           6           8           8           8

In the above command, you can see that element number 1 is connected with nodes 
1, 2 and 3, element number 2 is connected with nodes 4,1 and 3.

Now create manually a mesh using a data distribution generated in MATLAB by 
entering the command below:

[x,y] = meshgrid([0 0.5 1], [0 0.5 1]);
X = reshape(X,1,9);
Y = reshape(Y,1,9);
coord=[X;Y];

The node distribution obtain with the above command correspond to the mesh in the 
figure Figure 3-18.

Figure 3-18: Mesh with elements (bold) and nodes (italic) indices
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In Table 3-1, you can see the nodes and element connectivity in the mesh:

Now create the elements and nodes connectivity information with the command 
below:

new_tri(:,1)=[0;3;4];
new_tri(:,2)=[0;1;4];
new_tri(:,3)=[1;4;5];
new_tri(:,4)=[1;2;5];
new_tri(:,5)=[3;6;7];
new_tri(:,6)=[3;4;7];
new_tri(:,7)=[4;7;8];
new_tri(:,8)=[4;5;8];

Assign the element information, node coordinates and elements connectivity 
information, into a new mesh. Use the method createMesh to create the new mesh.

geom2 = model.geom.create('geom2',2);
mesh2 = model.mesh.create('mesh2','geom2');
mesh2.data.setElem('tri',new_tri)
mesh2.data.setVertex(coord)
mesh2.data.createMesh

TABLE 3-1:  ELEMENT AND NODES CONNECTIVITY

ELEMENT NODES

1 1, 4, 5

2 1, 2, 5 

3 2, 5, 6

4 2, 3, 6

5 4, 7, 8

6 4, 5, 8

7 5, 8, 9

8 5, 6, 9
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Mode l i n g  Ph y s i c s

This section describes how to set up physics interfaces in a model. The physics interface 
defines the equations that COMSOL solves.

• The Physics Interface Syntax

• The Material Syntax

• Modifying the Equations

• Adding Global Equation

• Defining Model Settings Using External Data File

The Physics Interface Syntax

Create a physics interface instance using the syntax

model.physics.create(<phystag>, physint, <geomtag>);

where <phystag> is a string that you choose to identify the physics interface. Once 
defined, you can always refer to a physics interface, or any other feature, by its tag. The 
string physint is the constructor name of the physics interface. To get the constructor 
name, the best is to create a model using the desired physics interface in the GUI and 
save the model as a M-file. The string <geomtag> refers the geometry where you want 
to specify the interface.

To add a feature to a physics interface, use the syntax

model.physics(<phystag>).feature.create(<ftag>,operation);

where the <phystag> string refers to a physics interface. <ftag> is a string that you 
use to refer to the operation. To set a property to a value in a operation, enter:

Overview of the Physics Interfaces in the COMSOL Multiphysics User’s 
Guide

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

See Also

Important
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model.physics(<phystag>).feature(<ftag>).set(property, <value>);

where <ftag> is the string that identifies the feature.

There are alternate syntaxes available. 

To disable or remove a feature node, use the methods active or remove, respectively. 

The command

model.physics(<phystag>).feature(<ftag>).active(false);

disables the feature <ftag>.

To activate the feature node you can set the active method to true:

model.physics(<phystag>).feature(<ftag>).active(true);

You can also remove a feature from the model. Use the method remove as below:

model.physics(<phystag>).feature.remove(<ftag>);

E X A M P L E :  I M P L E M E N T  A N D  S O L V E  A  H E A T  TR A N S F E R  P R O B L E M

This example details how to add a physics interface and set boundary conditions in the 
model object.

Start to create a model object, including a 3D geometry. The geometry consists in a 
block with default settings. Enter the following commands at the MATLAB prompt:

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1', 3);
geom1.feature.create('blk1', 'Block');
geom1.run;

Proceed with adding a Heat Transfer in Solids interface to the model:

phys = model.physics.create('ht', 'HeatTransfer', 'geom1');

The tag of the interface is ht. The physics interface constructor is HeatTransfer. The 
physics is defined on geometry geom1.

The physics interface automatically creates a number of default features. Examine these 
by entering:

model.physics() in the COMSOL Java API Reference Guide
See Also
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>> model.physics('ht')
ans =
Type: Heat Transfer in Solids
Tag: ht
Identifier: ht
Operation: HeatTransfer
Child nodes: solid1, ins1, cib1, init1, os1

The physics method has the following child nodes: solid1, ins1, cib1, init1, and 
os1. These are the default features that come with the Heat Transfer in Solids 
interface. The first feature, solid1, consists of the heat balance equation. Confirm this 
by entering:

>> solid = phys.feature('solid1')
ans =
Type: Heat Transfer in Solids
Tag: solid1

You can modify the settings of the solid1 feature node, for instance to manually set 
the material property. To change the thermal conductivity to 400 W/(m*K) enter:

solid.set('k_mat', 1, 'userdef');
solid.set('k', '400');

The Heat Transfer in Solids interface contains features you can use to specify domain 
or boundary settings. For example, to add a 1e5 W/m^3 heat source in the study 
domain, enter the commands:

hs = phys.feature.create('hs1', 'HeatSource', 3);
hs.selection.set([1]);
hs.set('Q', 1, '1e5');

To create a temperature boundary condition on boundaries 3, 5, and 6, enter:

temp = phys.feature.create('temp1', 'TemperatureBoundary', 2);
temp.selection.set([3 5 6]);
temp.set('T0', 1, '300[K]');

Then add a mesh and a study feature and compute the solution:

model.mesh.create('mesh1', 'geom1');
std = model.study.create('std1');
std.feature.create('stat', 'Stationary');
std.run

To visualize the solution, first create a 3D surface plot group, which is displayed in a 
MATLAB figure with the function mphplot:

pg = model.result.create('pg1', 'PlotGroup3D');
pg.feature.create('surf1', 'Surface');
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mphplot(model,'pg1','rangenum',1)

The Material Syntax

In addition to changing material properties directly inside the physics interfaces you 
can create materials available in the entire model. Such a material can be used by all 
physics interfaces in the model. 

Create a material using the syntax

model.material.create(<mattag>);

where <mattag> is a string that you use to refer to a material definition.

A Material is a collection of material models, where each material model defines a set 
of material properties, material functions, and model inputs. To add a material model, 
use the syntax:

model.material(<mattag>).materialmodel.create(<mtag>);

where <mattag> is the string identifying the material you defined when creating the 
material. The string <mtag> refers to the material model. 

Now you can define material properties for the model by setting property value pairs 
by the following operations:
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model.material(<mattag>).materialmodel(<mtag>).set(property, 
<value>);

E X A M P L E :  C R E A T E  A  M A T E R I A L  N O D E

While the section, Example: Implement and Solve a Heat Transfer Problem, showed 
how to change a material property inside a physics interface, here you can define a 
material available globally in the model. The steps below assume that you have 
completed the steps of the example above.

mat = model.material.create('mat1');

The material automatically creates a material model, def, which you can use to set up 
basic properties. Use it to define the density and the heat capacity:

mat.materialmodel('def').set('density', {'400'});
mat.materialmodel('def').set('heatcapacity', {'2e3'});

To use the defined material in your model, you must set the solid1 feature to use the 
material node.

solid.set('k_mat',1,'from_mat');

Modifying the Equations

The equation defining the physics node can be edited with the method 
featureInfo('info') applied to a feature of the physics node 
physics(<phystag>).feature(<ftag>), where <phystag> and <ftag> identify 
the physics interface and the feature, respectively.

info = 
model.physics(<phystag>).feature(<ftag>).featureInfo('info');

Use the method getInfoTable(type) to return the tables available in the Equation 
view node:

infoTable = info.getInfoTable(type);

where type defines the type of table to return. It can have the value 'Weak' to return 
the weak form equations, 'Constraint' to return the constraint types table, 
'Expression' to return the variable expressions table.

model.material() in the COMSOL Java API Reference Guide
See Also
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E X A M P L E :  A C C E S S  A N D  M O D I F Y  T H E  E Q U A T I O N  WE A K  F O R M

Continue with the section, Example: Implement and Solve a Heat Transfer Problem, 
to modify the model equation.

To retrieve information about the physics interface create an info object:

info = model.physics('ht').feature('solid1').featureInfo('info');

From the info object you can now access the weak form equation:

infoTable = info.getInfoTable('Weak');

This returns a string variable that contains both the name of the weak equation variable 
and the equation of the physics implemented in the weak form. Enter the command:

list = infoTable(:)

which result in the following output:

list =
java.lang.String[]:
    [1x159 char]
    'root.mod1.ht.solid1.weak$1'
    'Material'  
    'Domain 1'

The output provided above shows that the physics is defined with the weak expression 
available in the variable list(1), enter:

list(1)

To get the weak equation as a string variable. The result of the above command is 
displayed below:

ans =
-(ht.k_effxx*Tx+ht.k_effxy*Ty+ht.k_effxz*Tz)*test(Tx)-(ht.k_effyx
*Tx+ht.k_effyy*Ty+ht.k_effyz*Tz)*test(Ty)-(ht.k_effzx*Tx+ht.k_eff
zy*Ty+ht.k_effzz*Tz)*test(Tz)

You can access the equation in the node root.mod1.ht.solid1.weak$1; for 
instance, to modify the equation and lock the expression run the commands:

equExpr = '400[W/(m*K)]*(-Tx*test(Tx)-Ty*test(Ty)-Tz*test(Tz))';
info.lock(list(2), {equExpr});

The above command set the heat conductivity to a constant value directly within the 
heat balance equation.
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Adding Global Equation

To add a global equation in the model use the command:

model.physics.create(<odestag>, 'GlobalEquations');

To define the name of the variable to be solved by the global equation, enter

model.physics(<odetag>).set('name', <idx>, <name>);

where <idx> is the index of the global equation, and <name> a string with the name 
of the variable.

Set the expression <expr> of the global equation with

model.physics(<odetag>).set('equation', <idx>, <expr>);

where <expr> is defined as a string variable.

Initial value and initial velocity can be set with the commands

model.physics(<odetag>).set('initialValueU', <idx>, <init>);
model.physics(<odetag>).set('initialValueUt', <idx>, <init_t>);

where <init> and <init_t> are the initial value expression for the variable and its 
time derivative respectively.

E X A M P L E :  S O L V E  A N  O D E  P R O B L E M

This example illustrates how to solve the following ODE in a COMSOL model:

model = ModelUtil.create('Model');

ge = model.physics.create('ge', 'GlobalEquations');
ge1 = ge.feature('ge1');
ge1.set('name', 1, 1, 'u');
ge1.set('equation', 1, 1, 'utt+0.5*ut+1');
ge1.set('initialValueU', 1, 1, 'u0');
ge1.set('initialValueUt', 1, 1, 'u0t');

model.param.set('u0', '0');
model.param.set('u0t', '20');

std1 = model.study.create('std1');

u·· u·

2
--- 1+ + 0=

u0 0=

u·0 20=
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std1.feature.create('time', 'Transient');
std1.feature('time').set('tlist', 'range(0,0.1,20)');
std1.run;

model.result.create('pg1', 1);
model.result('pg1').set('data', 'dset1');
model.result('pg1').feature.create('glob1', 'Global');
model.result('pg1').feature('glob1').set('expr', {'mod1.u'});

mphplot(model,'pg1')

Defining Model Settings Using External Data File

To use tabulated data from files in a model, you can use the interpolation function 
available under the Global Definitions node or the Definitions node of the model. 

To add an interpolation function to the manual use the command:

model.func.create(<functag>, 'Interpolation');

The interpolation function is initially defined globally, in the Model Builder from the 
COMSOL Desktop you can see it under the Global Definitions node. In case you have 
several model node in your model and you would like to attached it to the specified 
model node <model>, enter:

model.func(<functag>).model(<model>);
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where <model> is the tag of the model node to attach the interpolation function.

You then have the possibility to interpolate data specified by a table inside the function 
(default), or specified in an external file.

When using an interpolation table, set the interpolation data for each row of the table 
with the commands:

model.func(<functag>).setIndex('table', <t_value>, <i>, 1);
model.func(<functag>).setIndex('table', <ft_value>, <i>, 2);

where <t_value> is the interpolation parameter value and <ft_value> is the function 
value. <i> is the index (0-based) in the interpolation table.

To use an external file change the source for the interpolation and specify the file:

model.func(<functag>).set('source', 'file');
model.func(<functag>).set('filename', <filename>);

In the above filename is the name, with path, of the data file.

Several interpolation methods are available. Choose which one to use by the 
command:

model.func(<functag>).set('interp', method);

The string method can be set as one of the following alternatives:

• 'neighbor', for interpolation according to the nearest neighbor method.

• 'linear', for linear interpolation method.

• 'cubicspline', for cubic spline interpolation method.

• 'piecewisecubic', piecewise cubic interpolation method.

You can also decide how to handle parameter values outside the range of the input data 
by selecting an extrapolation method:

model.func(<functag>).set('extrap', method);

The string method can be one of these following value:

• 'const', to use a constant value outside the interpolation data.

• 'linear', for linear extrapolation method.

• 'nearestfunction', to use the nearest function as extrapolation method.

'value', to use a specific value outside the interpolation data.
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model.func() in the COMSOL Java API Reference Guide
See Also
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C r e a t i n g  S e l e c t i o n s

In this section:

• The Selection Node

• Coordinate-Based Selections

• Selection Using Adjacent Geometry

• Display Selection

The Selection Node

Use a selection node to define a collection of geometry entities in a central location in 
the model. The selection can easily be accessed in physics or mesh features or during 
postprocessing. For example, you can refer collectively to a set of boundaries that have 
the same boundary conditions, and also have the same mesh size settings.

A selection feature can be one of the following type:

• Explicit, to include entities explicitly defined by their definitions indices.

• Ball, to include entities that fall with a set sphere.

• Box, to include entities that fall within a set box.

You can also combine selection by Boolean operations, such as Union, Intersection, 
Difference. 

S E T T I N G  A N  E X P L I C I T  S E L E C T I O N

Create an explicit selection with the command:

model.selection.create(<seltag>, 'Explicit');

User-Defined Selections in the COMSOL Multiphysics User’s Guide

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

See Also

Important
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You can specify the domain entity dimension to use in the selection node.

model.selection(<seltag>).geom(sdim);

With sdim the space dimension that represent the different geometry entity, 3 for 
domain, 2 for boundary/domain, 1 for edge/boundary, 0 for point.

Set the domain entity indices in the selection node with the command:

model.selection(<seltag>).set(<idx>);

Where <idx> is an array of integers that lists the geometry entity indices to add in the 
selection.

Coordinate-Based Selections

D E F I N I N G  A  B A L L  S E L E C T I O N  N O D E

The Ball selection node is defined by a center point and a radius. The selection can 
include geometric entities that are completely or partially inside the ball. You can set 
up the selection by using either the COMSOL API directly or the mphselectcoords 
function.

Ball Selection Using the COMSOL API
To add a ball selection to model object enter:

model.selection.create(<seltag>, 'Ball');

To set the coordinates (<x0>, <y0>, <z0>) of the selection center point, enter:

model.selection(<seltag>).set('posx', <x0>);
model.selection(<seltag>).set('posy', <y0>);
model.selection(<seltag>).set('posz', <z0>);

where <x0>, <y0>, <z0> are double values.

Specify the ball radius <r0> with the command:

model.selection(<seltag>).set('r', <r0>);

where <r0> is double value.

You can specify the geometric entity level with the command:

model.selection(<seltag>).set('entitydim', edim);

where edim is an integer defining the space dimension value (3 for domains, 2 for 
boundaries/domains, 1 for edges/boundaries and 0 for point).

The selection also specifies the condition for geometric entities to be selected:
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model.selection(<seltag>).set('condition', condition);

where condition can be:

• 'inside', to select all geometric entities completely inside the ball.

• 'intersects', to select all geometric entities that intersect the ball (default).

• 'somevertex', to select all geometric entities where at least some vertex is inside 
the ball.

• 'allvertices', to select all geometric entities where all vertices are inside the ball.

Ball Selection Using MPHSELECTCOORDS
The function mphselectcoords retrieves geometric entities enclosed by a ball. 

To get the geometric entities enclosed by a ball of radius r0, with its center positioned 
at (x0,y0,z0) enter the command:

idx = mphselectcoords(model, <geomtag>, [<x0>,<y0>,<z0>], ...
entitytype,'radius',<r0>);

where <geomtag> is the tag of geometry where the selection, and entitytype can be 
one of 'point', 'edge', 'boundary' or 'domain'.

The above function returns the entity indices list. Use it to specify a feature selection 
or to create an explicit selection as described in Setting an Explicit Selection.

By default the function searches for the geometric entity vertices near these 
coordinates using the tolerance radius. It returns only the geometric entities that have 
all vertices inside the search ball. To include in the selection any geometric entities that 
have at least one vertex inside the search ball set the property include to 'any':

idx = mphselectcoords(model, <geomtag>, [<x0>,<y0>,<z0>], ...
entitytype,'radius',<r0>,'include','any');

In case the model geometry is finalized as an assembly, you have distinct geometric 
entities for each part of the assembly. Specify the adjacent domain index to avoid 
selection of overlapping geometric entities. Set the adjnumber property with the 
domain index:

idx = mphselectcoords(model, <geomtag>, [<x0>,<y0>,<z0>], ...
entitytype,'radius',<r0>,'adjnumber',<idx>);

where <idx> is the domain index adjacent to the desired geometric entities.

D E F I N I N G  A  B O X  S E L E C T I O N  N O D E

The Box selection node is defined by two diagonally opposite points of a box (3D) or 
rectangle (2D).
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Box Selection Using the COMSOL API
The command below adds a box selection to the model object:

model.selection.create(<seltag>, 'Box');

Specify the points (<x0>, <y0>, <z0>) and (<x1>, <y1>, <z1>):

model.selection(<seltag>).set('xmin', <x0> );
model.selection(<seltag>).set('ymin', <y0> );
model.selection(<seltag>).set('zmin', <z0> );
model.selection(<seltag>).set('xmax', <x1> );
model.selection(<seltag>).set('ymax', <y1> );
model.selection(<seltag>).set('zmax', <z1> );

where <x0>, <y0>, <z0>, <x1>, <y1>, <z1> are double values.

You can specify the geometric entities level with the command:

model.selection(<seltag>).set('entitydim', edim);

where edim is an integer defining the space dimension value (3 for domains, 2 for 
boundaries/domains, 1 for edges/boundaries and 0 for point).

The selection also specifies the condition for geometric entities to be selected:

model.selection(<seltag>).set('condition', condition);

where condition can be:

• 'inside', to select all geometric entities completely inside the ball.

• 'intersects', to select all geometric entities that intersect the ball (default).

• 'somevertex', to select all geometric entities where at least some vertex is inside 
the ball.

• 'allvertices', to select all geometric entities where all vertices are inside the ball.

Box Selection Using MPHSELECTBOX
The function mphselectbox retrieves geometric entities enclosed by a box (3D) or 
rectangle (2D).

To get the geometric entities of type entitytype enclosed by the box defined by the 
points (x0,y0,z0) and (x1,y1,z1), enter the command:

idx = mphselectbox(model,<geomtag>,[<x0> <x1>,<y0> <y1>,<z0> <z1>], 
entitytype);

where <geomtag> is the tag of geometry where the selection is applied, and 
entitytype can be one of 'point', 'edge', 'boundary' or 'domain'.
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The above function returns the entity indices list. Use it to specify a feature selection 
or to create an explicit selection as described in Setting an Explicit Selection.

By default the function searches for the geometric entity vertices near these 
coordinates using the tolerance radius. It returns only the geometric entities that have 
all vertices inside the box/rectangle. To include in the selection any geometric entities 
that have at least one vertex inside the search ball set the property include to 'any':

idx = mphselectbox(model,<geomtag>,[<x0> <x1>,<y0> <y1>,<z0> <z1>], 
entitytype,'include','any');

In case the model geometry is finalized as an assembly, you have distinct geometric 
entities for each part of the assembly. Specify the adjacent domain index to avoid 
selection of overlapping geometric entities. Set the adjnumber property with the 
domain index:

idx = mphselectbox(model,<geomtag>,[<x0> <x1>,<y0> <y1>,<z0> <z1>], 
entitytype, 'adjnumber', <idx>);

where <idx> is the domain index adjacent to the desired geometric entities.

Selection Using Adjacent Geometry

An other approach to select geometry entity is to define their adjacent object. For 
instance select the edges that are adjacent to a specific domain, or the boundaries that 
are adjacent to a specific point. 

Adjacent Selection Using the COMSOL API
The command below create a selection node using adjacent geometric entities:

model.selection.create(<seltag>, 'Adjacent');

You need to specify the geometric entity level with the command:

model.selection(<seltag>).set(edim);

where edim is an integer defining the space dimension value (3 for domains, 2 for 
boundaries/domains, 1 for edges/boundaries and 0 for point).

The Adjacent selection node only support Selection node as input:

model.selection(<seltag>).set( 'Adjacent');

as Specify the ball radius <r0> with the command:

model.selection(<seltag>).set('input', <seltag>);

where <seltag> is the tag of an existing Selection node.
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Select the level of geometric entities to add in the selection with the command:

model.selection(<seltag>).set('outputdim', edim);

where edim is an integer defining the space dimension value (3 for domains, 2 for 
boundaries/domains, 1 for edges/boundaries and 0 for point).

In case you have multiple domains in the geometry to include the interior and exterior 
selected geometric entities enter:

model.selection(<seltag>).set('interior', 'on');
model.selection(<seltag>).set('exterior', 'on');

To exclude the interior/exterior select geometric entities you can set the respective 
property to 'off'.

Adjacent Selection Using MPHGETADJ
An alternative to the COMSOL API is to use the function mphgetadj to select 
geometric entities using adjacent domain.

To get a list of entities of type entitytype adjacent to the entity with the index 
<adjnumber> of type adjtype enter:

idx = mphselectbox(model, <geomtag>, entitytype, ...
adjtype, <adjnumber>);

where <geomtag> is the tag of geometry where the selection applies. The string 
variables entitytype and adjtype can be one of 'point', 'edge', 'boundary' or 
'domain'.

You can use the list returned by the function to specify the selection for a model feature 
or to create an explicit selection as described in Setting an Explicit Selection.

Display Selection

Use the function mphviewselection to display the selected geometric entities in a 
MATLAB figure.

You can either specify the geometry entity index and its entity type or specify the tag 
of a selection node available in the model.

To display the entity of type entitytype with the index <idx> enter:

mphviewselection(model, <geomtag>, <idx>, 'entity', entitytype)
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where <geomtag> is the tag of geometry node. <idx> is a positive integer array that 
contains the entity indices. The string entitytype can be one of 'point', 'edge', 
'boundary' or 'domain'.

If your model contains a selection node with the tag <seltag>, you can display it with 
the command:

mphviewselection(model, <geomtag>, <seltag>)

If the selection node is a Ball or Box selection, you can also display the ball or box used 
in the selection:

mphviewselection(model, <geomtag>, <seltag>, 'showselector', 'on')
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T h e  S t u d y  Node

This section describes how to set up and run a study. The study contains basic solver 
settings. COMSOL uses the physics interfaces and the study to automatically 
determine solver settings.

• The Solution Syntax

• Run, RunAll, RunFrom

• Adding a Parametric Sweep

• The Batch Node

• Plot While Solving

The Study Syntax

Create a study by using the syntax

model.study.create(<studytag>);

where studytag is a string that you use define to the study sequence.

To add a study step to a study, use the syntax

model.study(<studytag>).feature.create(<ftag>, operation);

where <studytag> is the string identifying the study node. The string <ftag> is a 
string that you define to refer to the study step. The string operation defines the 
operation to add to the study node, it can be one of the Study step node available with 
the Physics interface or adding a type of study step to add to the study. 

To specify a property value pair for a study step, enter

• Solvers and Study Types in the COMSOL Multiphysics User’s Guide

• Solver in the COMSOL Java API Reference Guide

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

See Also

Important
 3 :  B U I L D I N G  M O D E L S



model.study(<studytag>).feature(<ftag>).set(property, <value>);

where <ftag> is the string identifying the study step.

To run the study, enter

model.study(<studytag>).run

which generates the default solver configuration associated with the physics solved in 
the model. 

The Solution Syntax

To add a solution to the model start with typing:

model.sol.create(<soltag>);

where <soltag> is a string that you use to refer to the solution object.

To add a solution operation feature, enter:

model.sol(<soltag>).feature.create(<ftag>, operation);

where <soltag> is the string you defined when creating the solution object. The string 
ftag is a string that you define to refer to the feature, for instance a study step. 

To specify a property value pair for a solution object feature, enter

model.sol(<soltag>).feature(<ftag>).set(property, <value>);

where <ftag> is a string referring to the solution object.

Run, RunAll, RunFrom

There are several ways to run the solver configuration node. 

model.study() in the COMSOL Java API Reference Guide
See Also

For a list of the operations available for the solver feature node, see 
Features Producing and Manipulating Solutions and Solver, in the 
COMSOL Java API Reference Guide.See Also
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Use the methods run or runAll to run the entire solver configuration node.

model.sol(<soltag>).run;
model.sol(<soltag>).runAll;

Use the method run(<ftag>) to run the solver configuration up to the solver feature 
with the tag <ftag>:

model.sol(<soltag>).run(<ftag>);

Use the method runFrom(<ftag>) to run the solver configuration from the solver 
feature with the tag <ftag>:

model.sol(<soltag>).runFrom(<ftag>)

Adding a Parametric Sweep

The parametric sweep is a study step that does not generate equations and can only be 
used in combination with other study steps. You can formulate the sequence of 
problems that arise when you vary some parameters in the model.

To add a parametric sweep to the study node, enter:

model.study(<studytag>).feature.create(<ftag>, 'Parametric');

You can add one or several parameters to the sweep with the command:

model.study(<studytag>).feature(<ftag>).setIndex('pname', 
<pname>, <idx>);

where <pname> is the name of the parameter to use in the parametric sweep, and <idx> 
the index number of the parameter. Set the <idx> to 0 to define the first parameter, 1 
to define the second parameter and so on.

Set the list of the parameter value with the command:

model.study(<studytag>).feature(<ftag>).setIndex('plistarr', 
<pvalue>, <idx>);

where <pvalue> contains the list of parameter values defined with either a string or 
with a double array. <idx> the index number of the parameter, use the same value as 
for the parameter name.

If you have several parameters listed in the parametric sweep node, you can select the 
type of the sweep: all combinations or specified combinations, of parameter values. Do 
this with the command:

model.study(<studytag>).feature(<ftag>).set('sweeptype', type);
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where the sweep type,type, can be either 'filled' or 'sparse' respectively.

The Batch Node

Create a batch node to run automatically several jobs in a sequence:

model.batch.create(<batchtag>, type);

where type is the type of job to define. It can be either Parametric, Batch or 
Cluster.

Attach the batch mode to an existing study node defined in the model:

model.batch(<batchtag>).atached(<studytag>);

where <studytag> is the tag of the study node.

Set property to the batch job with the command:

model.batch(<batchtag>).set(property, <value>);

Run the batch job using the run method:

model.batch(<batchtag>).run;

Plot While Solving

With the plot while solving functionality you can monitor the development of the 
computation by updating predefined plots during computation. Since the plots are 
displayed on the COMSOL server, you need to start COMSOL with MATLAB using 
the graphics mode.

To activate plot while solving, enter the command 

You can get the list of the properties in model.batch() in the COMSOL 
Java API Reference Guide.

See Also

See the COMSOL Multiphysics Operations and Installation Guide to 
start COMSOL with MATLAB with the graphics mode.

See Also
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model.study(<studytag>).feature(<studysteptag>).set('plot', 
'on');

where <studytag> is the tag of the study and <studysteptag> refers to the study 
step.

Specify which plot group to plot by setting the plot group tag:

model.study(<studytag>).feature(<studysteptag>).set('plotgroup', 
<ptag>);

Only one plot group can be plotted during a computation. If you need to monitor 
several variables you can use probes instead. 

To activate plot while solving for a probe plot, enter the command:

model.study(<studytag>).feature(<studysteptag>).set('probesel', 
type);

where type is the type of probe to use. It can be 'probesel', 'probesel' or a cell 
array containing the tag of the probe to use.
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Ana l y z i n g  t h e  R e s u l t s

This section describes how to do results analysis and visualization. 

• The Plot Group Syntax

• Displaying The Results

• The Data Set Syntax

• The Numerical Node Syntax

• Exporting Data

The Plot Group Syntax

First create a plot group using the syntax

model.result.create(<pgtag>, sdim);

where <pgtag> is a string that you use to refer to the plot group, and sdim is the space 
dimension of the plot group (1, 2 or 3).

To add a plot feature to a plot group, use the syntax

model.result(<pgtag>).feature.create(<ftag>, plottype);

where plottype is the string to that define the type of plots to be used with the feature 
ftag. 

For each plot type you can add an attribute to the feature node, you can do it with the 
command:

model.result(<pgtag>).feature(<ftag>).feature.create(<attrtag>, 
attrtype);

• Results Evaluation and Visualization in the COMSOL Multiphysics 
User’s Guide

• Results in the COMSOL Java API Reference Guide

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

See Also

Important
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where attrtype is the string to that define the type of attribute to be used with the 
feature <ftag>. 

Displaying The Results

Use the command mphplot to display the plot group available in the model object. 

To display the plot group <pgtag> enter the command:

mphplot(model, <pgtag>);

This renders the graphics in a MATLAB figure window using Handle Graphics. 

To plot the plot group in a COMSOL graphics window, make sure you have started 
COMSOL with MATLAB using the -graphics option and enter:

mphplot(model, <pgtag>, 'server', 'on');

An alternative to plot the results on server is use the run method at a specific plot 
group:

model.result(<pgtag>).run;

The default plot settings displayed in a MATLAB figure do not include a color range 
bar. If you want to include the color range bar in your figure use the property 
rangenum:

mphplot(model, <pgtag>, 'rangenum', <idx>);

where <idx> is the index number of the feature node you would like to display the 
color range bar.

For a list of the syntax of the plots type and attribute types available, see 
Results in the COMSOL Java API Reference Guide. Also see 
model.result() in this guide.See Also

The plot on server option is not supported on Mac OS.

Note
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You can extract the data plot directly at the MATLAB prompt by adding an output 
argument to mphplot, see:

dat = mphplot(model, <pgtag>);

This returns a cell array dat that contains the data for each plot feature available in the 
plot group.

Alternatively, you can display the solution directly using data value instead of a plot 
group. The function mphplot supports data format such as the structure provided by 
the function mpheval. This allow you to extract expressions at the MATLAB prompt, 
do some operations with the exported data and plot the results in the model geometry.

To display data from mpheval, run the command:

mphplot(<data>);

If the data structure contains the value of several expression you can set the expression 
to display with the index property:

mphplot(<data>, 'index', <idx>);

where <idx> is a positive integer that corresponds to the expression to plot.

You can also set the color table to use when displaying the data value. See the 
command:

mphplot(<data>, 'colortable', colorname);

where colorname is the name of the color table to use. See the on-line help associated 
to the command colortable to get a list of the predefined color table.

E X A M P L E :  P L O T  M P H E VA L  D A T A

In this example you will see how to extract COMSOL data at the MATLAB, modify 
them and plot the data in a MATLAB figure. 

Start to load the model busbar from the COMSOL model library, enter the command:

model = mphload('busbar');

To extract the temperature and the electric potential field, use the command mpheval 
as below:

Only plots involving points, lines, and surfaces data are supported in 
<data>.

Note
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dat = mpheval(model, {'T' 'V'}, 'selection', 1);

To display the temperature field enter:

mphplot(dat, 'index', 1);

You can also edit and modify the data available in the data structure returned by 
mpheval. Then change the color table to display the modified data, see the command:

dat.d2 = dat.d2*1e-3;
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mphplot(dat, 'index', 2, 'colortable', 'thermal');

The Data Set Syntax

Data sets contain or refer to the source of data for creating Plots and Reports. It can 
be a Solution, a Mesh, or some transformation or cut plane applied to other data sets 
—that is, create new data sets from other data sets. Add data sets to the Data Sets 
branch under Results.

All plots refer to data sets; the solutions are always available as the default data set. 

To create a data at the MATLAB prompt, use the command:

model.result.dataset.create(<dsettag>, dsettype);

where dsettype is a data set type. 

• Defining Data Sets in the COMSOL Multiphysics User’s Guide

• Use of Data Sets in the COMSOL Java API Reference GuideSee Also
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The Numerical Node Syntax

Use the numerical node to do numerical operation such as computing average, 
integration, maximum or minimum of a given expressions. You can also perform point 
and global evaluation. 

To create a numerical node use the command:

model.result.numerical.create(<numtag>, numtype);

where numtype is the numerical type.

Exporting Data

The export method allows the user to generate an animation or to export data to an 
external file (ASCII format).

A N I M A T I O N  E X P O R T

You can define an animation as two different types: a movie or an image sequence. The 
movie generates file formats such as GIF (.gif), AVI (.avi), or flash (.swf); the image 
sequence generates a sequence of images.

To generate an animation, add an Animation node to the export method:

model.result.export.create(<animtag>, 'Animation');

To change the animation type use the 'type' property:

model.result.export(<animtag>).set('type', type);

where type is either 'imageseq'or 'movie'.

To set the filename and run the animation use the following commands:

model.result.export(<animtag>).set(typefilename, <filenname>);
model.result.export(<animtag>).run;

With typefilename depending on the type of animation export: 'imagefilename' 
for an image sequence, 'giffilename' for a gif animation, 'flashfilename' for a 
flash animation, and 'avifilename' for an avi animation.

For a list of the syntax of the numerical results type available, see About 
Results Commands in the COMSOL Java API Reference Guide.

See Also
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For a movie type it is possible to change the number of frames per second with the 
command:

model.result.export(<animtag>).set('fps', <fps_number>);

where <fps_number> is a positive integer that correspond to the number of frame per 
second to use.

For all animation type you can modify the width and the height of the plot:

model.result.export(<animtag>).set('width', <width_px>);
model.result.export(<animtag>).set('height', <height_px>);

where <width_px> and <height_px> are the width and height size (in pixels) 
respectively to use for the animation.

DA T A  E X P O R T

In order to extract data value to an ASCII file, create a Data node to the export 
method:

model.result.export.create(<datatag>, 'Data');

Set the expression expr and the file name filenname, and run the export:

model.result.export.(<datatag>).setIndex('expr', <expr>, 0);
model.result.export.(<datatag>).set('filename', <filenname>);
model.result.export.(<datatag>).run;

Set the export data format with the struct property:

model.result.export.(<datatag>).set('struct', datastruct);

where datastruct can be set to 'spreadsheet' or 'sectionwise':

The default data structure is the spreadsheet format defined as below:

% Model:                filename.mph
% Version:              COMSOL 4.3.0.133
% Date:                 May 1 2012, 11:17
% Dimension:            2
% Nodes:                1272
% Expressions:          20
% Description:          
% x      y      data     
x1      y1      data1
x2      y2      data2

In case of multiple solution fields (as for a parametric, transient, or eigenvalue analysis) 
extra columns are added corresponding to solution data at each parameter, time step, 
or eigenvalue.
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The section wise e format is as below:

% Model:                filename.mph
% Version:              COMSOL 4.3.0.133
% Date:                 May 1 2012, 11:28
% Dimension:            2
% Nodes:                1272
% Elements:             424
% Expressions:          20
% Description:          
% Coordinates
x1      y1
x2      y2
...
% Elements (triangles)
node11      node12      node13
node21      node22      node23
...
% Data
data1
data2
...

where nodeij is the jth node of the ith element.

A N I M A T I O N  P L A Y E R

For transient and parametric study you can generate animation player to create 
interactive animations. The player display the figure on a server window. Make sure 
that you have started COMSOL with MATLAB with the graphics mode to enable plot 
on server. 

To create a player feature node to the model enter the command:

model.result.export.create(<playtag>, 'Player');

You need then to associated the player with an existing plot group, this is done with 
the command:

model.result.export(<playtag>).set('plotgroup', <pgtag>);

with <pgtag> the tag of the plot group to be used in the player.

Set the frame number you want to visualize with the 
command:model.result.export(<playtag>).set('showframe', <freamenum>);

To learn how to start COMSOL with MATLAB with the graphics mode, 
see the COMSOL Multiphysics Installation and Operations Guide.

See Also
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where <frameum> is a positive integer value that corresponds to the frame number.

You can also specify the maximum number of frame to generate the player with the 
command:

model.result.export(<playtag>).set('maxframe', <maxnum>);

where <maxnum> is a positive integer value that corresponds to the maximum number 
of frame to generate the player.

You can display the frame with the command:

model.result.export(<playtag>).run;
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 4
W o r k i n g  W i t h  M o d e l s  
This section introduces you to the functionality available for LiveLink for 
MATLAB such as the wrapper functions or the MATLAB tools that can be used 
combined with a COMSOL model object. In this chapter:

• Using MATLAB Variables in Model Settings

• Extracting Results

• Running Models in Loop

• Running Models in Batch Mode

• Extracting System Matrices

• Extracting Solution Information and Solution Vector

• Retrieving Xmesh Information

• Navigating the Model

• Handling Errors And Warnings

• Improving Performance for Large Models

• Creating Custom GUI

• COMSOL 3.5a Compatibility
 113
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U s i n g  MAT LAB Va r i a b l e s  i n  Mode l  
S e t t i n g s

LiveLink for MATLAB allows you to define the model properties with MATLAB 
variables or MATLAB M-function. 

In this section:

• The Set and SetIndex Methods

• Using MATLAB Function To Define Model Properties

The Set and SetIndex Methods

You can use MATLAB variable to set properties of your COMSOL model. Use the set 
or setIndex methods to pass the variable value from MATLAB to the COMSOL 
model.

T H E  S E T  M E T H O D S

Use the set method to assign parameter/properties value. All assignments return the 
parameter object, which means that assignment methods can be appended to each 
other. 

The basic method for assignments is:

something.set(property, <value>);

The name argument is a string with the name of the parameter/property. The <value> 
argument can be of different types, from which ones MATLAB integer/double array 
variable.

When using a MATLAB variable make sure that the value correspond to the model 
unit system. You can also let COMSOL to take care of the unit conversation, in this 
case convert the MATLAB integer/double variable to a string variable and use the set 
method as:

something.set(property, [num2str(<value>)'[unit]']);

where is the unit you want to set the value property.
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T H E  S E T I N D E X  M E T H O D S

Use the setIndex methods to assign values to specific indices (0-based) in array or 
matrix property. All assignment methods return the parameter object, which means 
that assignment methods can be appended to each other.

something.setIndex(property, <value>, <index>);

The name argument is a string with the name of the property. <value> is the value to 
set the property, which can be a MATLAB variable value.<index> is the index in the 
property table.

When using a MATLAB variable make sure that the value correspond to the model 
unit system. You can also let COMSOL to take care of the unit conversation, in this 
case convert the MATLAB integer/double variable to a string variable and use the set 
method as:

something.setIndex(property, [num2str(<value>)'[unit]'], <index>);

where is the unit you want to set the value property.

Using MATLAB Function To Define Model Properties

Use MATLAB function to define the model property. The function can either be 
declared within the model object or called at the MATLAB prompt.

C A L L I N G  M AT L A B  F U N C T I O N  W I T H I N  T H E  C O M S O L  M O D E L  O B J E C T

LiveLink for MATLAB offers to the user the possibility to declare a MATLAB 
M-function directly from within the COMSOL model object. This is typically the case 
if you want to call MATLAB M-function from the COMSOL Desktop. The function 
being declared within the model object it accepts as arguments any parameters, variable 
or expressions defined in the COMSOL model object. However if you want to use 
variable defined at the MATLAB prompt you will have to transfer them first in the 
COMSOL model, as a parameter for instance (see how to set MATLAB variable in the 
COMSOL model in The Set and SetIndex Methods).

The function is evaluated at anytime the model needs to be updated. 

The model object cannot be called as input argument of the M-function.

Calling MATLAB Function
See Also
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C A L L I N G  M AT L A B  F U N C T I O N  A T  T H E  M AT L A B  P R O M P T

Use MATLAB function to a define model property with the set method:

something.set(property, myfun(<arg>));

where myfun() is a M-function defined in MATLAB.

The function is called only when the command is executed at the MATLAB prompt. 
The argument of the function <arg> call be MATLAB variables. To include an 
expression value from the model object, you first need to extract it at the MATLAB 
prompt, as it is described in Extracting Results.

The function myfun()accepts the model object model as input argument as any 
MATLAB variables.
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Ex t r a c t i n g  R e s u l t s

Use LiveLink for MATLAB to extract at the MATLAB prompt the data computed in 
the COMSOL model. A suite of wrapper function is available to perform evaluation 
operations at the MATLAB prompt.

In this section:

• Extracting Data From Tables

• Extracting Data at Node Points

• Extracting Data at Arbitrary Points

• Evaluating an Expression at Geometry Vertices

• Evaluating an Integral

• Evaluating a Global Expression

• Evaluating a Global Matrix

• Evaluating a Maximum of Expression

• Evaluating an Expression Average

• Evaluating a Minimum of Expression

Extracting Data From Tables

In the table node you can store the data evaluated with the COMSOL built-in 
evaluation method, see The Numerical Node Syntax.

You can extract the data stored in the table with the tag tbltag with the command:

tabl = model.result.table(<tbltag>).getTableData(fullprecision);

This create a java.lang.string array tabl that contains the data of the table 
tbltag. The size of the array table is Nx1 where N is the number of the table line. 
fullprecision is a Boolean expression to get the data with full precision.

To get the value of a specific row of the table, enter:

tablline = tabl(<i>);

where <i> is the number of the desired row. The variable tablline is a Mx1 
java.lang.string array where M is the number of row in the table.

You can obtain the table header with the command:
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header = model.result.table(<tbltag>).getColumnHeaders;

Where header is a Mx1 java.lang.string array, with M the number of the table 
row.

To get the table as a double array, use the methods getReal and getImag as described 
below: 

tablReal = model.result.table(<tbltag>).getReal;
tablImag = model.result.table(<tbltag>).getImag;

tablReal and tablImag are available at the MATLAB workspace as NxM arrays 
where N is the number of line and M the number of row of the table.

To get the table data at a specific row use the commands: 

tablRealRow = model.result.table(<tbltag>).getRealRow(<i>);
tablImagRow = model.result.table(<tbltag>).getImagRow(<i>);

tablRealERow and tablImagRow are available at the MATLAB workspace as Nx1 
array where N is the number of row of the table.

Extracting Data at Node Points

The function mpheval lets you evaluate expressions on nodes points. The function 
output is available as a structure in the MATLAB workspace.

Call the function mpheval as in the command below:

Table in the COMSOL Java API Reference Guide

The links to features described outside of this user guide do not work in 
the PDF, only from within the online help.

To locate and search all the documentation for this information, in 
COMSOL, select Help>Documentation from the main menu and either 
enter a search term or look under a specific module in the documentation 
tree.

See Also

Important

Tip
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pd = mpheval(model, <expr>);

where <expr> is a cell array of string that list the COMSOL expression to evaluate. 
The expression has to be defined in COMSOL model object to be evaluated.

pd is a structure with the following fields:

• expr contains the list of names of the expressions evaluated with mpheval.

• d1 contains the value of the expression evaluated. The columns in the data value 
fields correspond to node point coordinates in columns in the field p. In case of 
several expressions are evaluated in mpheval, additional field d2, d3,... are available.

• p contains the node point coordinates information. The number of rows in p is the 
number of space dimensions.

• t contains the indices to columns in pd.p of a simplex mesh; each column in pd.t 
represents a simplex.

• ve contains the indices to mesh elements for each node points.

• unit contains the list of the unit for each evaluated expressions.

S P E C I F Y  T H E  E V A L U A T I O N  D A T A

The function mpheval supports the following properties to set the data of the 
evaluation to perform:

• dataset, specify the solution data set to use in the evaluation.

pd = mpheval(model, <expr>, 'dataset', <dsettag>);

<dsettag> is the tag of a solution data set. The default value consist in the current 
solution data set of the model. Selection data set such as Cut point, Cut line, Edge, 
Surface, etc... are not supported.

• selection, specify the domain selection for evaluation.

pd = mpheval(model, <expr>, 'selection', <seltag>);

where <seltag> is the tag of a selection node to use for the data evaluation. 
<seltag> can also be a positive integer array that corresponds to the domain index 
list. The default selection consists in all domains where the expression is defined. If 
the evaluation point does not belong to the specified domain selection the output 
value is NaN. 

• edim, specify the element dimension for evaluation.

pd = mpheval(model, <expr>, 'edim', edim);

where edim is either a string or a positive integer such as: 'point' (0), 'edge' (1), 
'boundary' (2) or 'domain' (3). The default settings correspond to the model 
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geometry space dimension. When using a lower space dimension value, make sure 
that the evaluation point coordinates dimension has the same size.

• solnum, specify the inner solution number for data evaluation. Inner solutions are 
generated for the following analysis type: time domain, frequency domain, 
eigenvalue or stationary with continuation parameters.

pd = mpheval(model, <expr>, 'solnum', <solnum>);

where <solnum> is an integer array corresponding to the inner solution index. 
<solnum> can also be 'end' to evaluate the expression for the last inner solution. 
By default the evaluation is done using the last inner solution.

• outersolnum, specify the outer solution number for data evaluation. Outer 
solutions are generated with parametric sweep.

pd = mpheval(model, <expr>, 'outersolnum', <outersolnum>);

where <outersolnum> is a positive integer corresponding to the outer solution 
index. The default settings uses the first outer solution for the data evaluation.

• To evaluate the expression data at a specific time use the property t:

pd = mpheval(model, <expr>, 't', <time>);

where <time> is a double array. The default value correspond to all the stored time 
step.

• phase, specify the phase in degrees.

pd = mpheval(model, <expr>, 'phase', <phase>);

where <phase> is a double value.

• pattern, use Gauss point evaluation.

pd = mpheval(model, <expr>, 'pattern','gauss');

The default evaluation is performed on the Lagrange points.

O U T P U T  F O R M A T

The function mpheval returns in the MATLAB workspace a structure. You can specify 
other output data format.

Use the function mphevalpoint to evaluate expressions at geometric 
points (see Evaluating an Expression at Geometry Vertices).

Note
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To obtain only the data evaluation as a double array, you can set the property 
dataonly to on.

pd = mpheval(model, <expr>, 'dataonly', 'on');

Include the imaginary part in the data evaluation with the property complexout.

pd = mpheval(model, <expr>, 'complexout', 'on');

S P E C I F Y  T H E  E V A L U A T I O N  Q U A L I T Y

Define function settings to specify the evaluation quality.

• refine, specify the element refinement for evaluation.

pd = mpheval(model, <expr>, 'refine', <refine>);

where <refine> is a positive integer. The default value is 1 which set the simplex 
mesh identical to the geometric mesh.

• smooth, specify the smoothing method to enforce continuity on discontinuous data 
evaluation.

pd = mpheval(model, <expr>, 'smooth', smooth);

where smooth is either 'none', 'everywhere' or 'internal' (default). Set the 
property to none to evaluate the data on elements independently, set the property 
to everywhere to apply the smoothing to the entire geometry and set the property 
to internal to smooth the quantity inside the geometry but no smoothing takes 
place across borders between domains with different settings. The output with same 
data and same coordinates are automatically merge, this means that the output size 
may differ depending on the smoothing method.

• recover, specify the accurate derivative recovery.

pd = mpheval(model, <expr>, 'recover', recover);

where recover is either 'ppr', 'pprint' or 'off' (default). Set the property to ppr 
to perform recovery inside domains, set the property to pprint to perform recovery 
inside domains. Because the accurate derivative processing takes processing time, the 
property is disabled by default.

O T H E R S  E V A L U A T I O N  P R O P E R T Y

Use the property complexfun to not use complex-value functions with real inputs.

pd = mpheval(model, <expr>, 'complexfun','off');

The default value use complex-value functions with real inputs.

Use the property matherr to return an error for undefined operations or expressions:
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pd = mpheval(model, <expr>, 'matherr','on');

D I S P L A Y  T H E  E X P R E S S I O N  I N  F I G U R E

You can display an expression evaluated with mpheval in an external figure with the 
function mphplot, see Displaying The Results. The function mphplot only supports a 
MATLAB structure provided by mpheval as input.

Extracting Data at Arbitrary Points

The function mphinterp evaluates at the MATLAB prompt the result at arbitrary 
points.

To evaluate an expression at specific point coordinates call the function mphinterp as 
in the command below:

[d1, ..., dn] = mphinterp(model,{'e1', ..., 'en'},'coord',<coord>);

where e1,...,en are the COMSOL expressions to evaluate. <coord> is a NxM 
double array, with N the space dimension of the evaluation domain and M the number 
of evaluation point. The output d1, ..., dn are a PxM double array, where P is the 
length of the inner solution. 

Alternatively you can specify the evaluation coordinates using a selection data set:

data = mphinterp(model, <expr>, 'dataset', <dsettag>);

where <dsettag> is a selection data set tag defined in the model, for example, Cut 
point, Cut Plane, Revolve, and so forth.

S P E C I F Y  T H E  E V A L U A T I O N  D A T A

The function mphinterp supports the following properties to set the data of the 
evaluation to perform:

• dataset, specify the solution data set to use in the evaluation.

data = 
mphinterp(model,<expr>,'coord',<coord>,'dataset',<dsettag>);

<dsettag> is the tag of a solution data set. The default value consist in the current 
solution data set of the model.

• selection, specify the domain selection for evaluation.
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data = 
mphinterp(model,<expr>,'coord',<coord>,'selection',<seltag>);

where <seltag> is the tag of a selection node to use for the data evaluation. 
<seltag> can also be a positive integer array that corresponds to the domain index 
list. The default selection consists in all domains where the expression is defined. If 
the evaluation point does not belong to the specified domain selection the output 
value is NaN. 

• edim, specify the element dimension for evaluation.

data = mphinterp(model,<expr>,'coord',<coord>,'edim',edim);

where edim is either a string or a positive integer such as: 'point' (0), 'edge' (1), 
'boundary' (2) or 'domain' (3). The default settings correspond to the model 
geometry space dimension. When using a lower space dimension value, make sure 
that the evaluation point coordinates dimension has the same size.

• ext, specify extrapolation control value. This ensure you to return data for points 
that are outside the geometry.

data = mphinterp(model,<expr>,'coord',<coord>,'ext',<ext>);

where <ext> is a double value. The default value is 0.1.

• solnum, specify the inner solution number for data evaluation. Inner solutions are 
generated for the following analysis type: time domain, frequency domain, 
eigenvalue or stationary with continuation parameters.

data = mphinterp(model,<expr>,'coord',<coord>,solnum',<solnum>);

where <solnum> is an integer array corresponding to the inner solution index. 
<solnum> can also be 'end' to evaluate the expression for the last inner solution. 
By default the evaluation is performed using the last inner solution.

• outersolnum, specify the outer solution number for data evaluation. Outer 
solutions are generated with parametric sweep.

data = mphinterp(model,<expr>,'coord',<coord>,... 
'outersolnum',<outersolnum>);

where <outersolnum> is a positive integer corresponding to the outer solution 
index. The default settings uses the first outer solution for the data evaluation.

• To evaluate the expression data at a specific time use the property t:

data = mphinterp(model,<expr>,'coord',<coord>,'t',<time>);

where <time> is a double array. The default value correspond to all the stored time 
step.
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• phase, specify the phase in degrees.

data = mphinterp(model,<expr>,'coord',<coord>,'phase',<phase>);

where <phase> is a double value.

O U T P U T  F O R M A T

The function mphinterp returns in the MATLAB workspace a double array. It also 
supports other output format.

To evaluate several expressions at once, make sure that you have defined as many 
output variables as there are expressions specified:

[d1, ..., dn] = mphinterp(model,{'e1', ..., 'en'},'coord',<coord>);

To extract the unit of the evaluated expression, you need to defined an extra output 
variable.

[data, unit] = mphinterp(model,<expr>,'coord',<coord>);

with unit is a 1xN cell array where N is the number of expression to evaluate.

Include the imaginary part in the data evaluation with the property complexout.

data = mphinterp(model,<expr>,'coord',<coord>,'complexout','on');

To return an error if the all evaluation points are outside the geometry, set the property 
coorderr to on:

data = mphinterp(model,<expr>,'coord',<coord>,'coorderr','on');

By default the function return the value NaN.

S P E C I F Y  T H E  E V A L U A T I O N  Q U A L I T Y

With the property recover, you can specify the accurate derivative recovery.

data = mphinterp(model,<expr>,'coord',<coord>,'recover', recover);

where recover is either 'ppr', 'pprint' or 'off' (default). Set the property to ppr 
to perform recovery inside domains, set the property to pprint to perform recovery 
inside domains. Because the accurate derivative processing takes processing time, the 
property is disabled by default.

O T H E R S  E V A L U A T I O N  P R O P E R T Y

Set the unit property to specify the unit of the evaluation.

data = mphinterp(model,<expr>,'coord',<coord>,'unit',<unit>);

where unit is a cell array with the same size as expr.
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Use the property complexfun to not use complex-value functions with real inputs.

data = mphinterp(model,<expr>,'coord',<coord>,'complexfun','off');

The default value use complex-value functions with real inputs.

Use the property matherr to return an error for undefined operations or expressions:

data = mphinterp(model,<expr>,'coord',<coord>,'matherr','on');

Evaluating an Expression at Geometry Vertices

The function mphevalpoint returns the result of a given expression evaluated at the 
geometry vertices.

[d1,...,dn] = mphevalpoint(model,{'e1',...,'en'});

where e1,...,en are the COMSOL expressions to evaluate. The output d1, ..., 
dn is a NxP double array, where N is the number of evaluation point and P the length 
of the inner solution. 

S P E C I F Y  T H E  E V A L U A T I O N  D A T A

The function mphevalpoint supports the following properties to set the data of the 
evaluation to perform:

• dataset, specify the solution data set to use in the evaluation.

data = mphevalpoint(model,<expr>,'dataset',<dsettag>);

<dsettag> is the tag of a solution data set. The default value consist in the current 
solution data set of the model.

• selection, specify the domain selection for evaluation.

data = mphevalpoint(model,<expr>,'selection',<seltag>);

where <seltag> is the tag of a selection node to use for the data evaluation. 
<seltag> can also be a positive integer array that corresponds to the domain index 
list. The default selection consists in all domains where the expression is defined. If 
the evaluation point does not belong to the specified domain selection the output 
value is NaN. 

• solnum, specify the inner solution number for data evaluation. Inner solutions are 
generated for the following analysis type: time domain, frequency domain, 
eigenvalue or stationary with continuation parameters.
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data = mphevalpoint(model,<expr>,'solnum',<solnum>);

where <solnum> is an integer array corresponding to the inner solution index. 
<solnum> can also be 'end' to evaluate the expression for the last inner solution. 
By default the evaluation is done using the last inner solution.

• outersolnum, specify the outer solution number for data evaluation. Outer 
solutions are generated with parametric sweep.

data = mphevalpoint(model,<expr>,'outersolnum',<outersolnum>);

where <outersolnum> is a positive integer corresponding to the outer solution 
index. The default settings uses the first outer solution for the data evaluation.

• To evaluate the expression data at a specific time use the property t:

data = mphevalpoint(model,<expr>,'t', <time>);

where <time> is a double array. The default value correspond to all the stored time 
step.

Perform data series operation with the dataseries property.

data = mphevalpoint(model,<expr>,'dataseries', dataseries);

where dataseries is either 'mean', 'int', 'max', 'min', 'rms', 'std' or 'var'. 
Depending on the property value mphevalpoint performs the following operations: 
mean, integral, maximum, minimum, root mean square, standard deviation or variance 
respectively.

When performing a minimum or maximum operation on the data series, you can 
specify to perform the operation using the real or the absolute value. Set the property 
minmaxobj to 'real' or 'abs' respectively.

data = mphevalpoint(model,<expr>,'dataseries', dataseries,... 
'minmaxobj', valuetype);

By default valuetype is 'real'.

O U T P U T  F O R M A T

The function mphevalpoint supports other output formats.

To extract the unit of the evaluated expression, you need to define an extra output 
variable.

[data,unit] = mphevalpoint(model,<expr>);

with unit is a 1xN cell array where N is the number of expression to evaluate.
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By default mphevalpoint returns the result s as a squeezed singleton. To get the full 
singleton set the squeeze property to off:

data = mphevalpoint(model,<expr>,'squeeze','off');

Set the property matrix to off to returns the data as a cell array instead of a double 
array.

data = mphevalpoint(model,<expr>,'matrix','off');

Evaluating an Integral

Evaluate an integral of expression with the function mphint2. 

To evaluate the integral of the expression over the domain with the highest space 
domain dimension call the function mphint2 as in the command below:

[d1,...,dn] = mphint2(model,'e1',...,'en'},edim);

where e1,...,en are the COMSOL expression to integrate. The values d1,...,dn 
are returned as a 1xP double array, with P the length of inner parameters. edim is the 
integration dimension, it can be either 'line', 'surface' or 'volume' or integer 
value that specify the space dimension (1,2, or 3).

S P E C I F Y  T H E  I N T E G R A T I O N  D A T A

The function mphint2 supports the following properties to set the data of the 
evaluation to perform:

• dataset, specify the solution data set to use in the integration.

data = mphint2(model,<expr>,edim,'dataset',<dsettag>);

<dsettag> is the tag of a solution data set. The default value consist in the current 
solution data set of the model.

• selection, specify the integration domain.

data = mphint2(model,<expr>,edim,'selection',<seltag>);

where <seltag> is the tag of a selection node to use for the data evaluation. 
<seltag> can also be a positive integer array that corresponds to the domain index 

The function mphint is now obsolete and will be removed in a future 
version of the software. If you are using this function in your code, you 
can now replace it by mphint2.Note
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list. The default selection consists in all domains where the expression is defined. If 
the evaluation point does not belong to the specified domain selection the output 
value is NaN. 

• solnum, specify the inner solution number for data evaluation. Inner solutions are 
generated for the following analysis type: time domain, frequency domain, 
eigenvalue or stationary with continuation parameters.

data = mphint2(model,<expr>,edim,'solnum',<solnum>);

where <solnum> is an integer array corresponding to the inner solution index. You 
can also set the property solnum to 'end' to evaluate the expression for the 
last inner solution. By default the evaluation is done using the last inner solution.

• outersolnum, specify the outer solution number for data evaluation. Outer 
solutions are generated with parametric sweep.

data = mphint2(model,<expr>,edim,'outersolnum',<outersolnum>);

where <outersolnum> is a positive integer corresponding to the outer solution 
index. The default settings uses the first outer solution for the data evaluation.

• To evaluate the expression data at a specific time use the property t:

data = mphint2(model,<expr>,edim,'t',<time>);

where <time> is a double array. The default value correspond to all the stored time 
step.

O U T P U T  F O R M A T

The function mphint2 also supports other output format.

To extract the unit of the evaluated expression, you need to define an extra output 
variable.

[data,unit] = mphint2(model,<expr>,edim);

with unit is a 1xN cell array where N is the number of expression to evaluate.

By default mphint2 returns the result s as a squeezed singleton. To get the full 
singleton set the squeeze property to off:

data = mphint2(model,<expr>,edim,'squeeze','off');

Set the property matrix to off to returns the data as a cell array instead of a double 
array.

data = mphint2(model,<expr>,edim,'matrix','off');
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S P E C I F Y  T H E  I N T E G R A T I O N  S E T T I N G S

You can specify integration settings such as integration method, integration order or 
axisymmetry assumption with the following property:

• method, specify the integration method, which can be either integration or 
summation.

data = mphint2(model,<expr>,edim,'method',method);

where method can be 'integration' or 'summation'. The default uses the 
appropriate method for the given expression. 

• intorder, specify the integration order.

data = mphint2(model,<expr>,edim,'intorder',<order>);

where order is a positive integer. The default value is 4.

• intsurface or intvolume, compute surface or volume integral for axisymmetry 
model.

data = mphint2(model,<expr>,edim,'intsurface','on');
data = mphint2(model,<expr>,edim,'intvolume','on');

Evaluating a Global Expression

Evaluate a global expression with the function mphglobal. 

To evaluate a global expression at the MATLAB prompt call the function mphglobal 
as in the command below:

[d1,...,dn] = mphglobal(model,{'e1',...,'en'});

where e1,...,en are the COMSOL global expressions to evaluate. The output values 
d1,...,dn are returned as a Px1 double array, with P the length of inner parameters. 

S P E C I F Y  T H E  E V A L U A T I O N  D A T A

The function mphglobal supports the following properties to set the data of the 
evaluation to perform:

• dataset, specify the solution data set to use in the evaluation.

data = mphglobal(model,<expr>,'dataset',<dsettag>);

<dsettag> is the tag of a solution data set. The default value consist in the current 
solution data set of the model.
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• solnum, specify the inner solution number for data evaluation. Inner solutions are 
generated for the following analysis type: time domain, frequency domain, 
eigenvalue or stationary with continuation parameters.

data = mphglobal(model,<expr>,'solnum',<solnum>);

where <solnum> is an integer array corresponding to the inner solution index. You 
can also set the property solnum to 'end' to evaluate the expression for the last 
inner solution. By default the evaluation is done using the last inner solution.

• outersolnum, specify the outer solution number for data evaluation. Outer 
solutions are generated with parametric sweep.

data = mphglobal(model,<expr>,'outersolnum',<outersolnum>);

where <outersolnum> is a positive integer corresponding to the outer solution 
index. The default settings uses the first outer solution for the data evaluation.

• To evaluate the expression data at a specific time use the property t:

data = mphglobal(model,<expr>,'t',<time>);

where <time> is a double array. The default value correspond to all the stored time 
step.

• phase, specify the phase in degrees.

data = mphglobal(model,<expr>,'phase',<phase>);

where <phase> is a double value.

O U T P U T  F O R M A T

The function mphglobal also supports other output format.

To extract the unit of the evaluated expression, you need to define an extra output 
variable.

[data,unit] = mphglobal(model,<expr>);

with unit is a 1xN cell array where N is the number of expression to evaluate.

Include the imaginary part in the data evaluation with the property complexout.

data = mphglobal(model,<expr>,'complexout','on');

O T H E R S  E V A L U A T I O N  P R O P E R T Y

Set the unit property to specify the unit of the evaluation.

data = mphglobal(model,<expr>,'unit',<unit>);

where <unit> is a cell array with the same length as <expr>.
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Use the property complexfun to not use complex-value functions with real inputs.

data = mphglobal(model,<expr>,'complexfun','off');

The default value use complex-value functions with real inputs.

Use the property matherr to return an error for undefined operations or expressions:

data = mphglobal(model,<expr>,'matherr','on');

Evaluating a Global Matrix

mphevalglobalmatrix evaluates the matrix variable such as S-parameters in a model 
with several ports activated as a parametric sweep and a frequency-domain study. 

To evaluate the global matrix associated to the expression <expr>, execute the 
command below:

M = mphevalglobalmatrix(model,<expr>);

The output data M is a NxN double array, where N is the number of port boundary 
condition set in the model.

S P E C I F Y  T H E  E V A L U A T I O N  D A T A

Set the solution data set for evaluation with the property dataset:

data = mphevalglobalmatrix(model,<expr>,'dataset',<dsettag>);

where <dsettag> is the tag of a solution data.

Evaluating a Maximum of Expression

Use the function mphmax to evaluate the maximum of a given expression over inner 
solution list. 

To evaluate the maximum of the COMSOL expressions e1,...,en you can use the 
command mphmax as below:

[d1,...,dn] = mphmax(model,{'e1',...,'en'},edim);

where edim is a string to define the element entity dimension: 'volume', 'surface' 
or 'line'. edim can also be set as positive integer value (3, 2 or 1 respectively). The 
output variables d1,...,dn are NxP array where N is the number of inner solution 
and P the number of outer solution.
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S P E C I F Y  T H E  E V A L U A T I O N  D A T A

The function mphmax supports the following properties to set the data of the 
evaluation to perform:

• dataset, specify the solution data set to use in the evaluation.

data = mphmax(model,<expr>,edim,'dataset',<dsettag>);

<dsettag> is the tag of a solution data set. The default value consist in the current 
solution data set of the model.

• selection, specify the domain selection for evaluation.

data = mphmax(model,<expr>,edim,'selection',<seltag>);

where <seltag> is the tag of a selection node to use for the data evaluation. 
<seltag> can also be a positive integer array that corresponds to the domain index 
list. The default selection consists in all domains where the expression is defined. If 
the evaluation point does not belong to the specified domain selection the output 
value is NaN. 

• solnum, specify the inner solution number for data evaluation. Inner solutions are 
generated for the following analysis type: time domain, frequency domain, 
eigenvalue or stationary with continuation parameters.

data = mphmax(model,<expr>,edim,'solnum',<solnum>);

where <solnum> is an integer array corresponding to the inner solution index. You 
can also set the property solnum to 'end' to evaluate the expression for the last 
inner solution. By default the evaluation is done using the last inner solution.

• outersolnum, specify the outer solution number for data evaluation. Outer 
solutions are generated with parametric sweep.

data = mphmax(model,<expr>,edim,'outersolnum',<outersolnum>);

where <outersolnum> is a positive integer array corresponding to the outer 
solution index. The default settings uses the first outer solution for the data 
evaluation.

• To evaluate the expression data at a specific time use the property t:

data = mphmax(model,<expr>,edim,'t',<time>);

where <time> is a double array. The default value correspond to all the stored time 
step.

O U T P U T  F O R M A T

The function mphmax also supports other output format.
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To extract the unit of the evaluated expression, you need to define an extra output 
variable.

[data,unit] = mphmax(model,<expr>,edim);

with unit is a 1xN cell array where N is the number of expression to evaluate.

By default mphmax returns the result s as a squeezed singleton. To get the full singleton 
set the squeeze property to off:

data = mphmax(model,<expr>,edim,'squeeze','off');

Set the property matrix to off to returns the data as a cell array instead of a double 
array.

data = mphmax(model,<expr>,edim,'matrix','off');

Evaluating an Expression Average

Use the function mphmean to evaluate the average of a given expression over inner 
solution list. 

To evaluate the mean of the COMSOL expressions e1,...,en you can use the 
command mphmean as below:

[d1,...,dn] = mphmean(model,{'e1',...,'en'},edim);

where edim is a string to define the element entity dimension: 'volume', 'surface' 
or 'line'. edim can also be set as positive integer value (3, 2 or 1 respectively). The 
output variables d1,...,dn are NxP array where N is the number of inner solution 
and P the number of outer solution.

S P E C I F Y  T H E  E V A L U A T I O N  D A T A

The function mphmean supports the following properties to set the data of the 
evaluation to perform:

• dataset, specify the solution data set to use in the evaluation.

data = mphmean(model,<expr>,edim,'dataset',<dsettag>);

<dsettag> is the tag of a solution data set. The default value consist in the current 
solution data set of the model.

• selection, specify the domain selection for evaluation.
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data = mphmean(model,<expr>,edim,'selection',<seltag>);

where <seltag> is the tag of a selection node to use for the data evaluation. 
<seltag> can also be a positive integer array that corresponds to the domain index 
list. The default selection consists in all domains where the expression is defined. If 
the evaluation point does not belong to the specified domain selection the output 
value is NaN. 

• solnum, specify the inner solution number for data evaluation. Inner solutions are 
generated for the following analysis type: time domain, frequency domain, 
eigenvalue or stationary with continuation parameters.

data = mphmean(model,<expr>,edim,'solnum',<solnum>);

where <solnum> is an integer array corresponding to the inner solution index. You 
can also set the property solnum to'end' to evaluate the expression for the last 
inner solution. By default the evaluation is done using the last inner solution.

• outersolnum, specify the outer solution number for data evaluation. Outer 
solutions are generated with parametric sweep.

data = mphmean(model,<expr>,edim,'outersolnum',<outersolnum>);

where <outersolnum> is a positive integer array corresponding to the outer 
solution index. The default settings uses the first outer solution for the data 
evaluation.

• To evaluate the expression data at a specific time use the property t:

data = mphmean(model,<expr>,edim,'t',<time>);

where <time> is a double array. The default value correspond to all the stored time 
step.

O U T P U T  F O R M A T

The function mphmean also supports other output format.

To extract the unit of the evaluated expression, you need to define an extra output 
variable.

[data,unit] = mphmean(model,<expr>,edim);

with unit is a 1xN cell array where N is the number of expression to evaluate.

By default mphmean returns the result s as a squeezed singleton. To get the full 
singleton set the squeeze property to off:

data = mphmean(model,<expr>,edim,'squeeze','off');
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Set the property matrix to off to returns the data as a cell array instead of a double 
array.

data = mphmean(model,<expr>,edim,'matrix','off');

S P E C I F Y  T H E  I N T E G R A T I O N  S E T T I N G S

You can specify integration settings such as integration method or integration order to 
perform the mean operation. The available integration properties are:

• method, specify the integration method, which can be either integration or 
summation.

data = mphmean(model,<expr>,edim,'method',method);

where method can be 'integration' or 'summation'. The default use the 
appropriate method for the given expression. 

• intorder, specify the integration order.

data = mphmean(model,<expr>,edim,'intorder',<order>);

where <order> is a positive integer. The default value is 4.

Evaluating a Minimum of Expression

Use the function mphmin to evaluate the minimum of a given expression over an inner 
solution list. 

To evaluate the minimum of the COMSOL expressions e1,...,en you can use the 
command mphmin as below:

[d1,...,dn] = mphmin(model,{'e1',...,'en'},edim);

where edim is a string to define the element entity dimension: 'volume', 'surface' 
or 'line'. edim can also be set as positive integer value (3, 2, or 1 respectively). The 
output variables d1,...,dn are NxP array where N is the number of inner solution 
and P the number of outer solution.

S P E C I F Y  T H E  E V A L U A T I O N  D A T A

The function mphmin supports the following properties to set the data of the 
evaluation to perform:

• dataset, specify the solution data set to use in the evaluation.
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data = mphmin(model,<expr>,edim,'dataset',<dsettag>);

<dsettag> is the tag of a solution data set. The default value consist in the current 
solution data set of the model.

• selection, specify the domain selection for evaluation.

data = mphmin(model,<expr>,edim,'selection',<seltag>);

where <seltag> is the tag of a selection node to use for the data evaluation. 
<seltag> can also be a positive integer array that corresponds to the domain index 
list. The default selection consists in all domains where the expression is defined. If 
the evaluation point does not belong to the specified domain selection the output 
value is NaN. 

• solnum, specify the inner solution number for data evaluation. Inner solutions are 
generated for the following analysis type: time domain, frequency domain, 
eigenvalue or stationary with continuation parameters.

data = mphmin(model,<expr>,edim,'solnum',<solnum>);

where <solnum> is an integer array corresponding to the inner solution index. You 
can also set the property solnum to 'end' to evaluate the expression for the last 
inner solution. By default the evaluation is done using the last inner solution.

• outersolnum, specify the outer solution number for data evaluation. Outer 
solutions are generated with parametric sweep.

data = mphmin(model,<expr>,edim,'outersolnum',<outersolnum>);

where <outersolnum> is a positive integer array corresponding to the outer 
solution index. The default settings uses the first outer solution for the data 
evaluation.

• To evaluate the expression data at a specific time use the property t:

data = mphmin(model,<expr>,edim,'t',<time>);

where <time> is a double array. The default value correspond to all the stored time 
step.

O U T P U T  F O R M A T

The function mphmin also supports other output format.

To extract the unit of the evaluated expression, you need to define an extra output 
variable.

[data,unit] = mphmin(model,<expr>,edim);

with unit is a 1xN cell array where N is the number of expression to evaluate.
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By default mphmin returns the result s as a squeezed singleton. To get the full singleton 
set the squeeze property to off:

data = mphmin(model,<expr>,edim,'squeeze','off');

Set the property matrix to off to returns the data as a cell array instead of a double 
array.

data = mphmin(model,<expr>,edim,'matrix','off');
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Runn i n g  Mode l s  i n  L oop

A common use of LiveLink for MATLAB is to run models in a loop. As MATLAB 
offers several functionalities to run loops including conditional statements and error 
handling, you will see how all these functionality can be used together with the 
COMSOL Java API syntax to run COMSOL model in loop.

In this section:

• The Parametric Sweep Node

• Running Model in a Loop Using the MATLAB Tools

The Parametric Sweep Node

Using the COMSOL Java API you can run model in loop. See the section Adding a 
Parametric Sweep in the section Building Models.

Note that using the COMSOL built-in function to run models in loop, you can ensure 
the model to be saved automatically at each iteration. COMSOL also offers tool to take 
advantage of clusters architecture.

Running Model in a Loop Using the MATLAB Tools

Use MATLAB tools such as for or while statements to run your model in a loop. The 
COMSOL API Java commands can be included in scripts using MATLAB commands. 
To evaluate such a script you need to have MATLAB connected to a COMSOL server.

To run a model in a loop you do not need to run the entire model M-file commands 
from scratch. It is recommended to load a COMSOL model in MATLAB and run the 
loop only over the desired operations. The COMSOL model is automatically updated 
when running the study node.
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You can run a model M-file from scratch if you need, for instance, to generate the 
geometry in loop.

When running loops in MATLAB, the iteration progress is entirely taking care by 
MATLAB, only the COMSOL commands are executed in the COMSOL server. You 
can generate as many nested loops your modeling requires and combine the loop with 
other MATLAB conditional statement such as if and switch or error handling 
statement such as try/catch. 

Break the loop with break or jump to the next loop iteration with continue.

Refer to MATLAB help to get more information about the MATLAB commands for, 
while, if, switch, try/catch, break, and continue.

E X A M P L E :  G E O M E T R Y  P A R A M E T R I Z A T I O N

In this example you will see how to proceed to geometry parametrization using a 
MATLAB for loop. The model consists in the busbar example available in the 
COMSOL Multiphysics model, see the Introduction to COMSOL Multiphysics. 

In this example the loop iterate over the busbar width wbb. The solution for each 
parameter value is displayed using the second plot group defined in the COMSOL 
model. All the results are plotted in the same figure.

model = mphload('busbar');
w = [5e-2 10e-2 15e-2 20e-2];
for i = 1:4
    model.param.set('wbb',w(i));
    model.study('std1').run;
    subplot(2,2,i)
    mphplot(model,'pg2','rangenum',1)
end

The model run inside a MATLAB loop is not automatically saved. Make 
sure to save the model at each iteration. Use the command mphsave to 
save your model object. If you are not interested in saving the entire 
model object at each iteration, you can extract data and store it in the 
MATLAB workspace. See Extracting Results to find the most suitable 
function to your model.

Note
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The resulting figure is shown below:
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Runn i n g  Mode l s  i n  Ba t c h  Mode

Use LiveLink for MATLAB to models in batch mode. At the MATLAB prompt you 
can execute commands to set-up the batch job using the COMSOL built-in method 
or run custom scripts directly from a command line. In this section:

• The Batch Node

• Running A COMSOL M-file In Batch Mode

• Running A COMSOL M-file In Batch Mode Without Display

The Batch Node

Using the COMSOL Java API you can run model in loop. See The Batch Node.

Running A COMSOL M-file In Batch Mode

To run in batch a M-script that runs COMSOL Model, start COMSOL with 
MATLAB at a terminal window with the following command:

comsol server matlab myscript

where myscript is the M-script, saved as myscript.m, that contains the operation to 
run at the MATLAB prompt. 

The COMSOL does not automatically save the model. You need to make sure that the 
model is saved before the end of the execution of the script. See Loading and Saving a 
Model.

You can also run the script in batch without the MATLAB desktop and the MATLAB 
splash. Enter the command below:

comsol server matlab myscript -nodesktop -mlnosplash

Running COMSOL with MATLAB in batch mode as described in this chapter requires 
that you have xterm installed on your machine. If this is not the case see Running A 
COMSOL M-file In Batch Mode Without Display.
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Running A COMSOL M-file In Batch Mode Without Display

COMSOL with MATLAB requires that xterm is installed on the machine. If this is not 
the case as it be for computation server, a workaround is to connect manually 
MATLAB to a COMSOL server with the function mphstart.

The steps below describe how to follow to run a M-script that run COMSOL model

1 In a system terminal prompt start a comsol server with the command:

comsol server &

2 In the same terminal window change the path to the COMSOL installation 
directory:

cd COMSOL_path/mli

3 From that location, start MATLAB without display and run the mphstart function 
in order to connect MATLAB to COMSOL:

matlab -nodesktop -mlnosplash -r "mphstart; myscript"

You can get more information about how to connect MATLAB to a COMSOL server 
in Starting COMSOL with MATLAB on Windows / Mac OSX / Linux.
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Ex t r a c t i n g  S y s t em Ma t r i c e s

In this section:

• Extracting System Matrices

• Extracting State-Space Matrices

Extracting System Matrices

Extract the matrices of the COMSOL linearized system with the function mphmatrix. 
To call the function mphmatrix you need to specify solver node and the list of the 
system matrices to extract:

str = mphmatrix(model, <soltag>, 'out', out);

where <soltag> is the tag of the solver node used to assemble the system matrices and 
out a cell array containing the list of the matrices to evaluate. The output data str 
returned by mphmatrix is a MATLAB structure whose fields correspond to the 
assembled system matrices.

The system matrices that can be extracted with mphmatrix is listed in the table below:

EXPRESSION DESCRIPTION

K Stiffness matrix

L Load vector

M Constraint vector

N Constraint Jacobian

D Damping matrix

E Mass matrix

NF Constraint force Jacobian

NP Optimization constraint Jacobian (*)

MP Optimization constraint vector (*)

MLB Lower bound constraint vector (*)

MUB Upper bound constraint vector (*)

Kc Eliminated stiffness matrix

Lc Eliminated load vector

Dc Eliminated damping matrix
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(*) Requires the Optimization Module.

S E L E C T I N G  L I N E A R I Z A T I O N  PO I N T

The default selection of linearization point for the system matrix assembly consists in 
the current solution of the solver node associated to the assembly. 

If you do not specify the linearization point when calling mphmatrix, COMSOL 
automatically runs the entire solver configuration before assembling and extracting the 
matrices. 

You can save time during the evaluation by setting manually the linearization point. 
Use the initmethod property as in the command below:

str = mphmatrix(model, <soltag>, 'out', out, 'initmethod', method);

where method corresponds to the type of linearization point: the initial value 
expression ('init') or a solution ('sol').

You can set which solution to use for the linearization point with the property 
initsol:

str = mphmatrix(model, <soltag>, 'out', out, 'initsol', 
<initsoltag>);

where <initsoltag> is the solver tag to use for linearization point. You can also set 
the initsol property to 'zero', which correspond to use a null solution vector as 
linearization point. The default consists in the current solver node where the assemble 
node is associated.

For continuation, time-dependent or eigenvalue analysis you can set which solution 
number to use as linearization point. Use the solnum property as indicated below:

str = mphmatrix(model, <soltag>, 'out', out, 'solnum', <solnum>);

where <solnum> is an integer value corresponding to the solution number. The default 
value consist in the last solution number available with the current solver 
configuration.

Ec Eliminated mass matrix

Null Constraint null-space basis

Nullf Constraint force null-space matrix

ud Particular solution ud

uscale Scale vector

EXPRESSION DESCRIPTION
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E X A M P L E

The following example illustrates how to use the mphmatrix command to extract 
eliminated system matrices of a stationary analysis and linear matrix system at the 
MATLAB prompt.

The model consists in a linear heat transfer problem solved on a unit square with a 1e5 
W/m^2 surface heat source and temperature constraint. Only one quarter of the 
geometry is represented in the model. For simplification reason, the mesh is made of 
4 quad elements.

The commands below set the COMSOL model object:

model = ModelUtil.create('Model');

geom1 = model.geom.create('geom1', 2);
geom1.feature.create('sq1', 'Square');
geom1.run;

mat1 = model.material.create('mat1');
def = mat1.materialModel('def');
def.set('thermalconductivity',{'4e2'});

ht = model.physics.create('ht', 'HeatTransfer', 'geom1');
hs1 = ht.feature.create('hs1','HeatSource',2);
hs1.selection.set(1);
hs1.set('Q',1,'1e5');

temp1 = ht.feature.create('temp1','TemperatureBoundary',1);
temp1.selection.set([1 2]);

mesh1 = model.mesh.create('mesh1','geom1');
dis1 = mesh1.feature.create('dis1','Distribution');
dis1.selection.set([1 2]);
dis1.set('numelem','2');
mesh1.feature.create('map1','Map');

std1 = model.study.create('std1');
std1.feature.create('stat','Stationary');
std1.run;

To extract the solution vector of the computed solution, run the function mphgetu as 
in the command below:

U = mphgetu(model);

To assemble and extract the eliminated stiffness matrix and the eliminated load vector, 
you need to set the linearization point to the initial value expression, type:

MA = mphmatrix(model ,'sol1', ...
E X T R A C T I N G  S Y S T E M  M A T R I C E S  |  145



146 |  C H A P T E
    'Out', {'Kc','Lc','Null','ud','uscale'},...
    'initmethod','init');

Solve for the eliminated solution vector using the extracted eliminated system:

Uc = MA.Null*(MA.Kc\MA.Lc);

Combine the eliminated solution vector and the particular vector:

U0 = Uc+MA.ud;

Scale back the solution vector:

U1 = (1+U0).*MA.uscale;

Now compare both solution vector U and U1 computed by COMSOL and by the 
matrix operation respectively.

Extracting State-Space Matrices

Use state-space export to create a linearized state-space model corresponding to a 
COMSOL Multiphysics model. You can export the matrices of the state-space form 
directly to the MATLAB workspace with the command mphstate.

T H E  S T A T E - S P A C E  S Y S T E M

A state-space system is the mathematical representation of a physical model. The 
system consistent in an ODE linking input, output and state-space variables. A 
dynamic system can be represented with the following system:

An alternative representation of the dynamic system is:

This form is more suitable for large systems because the matrices MC and MA usually 
become much more sparse than A.

If the mass matrix MC is small, it is possible to approximate the dynamic state-space 
model with a static model, where MC= 0:

dx
dt
------- Ax Bu+=

y Cx Du+=





Mcx· McAx= McBu+

y Cx Du+=

y D C McA  1– McB– u=
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Let Null be the PDE constraint null-space matrix and ud a particular solution fulfilling 
the constraints. The solution vector U for the PDE problem can then be written

where u0 is the linearization point, which is the solution stored in the sequence once 
the state-space export feature is run.

E X T R A C T  S T A T E - S P A C E  M A T R I C E S

The function mphstate requires that you define the input and output variables and the 
list of the matrices you want to extract in the MATLAB workspace:

str = mphstate(model, <soltag>, 'input', <input>, ...
    'output', <output>, 'out', out);

where <soltag> is the tag of the solver node to use to assemble the system matrices 
listed in the cell array out. <input> and <output> are cell arrays containing the list of 
the input and output variables respectively.

The output data str returned by mphstate is a MATLAB structure whose fields 
correspond to the assembled system matrices.

The input variables need to be defined as parameters in the COMSOL model. The 
output variables are defined as domain point probes or global probes in the COMSOL 
model.

The system matrices that can be extracted with mphstate is listed in the table below:

To extract sparse matrices set the property sparse to on:

EXPRESSION DESCRIPTION

MA McA matrix

MB McB matrix

A A matrix

B B matrix

C C matrix

D D matrix

Mc Mc matrix

Null Null matrix

ud ud vector

x0 x0 vector

U Nullx ud u0+ +=
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str = mphstate(model, <soltag>, 'input', <input>, ...
    'output', <output>, 'out', out, 'sparse', 'on');

To keep the state-space feature node set the property keepfeature to on:

str = mphstate(model, <soltag>, 'input', <input>, ...
    'output', <output>, 'out', out, 'keepfeature', 'on');

S E T  L I N E A R I Z A T I O N  PO I N T

mphstate uses linearization point to assemble the state-space matrices. The default 
linearization point consists in the current solution provided by the solver node which 
the state-space feature node is associated. If there is no solver associated to the solver 
configuration, a null solution vector is used as linearization point.

You can however manually select which linearization point to use. Use the 
initmethod property to select a linearization point:

str = mphstate(model, <soltag>, 'input', <input>, ...
    'output', <output>, 'out', out, 'initmethod', method);

where method corresponds to the type of linearization point: the initial value 
expression ('init') or a solution ('sol').

You can set which solution to use for the linearization point with the property 
initsol:

str = mphstate(model, <soltag>, 'input', <input>, ...
    'output', <output>, 'out', out, 'initsol', <initsoltag>);

where <initsoltag> is the solver tag to use for linearization point. You can also set 
the initsol property to 'zero', which correspond to use a null solution vector as 
linearization point. The default consists in the current solver node where the assemble 
node is associated.

For continuation, time-dependent or eigenvalue analysis you can set which solution 
number to use as linearization point. Use the solnum property as indicated below:

str = mphstate(model, <soltag>, 'input', <input>, ...
    'output', <output>, 'out', out, 'solnum', <solnum>);

The linearization point needs to be a steady-state solution.

Note
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where <solnum> is an integer value corresponding to the solution number. The default 
value consist in the last solution number available with the current solver 
configuration.

E X A M P L E

To illustrate how to use the mphstate function to extract the state-space matrices of 
the model heat_transient_axi from the COMSOL Multiphysics Model Library. To be 
able to extract the state-space matrices you will need to do some modification of 
existing model. First of all create a parameter T0 that is set as external temperature. 

model = mphload('heat_transient_axi');
model.param.set('Tinput','1000[degC]');
model.physics('ht').feature('temp1').set('T0', 1, 'Tinput');

Then you need to create a domain point probe:

pdom1 = model.probe.create('pdom1', 'DomainPoint');
pdom1.model('mod1');
pdom1.setIndex('coords2','0.28',0,0);
pdom1.setIndex('coords2','0.38',0,1);

You can now extract the matrices of the state-space system using Tinput as input 
variables and the probe mod1.ppb1 as output variable:

M = mphstate(model,'sol1','out',{'Mc' 'MA' 'MB' 'C' 'D'},...
         'input','T0', 'output', 'mod1.ppb1');

You can now compute the state-space system with the extracted matrices:

T0 = 273.15;
Tinput = 1273.15-T0;

opt = odeset('mass', M.Mc);
func = @(t,x) M.MA*x + M.MB*Tinput;
[t,x] = ode23s(func, [0:10:190], zeros(size(M.MA,1),1), opt);
y = M.C*x';
y = y+T0;

Compare the solution computed with the state-space system and the one computed 
with COMSOL:

plot(t,y)
hold on
Tnum = mphinterp(model,'T','coord',[0.28;0.38],'t',t);
plot(t,Tnum,'r+')
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Figure 4-1: Temperature distribution computed with the state-space system (blue line) and 
COMSOL Multiphysics (red marker)
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Ex t r a c t i n g  S o l u t i o n  I n f o rma t i o n  and 
S o l u t i o n  V e c t o r

In this section:

• Obtaining Solution Information

• Extracting Solution Vector

Obtaining Solution Information

Get the solution object information with the function mphsolinfo. Specify only the 
model object to obtain the information of the default solution object:

info = mphsolinfo(model)

S P E C I F Y I N G  T H E  S O L U T I O N  O B J E C T

To retrieve the information of a specific solution object, you can set the solname 
property with the solver tag soltag associated to the solution object:

info = mphsolinfo(model, 'soltag', <soltag>);

If you have several solution data set attached to the solver, for instance solution data 
sets with different selection, you can specify which data set to use to get the solution 
object information with the dataset property:

info = mphsolinfo(model, 'dataset', <dsettag>);

where dsettag the tag of the solution data set to use.

The function mphsolinfo replaces the function mphgetp.

Note
E X T R A C T I N G  S O L U T I O N  I N F O R M A T I O N  A N D  S O L U T I O N  V E C T O R  |  151



152 |  C H A P T E
O U T P U T  F O R M A T

The output info is a MATLAB structure. The default fields available in the structure 
are listed in the table below:

To get the information about the number of solutions, set the property nu to on:

info = mphsolinfo(model, 'nu', 'on');

The info structure is added with the following fields:

The batch field is a a structure including the following fields:

FIELDS DESCRIPTION

soltag Tag of the solver associated to the solution object

study Tag of the study associated to the solution object

size Size of the solution vector

nummesh Number of mesh in the solution (for automatic remeshing)

sizes Size of solution vector and inner parameters for each mesh

soltype Solver type

solpar Parameter name

sizesolvals Length of parameter list

solvals Inner parameter value

paramsweepnames Outer parameter name

paramsweepvals Outer parameter value

batch Batch information

dataset Tag of the solution data set associated to the solution object

FIELDS DESCRIPTION

NUsol Number of solutions vectors stored

NUreacf Number of reaction forces vectors stored

NUadj Number of adjacency vectors stored

NUfsens Number of functional sensitivity vectors stored

NUsens Number of forward sensitivity vectors stored

BATCH FIELDS DESCRIPTION

type The type of batch

psol Tag of the associated solver node
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Extracting Solution Vector

Extracts the solution vector with the function mphgetu:

U = mphgetu(model);

where U is Nx1 double array, where N is the number of degrees of freedom of the 
COMSOL model.

You can refer to the function mphxmeshinfo to receive the dof name or the node 
coordinates in the solution vector, see the section Retrieving Xmesh Information.

S P E C I F Y I N G  T H E  S O L U T I O N

Change the solver node to extract the solution vector with the property solname:

U = mphgetu(model, 'soltag', <soltag>);

where <soltag> is the tag of the solver node.

For solver settings that compute for several inner solution, you can select which inner 
solution to use with the solnum property:

U = mphgetu(model, 'solnum', <solnum>);

where <solnum> a positive integer vector that correspond to the solution number to 
use to extract the solution vector. For time-dependent and continuation analysis the 
default value for the solnum property consists in the last solution number. For an 
eigenvalue analysis it consists in the first solution number.

A model can contains different type of solution vector, the solution of the problem but 
also the reaction forces vector, the adjoint solution vector, the functional sensitivity 
vector or the forward sensitivity. In mphgetu, you can specify which type of solution 
vector to extract with the type property:

U = mphgetu(model, 'type', type);

where type is one of the following string 'sol', 'reacf', 'adj' or 'sens'to extract 
the solution vector, the reaction forces, the functional sensitivity or the forward 
sensitivity respectively.

sol Tag of the stored solution associated to psol

seq Tag of the solver sequence associated to psol

BATCH FIELDS DESCRIPTION
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O U T P U T  F O R M A T

mphgetu returns by the default the solution vector. Get the time derivative of the 
solution vector Udot by adding a second output variable:

[U, Udot] = mphgetu(model);

In case the property solnum is set as a 1x M array and the solver node only use one 
mesh to create the solution, the default output consists in a a NxM array, where N is 
the number of degrees of freedom of the model. Else the output U is a cell array that 
contains each solution vector. If you prefer to have the output in a cell array format, 
set the property matrix to off:

U = mphgetu(model, 'solnum', <solnum>, 'matrix', 'off');
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Re t r i e v i n g  Xme s h  I n f o rma t i o n

Use LiveLink for MATLAB to retrieve at the MATLAB workspace low level 
information of the COMSOL finite element model.

The Extended Mesh (Xmesh)

The extended mesh (xmesh) is the finite element mesh that is used to compute the 
solution. This contains the information about elements, nodes and degrees of freedom 
such as dof names, position of the nodes in the assembled matrix system or how 
element and nodes are connected.

Extracting Xmesh Information

The function mphxmeshinfo returns the extended mesh information. To get the 
xmesh information of the current solver and mesh node type the command:

info = mphxmeshinfo(model);

where info is a MATLAB structure that contains the fields listed in the following table:

The dofs substructure contains the fields listed in the following table:

FIELDS DESCRIPTION

soltag Tag of the solver node

ndofs Number of degrees of freedom

fieldnames List of field variables names

fieldndofs Number of degrees of freedom for each field variables

meshtypes List of the mesh type

geoms Tag of the geometry node used in the model

dofs Structure containing the dofs information

nodes Structure containing the nodes information

elements Structure containing the elements information

FIELDS DESCRIPTION

geomnums Index of the geometry tag for each dofs

coords Coordinates of the dofs

nodes Nodes index of the dofs
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The nodes substructure contains the fields listed in the following table:

The element substructure contains the fields listed in the following table:

The type substructure list the information for each element. The possible mesh types 
are vtx, edg, quad, tri, quad, tet, hex, prism and pyr. The substructure type 
contains the fields listed in the following table:

S P E C I F Y  T H E  I N F O R M A T I O N  TO  R E T R I E V E

You can specify the solver node to use to retrieve the xmesh information, set the 
property solname as in the command below:

info = mphxmeshinfo(model, 'soltag', <soltag>);

where <soltag> is the tag of the solver use to extract the xmesh information.

You can also retrieve the xmesh information for a specific study step node which is 
specified with the property studysteptag:

dofnames Variable names

nameinds Variable names index of the dofs

FIELDS DESCRIPTION

coords Nodes coordinates

dofnames Variable names

dofs NxM array containing the index (0-based) of the dofs for each 
node. N being the length of dofnames and M the number of 
nodes 

FIELDS DESCRIPTION

meshtypes List of the type of mesh available

type Substructure containing the information of element of type 
type

FIELDS DESCRIPTION

localcoords Local nodes coordinates 

localdofcoords Local dofs coordinates

localdofnames Names of the local dofs

nodes Nodes index for each element

dofs Dofs index for each element

FIELDS DESCRIPTION
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info = mphxmeshinfo(model, 'studysteptag', <studysteptag>);

where <studysteptag> is the tag of either a compile equation node or a variable 
node.

In case several mesh case have been used by a specific solver, for instance with an 
automatic remeshing procedure, you can specify which mesh case to use to get the 
discretization information.

info = mphxmeshinfo(model, 'meshcase', <meshcase>);

where <meshcase> is the mesh case number or the tag of the mesh case.
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Nav i g a t i n g  t h e  Mode l

The model object contains all the finite element model settings. To retrieve the model 
information you can navigate in the model object by the mean of a graphical user 
interface or directly at the MATLAB prompt. See how to get the list of predefined 
expressions available for a given model and how to extract the value of these 
expressions and also the properties of the method used in the model.

In this section:

• Navigating The Model Object Using a GUI

• Navigating The Model Object At The Command Line

• Finding Model Expressions

• Getting Feature Model Properties

• Getting Model Expressions

• Getting Selection Information

Navigating The Model Object Using a GUI

The usual approach to navigate through the model object in a graphical user interface 
is simply to load the model object at the COMSOL Desktop. You can directly transfer 
the model object form the COMSOL server to the COMSOL Desktop as indicated in 
the section Exchanging Models Between MATLAB and the COMSOL Desktop of the 
chapter Building Models.

An alternative approach is to call the function mphnavigator that displays the model 
object information in a MATLAB graphical user interface. To run the function type at 
the MATLAB prompt the command:

mphnavigator

Prior to call mphnavigator, make sure that the MATLAB object linked 
the COMSOL model object as the name model. No other name is 
currently supported.Note
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This command pops-up a MATLAB GUI as in the figure below:

If you create new model object with the MATLAB object name model, you need to 
restart mphnavigator in order to have the updated model information.

T H E  M E N U  B A R  I T E M S

The mphnavigator GUI menu bar consist in the following menu:

• the File menu, where you can save the current model object in the MPH-format, you 
can also open a new model object and close the mphnavigator window.

• the Tools menu lists the navigating tools available for the model object. Search is a 
shortcut to the command mphsearch that start a GUI for searching expressions or 
tags in the model object, see also the section Finding Model Expressions for more 
information. Solutions starts a GUI to display the solution object available in the 
COMSOL model object. Show Errors lists the error or warning node available in the 
model object, see the section Handling Errors And Warnings for more information.

• the Settings menu only contains the Advanced options. Click on it to select or 
deselect the advanced model object methods that are displayed in the Model Viewer 
tree.

• the Help menu.
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T H E  S H O R T C U T  I C O N

Just under the menu bar you will find two shortcut icon: the Plot icon and the Help 
icon. 

These icon are grayed if you have not selected any method in the Model Tree section. 

The Plot icon displays the geometry, the mesh or a plot group in a MATLAB figure.

The Help icon displays the page of the COMSOL Java API Reference Guide of the 
corresponding method in your default web browser.

T H E  M O D E L  TR E E  S E C T I O N

In the Model Tree section you will find the list of the nodes of the model object. Use 
the scroll bar at the right side to scroll down the list and click on the + icon to expand 
the model object feature nodes.

When a feature node is selected, its associated command is listed just beneath the 
model tree. Click the Copy button to copy syntax in the clip board, you can then paste 
it in your script.

You can notice that the Model Tree list slightly differs to the Model Builder list available 
in the COMSOL Desktop. This is because mphnavigator display all feature nodes and 
do not use the same filter as in the COMSOL Desktop to order the available feature 
node.
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T H E  P R O P E R T I E S  S E C T I O N

In the Properties section you will find all the properties of a selected feature node and 
their associated value.

Click Copy Table button to copy the entire properties table in the clip board which can 
the be paste in text or spreadsheet editor.

Click Copy button to copy a selected cell in the properties table.

T H E  M E T H O D S  S E C T I O N

In the Methods section you will find the list of all the methods associated to the feature 
node selected in the Model Tree section. 

Click Filter button to filter the reduce the methods list to the one that returns simple 
information.

Select a method in the list to get its associated syntax at the button of the Methods 
section. Use the Copy button to copy the syntax in the clipboard.
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Navigating The Model Object At The Command Line

Retrieve model object information such as tags for nodes and subnodes of a COMSOL 
model object at the MATLAB prompt with the command mphmodel.

To get the list of the main feature node and their tags of the model object model, type 
the command:

mphmodel(model)

To list the subfeature of the node type model.feature enter the command:

mphmodel(model.feature)

To list the subfeature node of the feature node model.feature(<ftag>), type:

mphmodel(model.feature(<ftag>))

Use the flag -struct to returns the model object information to MATLAB structure:

str = mphmodel(model.feature,'-struct')

str is a MATLAB structure which fields consist in each feature node associated to the 
node model.feature.

Finding Model Expressions

Each model object contains predefined expressions that depends on the physics 
interface used in the model.
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The function mphsearch starts a MATLAB GUI that display the list all the 
expressions, constant, solution variables or parameters available in the model object.

The table contains the following information for each entry: the name of the 
expression, the expression as it is set in the property value, the description if there is one 
set for the expression, the type of the expression and the path in the model object.

In the Search section you will find a searching tool to filter the list among all the 
possibilities. Enter any string in the edit field and select where to search this string: in 
the name, the expression or the description of the table entry. You can also select the 
type you want to list. The expression type can be any of Equation, Field, Tag, VarNames 
or Weak.

Click Go button to display the result of the search. Click Clear button to clear the search 
settings.

Use the Copy button to copy in the clip board any entry of the table.

Click Close button to close the mphsearch window.

Getting Feature Model Properties

Use the command mphgetproperties to extract at the MATLAB prompt the 
properties of a specified node of the model object. Use the command as:

prop = mphgetproperties(model.feature)
N A V I G A T I N G  T H E  M O D E L  |  163



164 |  C H A P T E
where expr is a MATLAB structure that list all the properties and their value of the 
feature node model.feature.

Getting Model Expressions

Use the command mphgetexpressions to get at the MATLAB prompt the 
expressions and the descriptions of a specified node of the model object. Use the 
command as:

expr = mphgetexpressions(model.feature)

where model.feature is the node to get the expressions from and expr is a Nx3 cell 
array where N is the number of expressions for this node.

Getting Selection Information

Use the function mphgetselection to retrieve the model selection information.

str = mphgetselection(model.selection(<seltag>))

where seltag is the tag a selection node define in the model object. The output str 
is a MATLAB structure containing the following fields:

• dimension, the space dimension of the geometry entity selected.

• geom, the tag of the geometry node used in the selection.

• entities, the list of the entity indexes listed in the selection.

• isGlobal, Boolean value to indicate if the selection is global or not.
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Hand l i n g  E r r o r s  And Wa rn i n g s

In this section:

• Errors and Warnings

• Using MATLAB Tools To Handle COMSOL Exception

• Displaying Warning and Error in the Model

Errors and Warnings

COMSOL Multiphysics reports problems of two types:

• Errors, which prevent the program from completing a task

• Warnings, which are problems that do not prevent the completion of a task but that 
might affect the accuracy or other aspects of the model.

For both errors and warnings a messages is stored in a separate node located just below 
the problematic model feature node.

In case of errors a Java Exception is thrown to MATLAB, which also break the 
execution of the script.

Using MATLAB Tools To Handle COMSOL Exception

Where running a model that returns an error in MATLAB, the execution of the script 
is automatically stopped. You have however the possibility to use MATLAB tools to 
handle exception and prevent the script to break. Use the try and catch MATLAB 
statement to offers alternative to a failed model. 

In a loop, for instance, use the try and catch statement to continue to the next iteration. 
For automatic geometry or mesh generation you can use it to set the model properties 
with alternative value that circumvent the problem.

Displaying Warning and Error in the Model

Use the command mphshowerrors to search in a given model object for the warnings 
or the errors nodes.

To display the error and warning messages and their location in the model object type 
the command:
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mphshowerrors(model)

Alternatively mphshowerrors can also returns the errors and warning information in 
a MATLAB variable:

str = mphshowerrors(model)

where str is a Nx2 cell array, with N the number of error and warning nodes that 
contains the model object. str{i,1} contains the location in the model of the ith 
error/warning message and str{i,2} contains the message of the ith error/warning 
message.
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Imp r o v i n g  P e r f o rman c e  f o r  L a r g e  
Mode l s

Memory management is a key of successful modeling. In COMSOL Multiphysics the 
finite element model can store a large amount of data depending on the complexity of 
the model. Exchanging such a large amount of data between MATLAB and the 
COMSOL server can be problematic in term of memory or computational time. In 
this section you will find a discussion for model settings in the case you are 
experiencing memory problem or slowness of command execution. The section 
consists in the following paragraph:

• Setting Java Heap Size

• Disabling Model Feature Update

• Disabling The Model History

Setting Java Heap Size 

COMSOL store the data in Java. If you are experiencing memory problem during 
meshing, postprocessing operation or when exchanging data between the COMSOL 
server and MATLAB this may indicate that the Java Heap size is set with too low value. 

T H E  C O M S O L  S E R V E R  J A V A  H E A P  S I Z E

You can access the Java Heap size settings for the COMSOL server process in the 
comsolserver.ini file that can be found in the COMSOL43/bin/<arch> directory. 
<arch> correspond to the architecture of the machine where the COMSOL server is 
running. Edit the file with a text editor, you will find the Java heap settings set as:

-Xss4m
-Xms40m
-Xmx1024m
-XX:MaxPermSize=256m

The values are given in Mb, modify these value to satisfy your model requirements.

Increasing the memory allocated for the Java process, necessarily decrease 
the memory available for the solver.

Note
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T H E  M AT L A B  J A V A  H E A P  S I Z E

To modify the Java heap size you need to edit the java.opts file available under the 
COMSOL with MATLAB start-up directory. The java.opts file is stored by default 
with the following settings:

-Xss4m
-Xmx768m
-XX:MaxPermSize=256m

The values are given in Mb, modify these value to satisfy your model requirements.

To modify the MATLAB Java Heap size the java.opts file has to be stored at the 
MATLAB start-up directory. This is the case when starting COMSOL with MATLAB.

In case you are connecting manually MATLAB with a COMSOL server, make sure you 
have the java.opts at the MATLAB start-up directory.

Disabling Model Feature Update

For models that contains a large amount of physics feature nodes, it may help to 
deactivate the model feature update while implementing the model object. By default 
COMSOL update the expressions value for every feature node in the model, which can 
take some time.

To disable the feature model update enter:

model.disableUpdates(true);

You need to enable the feature update prior to compute the solution unless the model 
expressions would not be updated accordingly to the model settings. This is also 
necessary if you are building a geometry or a mesh that depends on expressions. 

To enable the feature model update enter:

model.disableUpdates(false);

Disabling The Model History

If you are experiencing slow down of the operation run in loop as the number iteration 
increase. A possible reason is that the model history use significant amount memory 
that can no longer be accessible by the COMSOL operation. You can disable the 
history recording to keep the model history information low. 

To disable the model history type the command:

model.hist.enable
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When the model history is disabled you will no longer see the commands use to set up 
the model when saving it as a M-file.

If you load the model object with the function mphload, it automatically disable the 
model history.

To activate the model history enter the command:

model.hist.disable
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C r e a t i n g  Cu s t om GU I

You can use the MATLAB guide functionality to create a GUI and connect the 
interface to a COMSOL model object. Each operation at the GUI set the value of a 
MATLAB variable or call a MATLAB command. As described in this manual you can 
call command at the MATLAB prompt to set up a COMSOL model object or set 
MATLAB variable in the COMSOL model object.

The figure below illustrates a GUI made in MATLAB linked to a COSMOL model 
object. 

The simplified GUI only allow the user to compute a heat transfer problem on a given 
geometry. The user can only change the radius and the position of the bottom circle 
geometry. The heat source applied to the bottom circle is also defined by the user. 

The button execute the building operation of the geometry and mesh. Another button 
execute the computation of the solution.
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COMSOL 3 . 5 a  Compa t i b i l i t y

COMSOL makes a effort to be backward compatible: you can load model MPH-files 
created in COMSOL Multiphysics 3.5a and later versions in COMSOL Multiphysics 
4.3.

When going from version 3.5a to version 4, a major revision was made to the 
MATLAB interface. This revision was made to reflect changes made to the new user 
interface and to support parameterized geometry operations. As a result, a new 
MATLAB interface syntax is used in today's version 4 of COMSOL Multiphysics and 
its add-on product LiveLink for MATLAB.

In order to assist in the conversion process, a special compatibility mode was created 
to facilitate the new syntax. This compatibility mode, together with LiveLink for 
MATLAB function mphv4, is no longer supported in COMSOL Multiphysics 4.3.

If you wish to convert a model defined with an M-file created with version 3.5a to the 
version 4.3 format, we recommend the following procedure:

1 Run the M-file using COMSOL Multiphysics 3.5a and save the model, using flsave, 
as an MPH-file.

2 Load the model into COMSOL Multiphysics 4.3 and verify that the model settings 
have been translated correctly. In addition, verify that the model can be meshed and 
solved.

3 Select File>Reset history.

4 Select File>Save as Model M-file.

The saved M-file can now be tested if you start COMSOL Multiphysics 4.3 with 
MATLAB.

If you have any problems with this conversion process, please contact COMSOL's 
technical support team at support@comsol.com, or your local COMSOL 
representative. 
C O M S O L  3 . 5 A  C O M P A T I B I L I T Y  |  171



172 |  C H A P T E
 R  4 :  W O R K I N G  W I T H  M O D E L S



 5
C a l l i n g  M A T L A B  F u n c t i o n  
This section introduces you to the MATLAB function callback from the 
COMSOL Desktop and COMSOL model object.
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Th e  MAT LAB Fun c t i o n  F e a t u r e  Node

Use MATLAB M-function in the COMSOL model to define model settings such as 
parameters, material properties, and boundary conditions. 

When running the model COMSOL automatically starts a MATLAB process that 
evaluates the function and return the value to the COMSOL model.

• Defining MATLAB Function In The COMSOL Model

• Adding A MATLAB Function with the COMSOL API Java Syntax

Defining MATLAB Function In The COMSOL Model

A D D I N G  T H E  M AT L A B  F U N C T I O N  N O D E

To evaluate a MATLAB M-function from within the COMSOL model you need to 
add a MATLAB node in the model object where you define the function name, the list 
of the arguments, and, if required, the function derivatives.

To call a MATLAB function from within the model object you do not 
need to start COMSOL with MATLAB—starting the COMSOL 
Desktop is sufficient. The MATLAB process starts automatically to 
evaluate the function.Note
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To a MATLAB function node, right-click the Global Definitions node and select 
Functions>MATLAB.

The settings window of the MATLAB node contains the following section: 

• Functions where you declare the name of the MATLAB functions and their 
arguments.

• Derivatives, where you define the derivative of the MATLAB functions with respect 
to all function arguments.

• Plot Parameters where you can define the limit of the arguments value in order to 
display the function in the COMSOL Desktop main-axis.
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D E F I N I N G  T H E  M AT L A B  F U N C T I O N

The figure below illustrate the MATLAB settings page 

Under the Functions section you can define the function name and the list of the 
function arguments.

In the table enter the function name under the Function column and the function 
argument in the Arguments column.

The table support multiple function definition. Define several functions in the same 
table or add several MATLAB node at your convenience.

P L O T T I N G  T H E  F U N C T I O N

Use the Plot button to display the function in the COMSOL Desktop main axis.

Use the Create Plot button to create a plot group under the Results node.

To plot the function you need to first define the argument limit. Expand the Plot 

Parameters section and enter the desired value in the Lower limit and Upper limit 
column. In the Plot Parameters table the number of row correspond to the number of 
input arguments of the function. The first input arguments correspond to the top row.

In case of you have several functions declare in the Functions table, only the function 
that have the same number of input arguments as plot parameters row is plotted. If you 
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have several functions with same number of input arguments, the first function in the 
table (from top to bottom) is then plotted. Use the Move Up and Move Down button to 
change the order of the function.

E X A M P L E :  D E F I N E  T H E  H A N K E L  F U N C T I O N  I N  T H E  C O M S O L  D E S K T O P

Assume that you want to use MATLAB’s Bessel function of the third kind (Hankel 
function) in COMSOL Multiphysics define the following settings:

To plot the function you need to define first the lower and upper limit for both nu and 
x. In the Plot Parameters table set the two first row of the Lower limit column to 0 and 
the Upper limit column to 5:

FUNCTION ARGUMENTS

besselh nu, x
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Click Plot button to get the same plot as below:

Adding A MATLAB Function with the COMSOL API Java Syntax

To add a MATLAB feature node to the COMSOL model using the COMSOL API 
Java, enter the command:

model.func.create(<ftag>, 'MATLAB');

Define the function name and function arguments with the command:

model.func(<ftag>).setIndex('funcs', <function_name>, 0, 0);
model.func(<ftag>).setIndex('funcs', <arglist>, 0, 1);

where <function_name> is a string set with the function name and <arglist> is a 
string that define the list of the input arguments.
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Add i t i o n a l  I n f o rma t i o n

In this section:

• Function Input/Output Considerations

• Updating The Functions

• Defining Function Derivatives

• Using the MATLAB Debugger (Windows OS only)

Function Input/Output Considerations

The functions called from COMSOL must support vector arguments of any length. 
COMSOL calls your MATLAB function using vector arguments because the number 
of expensive calls from COMSOL to MATLAB can be reduced this way. All common 
MATLAB functions such as sin, abs, and other mathematical functions support 
vector arguments.

When you write your own functions for specifying inhomogeneous materials, logical 
expressions, time-dependent sources, or other model properties, remember that the 
input arguments are vectors. The output must have the same size as the input. All 
arguments and results must be double-precision vectors. Values can be real or complex. 

Consider the following example function where the coefficient c depends on the x 
coordinate:

function c = func1(x)
if x > 0.6
  c = x/1.6;
else
  c = x^2+0.3;
end

This function looks good at first but it does not work in COMSOL Multiphysics 
because the input x is a matrix.

• You must use element-by-element multiplication, division, and power—that is, the 
operators .*, ./, and .^. Replace expressions such as x/1.6 and x^2+0.3 with x./
1.6 and x.^2+0.3, respectively.

• The comparison x  0.6 returns a matrix with ones (true) for the entries where the 
expression holds true and zeros (false) where it is false. The function evaluates the 
conditional statement if and only if all the entries are true (1).
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You can replace the if statement with a single assignment to the indices retrieved from 
the x  0.6 operation and another assignment to the indices where . All in all, 
the function could look like this:

function c = func2(x)
c = (x./1.6).*(x>0.6) + (x.^2+0.3).*(x<=0.6);

Updating The Functions

If you have modified the function M-file using a text editor, click Clear Functions 
button to ensure the functions modifications to be updated in the COMSOL model.

An alternative is to select Clear functions automatically before solving.

Defining Function Derivatives

Automatic differentiation cannot be operated with MATLAB function. In case the 
MATLAB function has Jacobian contribution you need to define its derivative with 
respect to the function input arguments. By default COMSOL assumes the derivatives 
to be null.

You can expand the Derivatives section to define the derivatives of the function with 
respect to the function arguments. 

In the table define the derivative for each of the function arguments. In the Function 
column enter the function name, in the Argument column enter the argument with 
respect to which you will define the function derivatives. Finally in the Function 

derivative column enter the function derivative expression.

Note that the function derivative expression can also be defined by another external 
MATLAB function.

x 0,6
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For example, using the Hankel function describe in the previous section (see page 177) 
you can define the function derivative by setting the table as described below:

Using the MATLAB Debugger (Windows OS only)

If you are running on Windows OS, you can benefit of the MATLAB debugger when 
running MATLAB function in the COMSOL Model.

To activate the MATLAB debugger, you need first to start the MATLAB Desktop 
from the MATLAB process that is started when evaluating the function in COMSOL. 
At the MATLAB prompt type the command desktop.

In the COMSOL Desktop edit the function M-file and add breakpoint at the desired 
line. Now when you run the COMSOL model, the MATLAB debugger automatically 
stops at the break point. You can then verify the intermediate value of the function 
variables.

FUNCTION ARGUMENT FUNCTION DERIVATIVE

besselh nu (besselh(nu-1,x)-besselh(nu+1,x))/2

besselh x (besselh(0,x)-besselh(2,x))/2
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 6 
C o m m a n d  R e f e r e n c e
The main reference for the syntax of the commands available with LiveLink for 
MATLAB is the COMSOL Java API Reference Guide. This section documents 
additional interface functions that come with the product.
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S umma r y  o f  C ommand s
colortable
mphdoc
mpheval
mphevalglobalmatrix
mphevalpoint
mphgeom
mphgetadj
mphgetcoords
mphgetexpressions
mphgetproperties
mphgetselection
mphgetu
mphglobal
mphimage2geom
mphint2
mphinterp
mphload
mphmatrix
mphmax
mphmean
mphmesh
mphmeshstats
mphmin
mphmodel
mphmodellibrary
mphnavigator
mphplot
mphsave
mphsearch
mphselectbox
mphselectcoords
mphshowerrors
mphsolinfo
mphstart
mphstate
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mphversion
mphviewselection
mphxmeshinfo
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Command s  G r oup ed b y  Fun c t i o n

Interface Functions

Geometry Functions

Mesh Functions

Utility Functions

FUNCTION PURPOSE

mphcd Change directory to the directory of the model.

mphdoc Return HTML help of a specified function.

mphload Load a COMSOL model MPH-file.

mphsave Save a COMSOL model.

mphstart Connect MATLAB to a COMSOL server.

mphversion Return the version number of COMSOL Multiphysics.

FUNCTION PURPOSE

mphgeom Plot a geometry in a MATLAB figure.

mphimage2geom Convert image data to geometry.

mphviewselection Display a geometric entity selection in a MATLAB figure.

FUNCTION PURPOSE

mphmesh Plot a mesh in a MATLAB figure.

mphmeshstats Return mesh statistics and mesh data information.

FUNCTION PURPOSE

mphgetadj Return geometric entity indices that are adjacent to other.

mphgetcoords Return point coordinates of geometry entities

mphgetu Return solution vector.

mphmatrix Get model matrices.

mphselectbox Select geometric entity using a rubberband/box.

mphselectcoords Select geometric entity using point coordinates.
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Postprocessing Functions

Model information and navigation

mphsolinfo Get information about a solution object.

mphstate Get state-space matrices for dynamic system.

mphxmeshinfo Extract information about the extended mesh.

FUNCTION PURPOSE

mpheval Evaluate expressions on node points.

mphevalglobalmatrix Evaluate global matrix variables.

mphevalpoint Evaluate expressions at geometry vertices.

mphglobal Evaluate global quantities.

mphint2 Perform integration of expressions.

mphinterp Evaluate expressions in arbitrary points or data sets.

mphmax Perform maximum of expressions.

mphmean Perform mean of expressions.

mphmin Perform minimum of expressions.

mphplot Render a plot group in a figure window.

FUNCTION PURPOSE

mphgetproperties Get properties from a model node.

mphgetexpressions Get the model variables and parameters.

mphgetselection Get information about a selection node.

mphmodel Return tags for the nodes and subnodes in the COMSOL 
model object.

mphmodellibrary GUI for viewing the Model Library.

mphnavigator GUI for viewing the COMSOL model object.

mphsearch GUI for searching expressions in the COMSOL model 
object.

mphshowerrors Show messages in error and warning nodes in the 
COMSOL model object.

FUNCTION PURPOSE
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colortablePurpose Return a MATLAB colormap for a COMSOL color table.

Syntax map = colortable(name)

Description map = colortable(name) returns the color table (of 1024 colors) for name, where 
name can be one of the following strings:

Cyclic - A color table that varies the hue component of the hue-saturation-value 
color model, keeping the saturation and value constant (equal to 1). The colors 
begin with red, pass through yellow, green, cyan, blue, magenta, and finally return 
to red. This table is particularly useful for displaying periodic functions and has a 
sharp color gradient.

Disco - This color table spans from red through magenta and cyan to blue.

Discolight - Similar to Disco but uses lighter colors.

Grayscale - A color table that uses no color, only the gray scale varying linearly 
from black to white.

Grayprint - Varies linearly from dark gray (0.95, 0.95, 0.95) to light gray (0.05, 
0.05, 0.05). This color table overcomes two disadvantages that the GrayScale color 
table has when used for printouts on paper, namely that it gives the impression of 
being dominated by dark colors, and that white cannot be distinguished from the 
background.

Rainbow - The color ordering in this table corresponds to the wavelengths of the 
visible part of the electromagnetic spectrum: beginning at the small-wavelength end 
with dark blue, the colors range through shades of blue, cyan, green, yellow, and 
red.

Rainbowlight - Similar to Rainbow, this color table uses lighter colors.

Thermal - Ranges from black through red and yellow to white, which corresponds 
to the colors iron takes as it heats up.

Thermalequidistant - Similar to Thermal but uses equal distances from black to 
red, yellow, and white, which means that the black and red regions become larger.

Traffic - Spans from green through yellow to red.

Trafficlight - Similar to Traffic but uses lighter colors.

Wave - Ranges linearly from blue to light gray, and then linearly from white to red. 
When the range of the visualized quantity is symmetric around zero, the color red 
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or blue indicates whether the value is positive or negative, and the saturation 
indicates the magnitude.

Wavelight - Similar to Wave and ranges linearly from a lighter blue to white 
(instead of light gray) and then linearly from white to a lighter red.

Calling colortable is equivalent to calling the corresponding colormap function 
directly.

Example Create a rainbow color map

map = colortable('Rainbow');
map = rainbow;
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mphcdPurpose Change directory to the directory of the model

Syntax mphcd(model)

Description mphcd(model) changes the current directory in MATLAB to the directory where 
the model was last saved.

See aalso mphload, mphsave
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mphdoc
mphdocPurpose Return HTML help of a specified function.

Syntax mphdoc arg1
mphdoc arg1 arg2

Description mphdoc arg1 returns the HTML documentation associated to the function arg1.

mphdoc arg1 arg2 returns the HTML documentation associated to the feature 
arg2 of the method arg1.

mphdoc arg1 -web returns the HTML documentation in the default web browser.

Example Create a model object

model = ModelUtil.creat('Model')

Get the documentation for the mesh node

mphdoc model.mesh

Get the documentation of the rectangle geometry feature

mphdoc model.geom Rectangle

Display the documentation in the default web browser

mphdoc model.sol -web
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mphevalPurpose Evaluate expressions on node points.

Syntax pd = mpheval(model,{e1,...,en},...)

Description pd = mpheval(model,{e1,...,en},...) returns the post data pd for the 
expressions e1,...,en.

The output value pd is a structure with fields expr, p, t, ve, unit and fields for data 
values. 

• The field expr contains the expression name evaluated.

• For each expression e1,...,en a field with the name d1,... dn is added with 
the numerical values. The columns in the data value fields correspond to node 
point coordinates in columns in p. The data contains only the real part of 
complex-valued expressions.

• The field p contains node point coordinate information. The number of rows in 
p is the number of space dimensions. 

• The field t contains the indices to columns in p of a simplex mesh, each column 
in t representing a simplex. 

• The field ve contains indices to mesh elements for each node point. 

• The field unit contains the list of the unit for each expression. 

The function mpheval accepts the following property/value pairs:

TABLE 6-1:  PROPERTY/VALUE PAIRS FOR THE MPHEVAL COMMAND.

PROPERTY PROPERTY 
VALUE

DEFAULT DESCRIPTION

Complexfun off | on on Use complex-valued functions with 
real input

Complexout off | on off Return complex values

Dataonly off | on off Only return expressions value

Dataset String Data set tag

Edim point | 
edge | 
boundary | 
domain | 0 
| 1 | 2 | 3

Geometry 
space 
dimension 

Evaluate on elements with this 
space dimension

Matherr off | on off Error for undefined operations or 
expressions

Outersolnum Positive 
integer

1 Solution number for parametric 
sweep
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The property Dataset controls which data set is used for the evaluation. Data Sets 
contain or refer to the source of data for postprocessing purposes. Evaluation is 
supported only on Solution Data Sets.

The property Edim decides which elements to evaluate on. Evaluation takes place 
only on elements with space dimension Edim. If not specified, Edim equal to the 
space dimension of the geometry is used. The setting is specified as one of the 
following strings 'point', 'edge', 'boundary' or 'domain'. In previous 
versions it was only possible to specify Edim as a number. For example, in a 3D 
model, if evaluation is done on edges (1D elements), Edim is 1. Similarly, for 
boundary evaluation (2D elements), Edim is 2, and for domain evaluation (3D 
elements), Edim is 3 (default in 3D).

Use Recover to recover fields using polynomial-preserving recovery. This 
techniques recover fields with derivatives such as stresses or fluxes with a higher 
theoretical convergence than smoothing. Recovery is expensive so it is turned off by 
default. The value pprint means that recovery is performed inside domains. The 
value ppr means that recovery is also applied on all domain boundaries.

Pattern lagrange | 
gauss

lagrange Specifies if evaluation takes place in 
Lagrange points or in Gauss points

Phase Scalar 0 Phase angle in degrees

Recover off | ppr | 
pprint

off Accurate derivative recovery

Refine Integer 1 Refinement of elements for 
evaluation points

Selection Integer 
vector | 
string | 
all

All 
domains

Set selection tag or entity number

Smooth Internal | 
none | 
everywhere

internal Smoothing setting

Solnum Integer 
vector | 
all | end

all Solutions for evaluation

t Double 
array

Times for evaluation

TABLE 6-1:  PROPERTY/VALUE PAIRS FOR THE MPHEVAL COMMAND.

PROPERTY PROPERTY 
VALUE

DEFAULT DESCRIPTION
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The property Refine constructs evaluation points by making a regular refinements 
of each element. Each mesh edge is divided into Refine equal parts.

The property Smooth controls if the post data is forced to be continuous on element 
edges. When Smooth is set to internal, only elements not on interior boundaries are 
made continuous.

The property Solnum is used to select the solution to plot when a parametric, 
eigenvalue or time dependent solver has been used to solve the problem.

The property Outersolnum is used to select the solution to plot when a parametric 
sweep has been used in the study.

When the property Phase is used, the solution vector is multiplied with 
exp(i*phase) before evaluating the expression.

The expressions e1,...,en are evaluated for one or several solutions. Each solution 
generates an additional row in the data fields of the post data output structure. The 
property Solnum and t control which solutions are used for the evaluations. The 
Solnum property is available when the data set has multiple solutions, for example 
in the case of parametric, eigenfrequency, or time-dependent solutions. The t 
property is available only for time-dependent problems. If Solnum is provided, the 
solutions indicated by the indices provided with the Solnum property are used. If t 
is provided solutions are interpolated. If neither Solnum nor t is provided, all 
solutions are evaluated.

For time-dependent problems, the variable t can be used in the expressions ei. The 
value of t is the interpolation time when the property t is provided, and the time 
for the solution, when Solnum is used. Similarly, lambda and the parameter are 
available as eigenvalues for eigenvalue problems and as parameter values for 
parametric problems, respectively.

Example Load micromixer.mph from the Model Library:

model = mphload('micromixer.mph');

Evaluate the pressure p at all node points:

dat = mpheval(model,'p');

Evaluate the concentration c at the outlet boundary:

dat = mpheval(model,'c','edim','boundary','selection',136);

Evaluate the pressure on all geometric vertices:
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dat = mpheval(model,'p','edim','point');

Evaluate the pressure on vertex number 1 and return only the pressure value:

dat = mpheval(model,'p','edim','point',... 
'selection',1,'dataonly','on');

See also mphevalpoint, mphglobal, mphint2, mphinterp
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mphevalglobalmatrixPurpose Evaluate global matrix variables.

Syntax M = mphevalglobalmatrix(model,expr,...)

Description M = mphevalglobalmatrix(model,expr,...) evaluates the global matrix of the 
variable expr and returns the full matrix M.

The function mphevalglobalmatrix accepts the following property/value pairs:

Note: S-parameters evaluation requires the RF module.

Example Load lossy_circulator_3d.mph from the RF Module’s Model Library:

model = mphload('lossy_circulator_3d.mph');

Evaluate the S-parameters matrix using the solution data set dset4:

M = mphevalglobalmatrix(model,'emw.SdB','dataset','dset4');

See also mpheval, mphinterp, mphglobal

TABLE 6-2:  PROPERTY/VALUE PAIRS FOR THE MPHEVAL COMMAND.

PROPERTY PROPERTY 
VALUE

DEFAULT DESCRIPTION

Dataset String Data set tag
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mphevalpointPurpose Evaluate expressions at geometry vertices.

Syntax [v1,...,vn] = mphevalpoint(model,{e1,...,en},...)
[v1,...,vn,unit] = mphevalpoint(model,{e1,...,en},...)

Description [v1,...,vn] = mphevalpoint(model,{e1,...,en},...) returns the results 
from evaluating the expressions e1,...,en at the geometry vertices. The values 
v1,...,vn can either be a cell array or a matrix depending on the options.

[v1,...,vn,unit] = mphevalpoint(model,{e1,...,en},...) also returns 
the unit of all expressions e1,...,en in the 1xN cell array unit.

The function mphevalpoint accepts the following property/value pairs:

The property Dataset controls which data set is used for the evaluation. Data Sets 
contain or refer to the source of data for postprocessing purposes. Evaluation is 
supported only on Solution Data Sets.

TABLE 6-3:  PROPERTY/VALUE PAIRS FOR THE MPHEVAL COMMAND.

PROPERTY PROPERTY 
VALUE

DEFAULT DESCRIPTION

Dataset String Data set tag

Dataseries none | mean 
| int | max 
| min | rms 
| std | var

none The operation that is applied to the 
data series formed by the 
evaluation

Matrix off | on on Return a matrix if possible

Minmaxobj Real | abs real The value being treated if 
Dataseries is set to max or min

Outersolnum Positive 
integer

1 Solution number for parametric 
sweep

Selection Integer 
vector | 
string | 
all

All 
domains

Set selection tag or entity number

Smooth Internal | 
none | 
everywhere

internal Smoothing setting

Solnum Integer 
vector | 
all | end

all Solutions for evaluation

Squeeze on | off on Squeeze singleton dimension

t Double 
array

Times for evaluation
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The Dataseries property is used to control any filtering of the data series. The 
supported operations are: average (mean), integral (int), maximum (max), 
minimum (min), root mean square (rms), standard deviation (std) and variance 
(var).

Set the property Matrix to off to get the results in a cell array format.

In case the property Datseries is either min or max, you can specify the how the 
value are treated using the property Minmaxobj. Use either the real data or the 
absolute data.

The property Solnum is used to select the solution to plot when a parametric, 
eigenvalue or time dependent solver has been used to solve the problem.

The expressions e1,...,en are evaluated for one or several solutions. Each solution 
generates an additional row in the data fields of the post data output structure. The 
property Solnum and t control which solutions are used for the evaluations. The 
Solnum property is available when the data set has multiple solutions, for example 
in the case of parametric, eigenfrequency, or time-dependent solutions. The t 
property is available only for time-dependent problems. If Solnum is provided, the 
solutions indicated by the indices provided with the Solnum property are used. If t 
is provided solutions are interpolated. If neither Solnum nor t is provided, all 
solutions are evaluated.

For time-dependent problems, the variable t can be used in the expressions ei. The 
value of t is the interpolation time when the property t is provided, and the time 
for the solution, when Solnum is used. Similarly, lambda and the parameter are 
available as eigenvalues for eigenvalue problems and as parameter values for 
parametric problems, respectively.

Example Load shallow_water_equations.mph from the Model Library:

model = mphload('shallow_water_equations.mph');

Evaluate the elevation Z at point number 2:

dat = mphevalpoint(model,'Z','selection',2);

Evaluate the maximum value of the elevation with respect to the time at point 2:

dat = mphevalpoint(model,'Z','selection',2,'dataseries','max');

Evaluate the maximum value of the elevation with respect to the time at point 2:

dat = mphevalpoint(model,'Z','selection',2,'dataseries','rms'));
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See also mpheval, mphglobal, mphint2, mphinterp
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mphgeomPurpose Plot a geometry in a MATLAB figure.

Syntax mphgeom(model)
mphgeom(model,geomtag,...)

Description mphgeom(model) plots the model geometry in a MATLAB figure.

mphgeom(model,geomtag,...) plots the model geometry with the tag geomtag 
in a MATLAB figure.

The function mphgeom accepts the following property/value pairs:

The Build property determines if mphgeom build the geometry prior to display it. 
If the Build property is set with a geometric object tag, the geometry is built up to 
that object. mphgeom only displays built geometry objects.

TABLE 6-4:  PROPERTY/VALUE PAIRS FOR THE MPHGEOM COMMAND

PROPERTY VALUE DEFAULT DESCRIPTION

Parent Double Parent axes

Selection Positive 
integer 
array

Selection

Entity point | 
edge | 
boundary | 
domain

Geometric entity to 
select

Build on | off | 
current | 
string

on Build the geometry 
before plotting

Edgecolor Char k Edge color

Edgelabels on | off off Show edge labels

Edgelabelscolor Char k Color for edge labels

Edgemode on | off on Show edges

Facealpha Double 1 Set transparency value

Facelabels on | off off Show face labels

Facelabelscolor Char k Color for face labels

Facemode on | off on Show faces

Vertexlabels on | off off Show vertex labels

Vertexlabelscolor Char k Color for vertex 
labels

Vertexmode on | off off Show vertices
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Example Load shell_diffusion.mph from the Model Library:

model = mphload('shell_diffusion.mph');

Plot the geometry:

mphgeom(model)

Plot the geometry and boundaries 2,4,6,8,10,16,17,18,29 and 20 in subplot:

ax = subplot(1,2,1);
mphgeom(model,'geom1', ...
    'parent',ax, ...
    'edgecolor','k', ...
    'edgelabels','on', ...
    'alpha',0.5,...
    'edgelabelscolor','b', ...
    'vertexmode','on',...
    'edgemode','on');
ax = subplot(1,2,2);
mphgeom(model,'geom1', ...
    'parent',ax, ...
    'entity','boundary', ...
    'selection',[2:2:10,16:20]);

See also mphmesh, mphviewselection
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mphgetadjPurpose Return geometry entity indices that are adjacent to other.

Syntax n = mphgetadj(model,geomtag,returntype,adjtype,adjnumber)

Description n = mphgetadj(model,geomtag,returntype,adjtype,adjnumber) returns 
the indices of the adjacent geometry entities.

returntype is the type of the geometry entities whose index are returned.

adjtype is the type of the input geometry entity.

The entity type can be one of 'point', 'edge', 'boundary' or 'domain' 
following the entity space dimension defined below:

•  'domain': maximum geometry space dimension

•  'boundary': maximum geometry space dimension -1

• 'edges': 1(only for 3D geometry)

•  'point': 0

Example Load busbar.mph from the Model Library:

model = mphload('busbar.mph');

Returns the indices of the domains adjacent to point 2:

n = mphgetadj(model,'geom1','domain','point',2);

Returns the indices of the points adjacent to domains 2 and 3:

n = mphgetadj(model,'geom1','point','domain',[2 3]);

See also mphgetcoords, mphselectbox, mphselectcoords
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mphgetcoordsPurpose Return point coordinates of geometry entities.

Syntax c = mphgetcoords(model,geomtag,entitytype,entitynumber)

Description c = mphgetcoords(model,geomtag,entitytype,entitynumber) returns the 
coordinates of the points that belong to the entity object with the type entitytype 
and the index entitynumber.

The entitytype property can be one of 'point', 'edge', 'boundary' or 
'domain' following the entity space dimension defined below:

•  'domain': maximum geometry space dimension

•  'boundary': maximum geometry space dimension -1

• 'edge': 1 (only for 3D geometry)

 'point': 0

Example Load busbar.mph from the Model Library:

model = mphload('busbar.mph');

Return the coordinates of points that belong to domain 1:

c = mphgetcoords(model,'geom1','domain',1);

Return the coordinates of points that belong to boundary 5:

c = mphgeomcoords(model,'geom1','boundary',5);

Return the coordinates of point number 10:

c = mphgeomcoords(model,'geom1','point',10);

See also mphgetadj, mphselectbox, mphselectcoords
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mphgetexpressionsPurpose Get the model variables and model parameters expressions.

Syntax expr = mphgetexpressions(modelnode)

Description expr = mphgetexpressions(modelnode) returns expressions from the node 
modelnode as a cell array. expr contains the list of the variable names, the variable 
expressions and the variable descriptions.

Note that not all nodes have expressions defined.

Example Load example model busbar.mph from the Model Library:

model = mphload('stresses_in_pulley.mph');

Get the expressions defined in the parameters node:

expr = mphgetexpressions(model.param)

See also mphnavigator, mphmodel
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mphgetpropertiesPurpose Get the properties from a model node

Syntax mphproperties(modelnode)

Description mphproperties(modelnode) returns properties that are defined for the node 
modelnode.

Example Load busbar.mph from the Model Library:

model = mphload('busbar');

Get the properties of the node model.result('pg1'):

prop = mphgetproperties(model.result('pg1'))

See also mphnavigator
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mphgetselectionPurpose Get information about a selection node.

Syntax info = mphgetselection(selnode)

Description info = mphgetselection(selnode) returns the selection data of the selection 
node selnode.

The output info is a MATLAB structure defined with the following fields:

• dimension, the space dimension of the geometry entity selected.

• geom, the geometry tag.

• entities, the indexes of the selected entities.

• isGlobal, a Boolean expression that indicates if the selection is global.

Example Load busbar.mph from the Model Library:

model = mphload('busbar.mph');

Get the information of the selection node model.selection('sel1'):

info = mphgetselection(model.selection('sel1'))

See also mphnavigator
E R  6 :  C O M M A N D  R E F E R E N C E



mphgetu
mphgetuPurpose Return solution vector.

Syntax U = mphgetu(model,...)
[U,Udot] = mphgetu(model,...)

Description U = mphgetu(model) returns the solution vector U for the default solution data set.

[U,Udot] = mphgetu(model,...) returns in addition Udot, which is the time 
derivative of the solution vector. This syntax is available for a time-dependent 
solution only.

For a time-dependent and parametric analysis type, the last solution is returned by 
default. For an eigenvalue analysis type the first solution number is returned by 
default.

The function mphgetu accepts the following property/value pairs:

The Solname property set the solution data set to use associated with the defined 
solver node.

Type is used to select the solution type. This is 'Sol' by default. The valid types are: 
'Sol' (main solution), 'Reacf' (reaction force), 'Adj' (adjoint solution), 
'Fsens' (functional sensitivity) and 'Sens' (forward sensitivity).

If Solnum is a vector and the result has been obtained with the same mesh then the 
solution will be stored in a matrix if the Matrix option is set to 'on'

Example Load falling_sand.mph from the Model Library:

model = mphload('falling_sand.mph');

Get the solution vector for the last time step (default solution number):

u = mphgetu(model);

Get the solution vector and its derivative for solution number 9 and 10: 

[u,ut] = mphgetu(model,'solnum',[9 10]);

TABLE 6-5:  PROPERTY/VALUE PAIRS FOR THE MPHGETU COMMAND

PROPERTY VALUE DEFAULT DESCRIPTION

Solname String Auto Solver node tag

Solnum Positive integer 
vector

Auto Solution for evaluation

Type String Sol Solution type

Matrix off | on on Store as matrix if possible
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See also mphsolinfo
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mphglobal

Purpose Evaluate global quantities.

Syntax [d1,...,dn] = mphglobal(model,{e1,...,en},...)
[d1,...,dn,unit] = mphglobal(model,{e1,...,en},...)

Description [d1,...,dn] = mphglobal(model,{e1,...,en},...) returns the results from 
evaluating the global quantities specified in the string expression e1,..., en.

[d1,...,dn,unit] = mphglobal(model,{e1,...,en},...) also returns the 
unit of the expressions e1,..., en. unit is a nx1 cell array.

The function mphglobal accepts the following property/value pairs:

The property Dataset controls which data set is used for the evaluation. Data Sets 
contain or refer to the source of data for postprocessing purposes. Evaluation is 
supported only on solution data sets.

When the property Phase is used, the solution vector is multiplied with 
exp(i*phase) before evaluating the expression.

The expressions ei are evaluated for one or several solutions. Each solution 
generates an additional row in the output data array di. The property Solnum and 
t control which solutions are used for the evaluations. The Solnum property is 

TABLE 6-6:  PROPERTY/VALUE PAIRS FOR THE MPHGLOBAL COMMAND.

PROPERTY PROPERTY VALUE DEFAULT DESCRIPTION

Complexfun off | on on Use complex-valued 
functions with real input

Complexout off | on off Return complex values

Dataset String Active solution 
data set

Data set tag

Matherr off | on off Error for undefined 
operations or expressions

Outersolnum Positive 
integer

1 Solution number for 
parametric sweep

Phase Scalar 0 Phase angle in degrees

Solnum Integer vector 
| all | end

all Solution for evaluation

T Double array Time for evaluation

Unit String | cell 
array

Unit to use for the 
evaluation
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available when the data set has multiple solutions, for example in the case of 
parametric, eigenfrequency, or time-dependent solutions. The t property is 
available only for time-dependent problems. If Solnum is provided, the solutions 
indicated by the indices provided with the Solnum property are used. If t is provided 
solutions are interpolated. If neither Solnum nor t is provided, all solutions are 
evaluated.

For time-dependent problems, the variable t can be used in the expressions ei. The 
value of t is the interpolation time when the property t is provided, and the time 
for the solution, when Solnum is used. Similarly, lambda and the parameter are 
available as eigenvalues for eigenvalue problems and as parameter values for 
parametric problems, respectively.

In case of multiple expression if the unit property is defined with a string, the same 
unit is used for both expressions. To use different units, set the property with a cell 
array. In case of inconsistent unit definition, the default unit is used instead.

Solnum is used to select the solution number when a parametric, eigenvalue or 
time-dependent solver has been used.

Outersolnum is used to select the outer solution number when a parametric sweep 
has been used in the study step node.

Example Load fluid_valve.mph from the Model Library:

model = mphload('fluid_valve.mph');

Evaluate the global expression u_up for each time step:

u_up = mphglobal(model,'u_up')

Evaluate the global expression u_up at t = 0.8 sec:

u_up = mphglobal(model,'u_up','t',0.8)

Evaluate the expressions u_up and u_down at the last solution number:

[u_up,u_down] = 
mphglobal(model,{'u_up','u_down'},'solnum','end')

Evaluate the expressions u_up in mm^2/s and u_down in cm^2/s:

[u_up,u_down] = 
mphglobal(model,{'u_up','u_down'},'unit',{'mm^2/s','cm^2/s'});

See also mpheval, mphevalpoint, mphint2, mphinterp
E R  6 :  C O M M A N D  R E F E R E N C E



mphimage2geom
mphimage2geomPurpose Convert image data to geometry.

Syntax model = mphimage2geom(imagedata,level,...)

Description model = mphimage2geom(imagedata,level,...) convertes the image 
contained in imagedata into a geometry which is returned in the model object 
model.

The contour of the image is defined by the value level. imagedata must be a 2D 
matrix.

The function mphimage2geom accepts the following property/value pairs:

The default curve types creates a geometry with the best suited geometrical 
primitives. For interior curves this is Interpolation Curves and for curves that are 
touching the perimeter of the image, Polygons is used.

Example Create the geometry following the contour level 50 of an image data array provided 
by the function peaks:

p = (peaks+7)*5;
figure(1)
[c,h] = contourf(p)
clabel(c,h);
colorbar
model = mphimage2geom(p, 50);

TABLE 6-7:  PROPERTY/VALUE PAIRS FOR THE MPHIMAGE2GEOM COMMAND.

PROPERTY PROPERTY VALUE DEFAULT DESCRIPTION

Rtol Value 1e-3 Relative tolerance for 
interpolation curves

Type Solid | closed 
| open

solid Type of geometry object

Curvetype Auto | polygon auto Type of curve to create the 
geometry object

Scale Value 1 Scale factor from pixels to 
geometry scale

Mindist Value 1 Minimum distance between 
coordinates in curves (in 
pixels)

Compose on | off on Create compose nodes for 
overlapping solids

Rectangle on | off off Insert rectangle in the 
geometry
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figure(2);
mphgeom(model)
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mphint2Purpose Perform integration of expressions.

Syntax [v1,...,v2] = mphint2(model,{e1,...,en},edim,...)
[v1,...,v2,unit] = mphint2(model,{e1,...,en},edim,...)

Description [v1,...,vn] = mphint2(model,{e1,...,en},...) evaluates the integrals of 
the string expressions e1,...,en and returns the result in N matrices v1,...,vn 
with M rows and P columns. M is the number of inner solution and P the number 
of outer solution used for the evaluation. edim defines the element dimension, as a 
string: line, surface, volume or as an integer value. 

[v1,...,vn] = mphint2(model,{e1,...,en},...) also returns the units of the 
integral in a 1xN cell array.

The function mphint2 accepts the following property/value pairs:

The property Dataset controls which data set is used for the evaluation. Data Sets 
contain or refer to the source of data for postprocessing purposes. Evaluation is 
supported only on Solution Data Sets.

TABLE 6-8:  PROPERTY/VALUE PAIRS FOR THE MPHINT2 COMMAND.

PROPERTY PROPERTY VALUE DEFAULT DESCRIPTION

Dataset String active 
solution 
data set

Data set tag

Intorder Positive integer 4 Integration order

Intsurface on | off off Compute surface integral

Intvolume on | off off Compute volume integral

Matrix off | on on Returns data as a matrix or 
as a cell

Method auto | 
integration | 
summation

auto Integration method

Outersolnum Positive integer 1 Solution number for 
parametric sweep

Selection Integer vector | 
string | all

all Selection list or named 
selection

Solnum Integer vector | 
end | all

all Solution for evaluation

Squeeze on | off on Squeeze singleton 
dimensions

T Double array Time for evaluation
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The expressions e1,...,en are integrated for one or several solutions. Each 
solution generates an additional column in the returned matrix. The property 
Solnum and t control which solutions are used for the integrations. The Solnum 
property is available when the data set has multiple solutions, for example in the case 
of parametric, eigenfrequency, or time-dependent solutions. The t property is 
available only for time-dependent problems. If Solnum is provided, the solutions 
indicated by the indices provided with the Solnum property are used. If t is provided 
solutions are interpolated. If neither Solnum nor t is provided, all solutions are 
evaluated.

For time-dependent problems, the variable t can be used in the expressions ei. The 
value of t is the interpolation time when the property t is provided, and the time 
for the solution, when Solnum is used. Similarly, lambda and the parameter are 
available as eigenvalues for eigenvalue problems and as parameter values for 
parametric problems, respectively.

The unit property defines the unit of the integral, if a inconsistent unit is entered, 
the default unit is used. In case of multiple expression, if the unit property is 
defined with a string, the same unit is used for both expressions. To use different 
units, set the property with a cell array. In case of inconsistent unit definition, the 
default unit is used instead.

Solnum is used to select the solution number when a parametric, eigenvalue or 
time-dependent solver has been used.

Outersolnum is used to select the outer solution number when a parametric sweep 
has been used in the study step node.

Example Load micromixer.mph from the Model Library:

model = mphload('micromixer.mph');

Integrate the x-velocity u at the outlet boundary and get its unit:

[flow unit]= mphint2(model,'u','surface','selection',136)

Load heat_transfer_axi.mph from the Model Library:

model = mphload('heat_transient_axi.mph');

Integrate the normal heat flux along the external boundaries using surface 
integration:

Q = mphint(model,'ht.ndflux',1,'intsurface','on',...
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'selection',[2,3,4]);

See also mpheval, mphevalpoint, mphglobal, mphinterp
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mphinterpPurpose Evaluate expressions in arbitrary points or data sets.

Syntax [v1,...,vn] = mphinterp(model,{e1,...,en},'coord',coord,...)
[v1,...,vn] = mphinterp(model,{e1,...,en},'dataset',dsettag,...)
[v1,...,vn,unit] = mphinterp(model,{e1,...,en},...)

Description [v1,...,vn] = mphinterp(model,{e1,...,en},'coord',coord,...) 
evaluates expressions e1,...en at the coordinates specified in the double matrix 
coord. Evaluation is supported only on Solution Data Sets.

[v1,...,vn] = mphinterp(model,{e1,...,en},'dataset',dsettag,...) 
evaluates expressions e1,...en on the specified data set dsettag. In this case the 
data set needs to be of a type that defines an interpolation in itself, such as cut planes, 
revolve, and so forth.

[v1,...,vn,unit] = mphinterp(model,{e1,...,en},...) returns in addition 
the unit of the expressions.

The function mphinterp accepts the following property/value pairs:

TABLE 6-9:  PROPERTY/VALUE PAIRS FOR THE MPHINTERP COMMAND.

PROPERTY PROPERTY 
VALUE

DEFAULT DESCRIPTION

Complexfun off | on on Use complex-valued functions 
with real input

Complexout off | on off Return complex values

Coord Double 
array

Coordinates for evaluation

Coorderr off | on off Give an error message if all 
coordinates are outside the 
geometry

Dataset String Auto Data set tag

Edim 'point' | 
'edge' | 
'boundary' 
| 'domain' 
| 0 | 1 | 2 
| 3

Geometry 
space 
dimension

Element dimension for 
evaluation

Ext Value 0.1 Extrapolation control

Matherr off | on off Error for undefined operations 
or expressions

Outersolnum Positive 
integer

1 Solution number for parametric 
sweep
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The columns of the matrix coord are the coordinates for the evaluation points. If 
the number of rows in coord equals the space dimension, then coord are global 
coordinates, and the property Edim determines the dimension in which the 
expressions are evaluated. For instance, Edim='boundary' means that the 
expressions are evaluated on boundaries in a 3D model. If Edim is less than the space 
dimension, then the points in coord are projected onto the closest point on a 
domain of dimension Edim. If, in addition, the property Selection is given, then 
the closest point on domain number Selection in dimension Edim is used.

If the number of rows in coord is less than the space dimension, then these 
coordinates are parameter values on a geometry face or edge. In that case, the 
domain number for that face or edge must be specified with the property 
Selection.

The expressions that are evaluated can be expressions involving variables, in 
particular physics interface variables.

The matrices v1,...,vn are of the size k-by-size(coord,2), where k is the number 
of solutions for which the evaluation is carried out, see below. The value of 
expression ei for solution number j in evaluation point coord(:,m) is vi(j,m).

The vector pe contains the indices m for the evaluation points code(:,m) that are 
outside the mesh, or, if a domain is specified, are outside that domain.

Phase Scalar 0 Phase angle in degrees

Recover off | ppr | 
pprint

off Accurate derivative recovery

Selection Positive 
Integer 
array | all

all Selection list

Solnum Positive 
integer 
array | all 
| end

all Inner solutions for evaluation

T Double 
array

Time for evaluation

Unit String | 
Cell array

Unit to use for the evaluation

TABLE 6-9:  PROPERTY/VALUE PAIRS FOR THE MPHINTERP COMMAND.

PROPERTY PROPERTY 
VALUE

DEFAULT DESCRIPTION
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The property Data controls which data set is used for the evaluation. Data Sets 
contain or refer to the source of data for postprocessing purposes. Evaluation is 
supported only on Solution Data Sets. The active solution data set is used by default.

The property Edim decides which elements to evaluate on. Evaluation takes place 
only on elements with space dimension Edim. If not specified, Edim equal to the 
space dimension of the geometry is used. The setting is specified as one of the 
following strings 'point', 'edge', 'boundary' or 'domain'. In previous 
versions it was only possible to specify Edim as a number. For example, in a 3D 
model, if evaluation is done on edges (1D elements), Edim is 1. Similarly, for 
boundary evaluation (2D elements), Edim is 2, and for domain evaluation (3D 
elements), Edim is 3 (default in 3D).

Use Recover to recover fields using polynomial-preserving recovery. This 
techniques recover fields with derivatives such as stresses or fluxes with a higher 
theoretical convergence than smoothing. Recovery is expensive so it is turned off by 
default. The value pprint means that recovery is performed inside domains. The 
value ppr means that recovery is also applied on all domain boundaries.

The property Refine constructs evaluation points by making a regular refinements 
of each element. Each mesh edge is divided into Refine equal parts.

The property Smooth controls if the post data is forced to be continuous on element 
edges. When Smooth is set to internal, only elements not on interior boundaries are 
made continuous.

When the property Phase is used, the solution vector is multiplied with 
exp(i*phase) before evaluating the expression.

The expressions e1,...,en are evaluated for one or several solutions. Each solution 
generates an additional row in the data fields of the post data output structure. The 
property Solnum and t control which solutions are used for the evaluations. The 
Solnum property is available when the data set has multiple solutions, for example, 
in the case of parametric, eigenfrequency, or time-dependent solutions. The t 
property is available only for time-dependent problems. If Solnum is provided, the 
solutions indicated by the indices provided with the Solnum property are used. If t 
is provided solutions are interpolated. If neither Solnum nor t is provided, all 
solutions are evaluated.

For time-dependent problems, the variable t can be used in the expressions ei. The 
value of t is the interpolation time when the property t is provided, and the time 
for the solution, when Solnum is used. Similarly, lambda and the parameter are 
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available as eigenvalues for eigenvalue problems and as parameter values for 
parametric problems, respectively.

In case of multiple expression, if the unit property is defined with a string, the same 
unit is used for both expressions. To use different units, set the property with a cell 
array. In case of inconsistent unit definition, the default unit is used instead.

Solnum is used to select the solution number when a parametric, eigenvalue or 
time-dependent solver has been used.

Outersolnum is used to select the outer solution number when a parametric sweep 
has been used in the study step node.

Example Load heat_convection_2d.mph from the Model Library:

model = mphload('heat_convection_2d.mph');

Compute the temperature T at the center of the domain:

T = mphinterp(model,'T','coord',[0.3;0.5])

Load transport_and_adsorption.mph from the Model Library:

model = mphload('transport_and_asorption.mph');

Evaluate the concentration along boundary 5 at t = 2 s:

list = [0:1e-3:0.1 0.2:0.1:0.9 0.9:1e-3:1];
[c,y] = mphinterp(model,{'c','y'},'coord',list,'edim',1,...
                'selection',5,'t',2);

Load stresses_in_pulley.mph from the Model Library:

model = mphload('stresses_in_pulley.mph');

Evaluate the von Mises effective stress at the cut point data set cpt1:

[mises,n]= mphinterp(model,{'solid.mises','n'},...
    'datset','cpt1');

See also mpheval, mphevalpoint, mphglobal, mphint2
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mphloadPurpose Load a COMSOL model MPH-file.

Syntax model = mphload(filename)
model = mphload(filename, ModelObjectName)
model = mphload(filename, ModelObjectName, '-history')
[model, filename] = mphload(filename, ModelObjectName)

Description model = mphload(filename) loads a COMSOL model object saved with the 
name filename and assigns the default name Model in the COMSOL server.

model = mphload(filename, ModelObjectName) loads a COMSOL model 
object and assigns the name ModelObjectName in the COMSOL server.

model = mphload(filename, ModelObjectName, '-history') turns on 
history recording.

[model, filenameloaded] = mphload(filename, ModelObjectName) also 
returns the full file name filenameloaded of the file that was loaded.

If the model name is the same as a model that is currently in the COMSOL server 
the loaded model overwrites the existing one.

Note that MATLAB searches for the model on the MATLAB path if an absolute 
path is not supplied. 

mphload turns off the model history recording by default, unless the property 
'-history' is used.

The extension mph can be omitted.

Example Load transport_and_adsorption.mph from the Model Library:

model = mphload('transport_and_asorption.mph');

Load stresses_in_pulley.mph without specifying the mph extension:

model = mphload('stresses_in_pulley');

Load the model from MyModel.mph with the path specified:

model = mphload('PATH\MyModel.mph');

Load effective_diffusivity.mph from the Model Library and return the file 
name:

[model, filename] = mphload('effective_diffusivity.mph');

See also mphsave
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mphmatrixPurpose Get model matrices.

Syntax str = mphmatrix(model,soltag,'Out',...)

Description str = mphmatrix(model,soltag,'Out',{'A'},...) returns a MATLAB 
structure str containing the matrix A assembled using the solver node soltag and 
accessible as str.A. A being taken from the Out property list.

str = mphmatrix(model,soltag,fname,'Out',{'A','B',...}) returns a 
MATLAB structure str containing the matrices A, B, ... assembled using the solver 
node solname and accessible as str.A and str.B. A and B being taken from the 
Out property list.

The function mphmatrix accepts the following property/value pairs:

The following values are valid for the out property:

TABLE 6-10:  PROPERTY/VALUE PAIRS FOR THE MPHMATRIX COMMAND

PROPERTY EXPRESSION DEFAULT DESCRIPTION

out Cell array of 
strings

List of matrices to assemble

Initmethod init | sol Use linearization point

Initsol string | zero Active 
solver tag

Solution to use for 
linearization

Solnum Positive 
integer| auto

auto Solution number

Property/Value Pairs for the property out.

PROPERTY EXPRESSION DESCRIPTION

out K Stiffness matrix

L Load vector

M Constraint vector

N Constraint Jacobian

D Damping matrix

E Mass matrix

NF Constraint force Jacobian

NP Optimization constraint Jacobian (*)

MP Optimization constraint vector (*)

MLB Lower bound constraint vector (*)

MUB Upper bound constraint vector (*)
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(*) Requires the Optimization Module.

Note that the assembly of the eliminated matrices uses the current solution vector 
as scaling method. To get the unscaled eliminated system matrices, it is required to 
set the scaling method to 'none' in the variables step of the solver configuration 
node.

The load vector is assembled using the current solution available as linearization 
point unless the initmethod property is provided. In case of the presence of a solver 
step node in the solver sequence, the load vector correspond then to the residual of 
the problem.

Example Load heat_convection_2d.mph from the Model Library: 

model = mphload('heat_convection_2d.mph');

Extract the stiffness matrix and the load vector:

str = 
mphmatrix(model,'sol1','out',{'K','L'},'initmethod','init');

Plot the sparsity of the matrix:

spy(str.K)

Extract the eliminated system:

str = 
mphmatrix(model,'sol1','out',{'Kc','Lc'},'initmethod','init');

Compare the sparsity of both system matrices (non-eliminated (b) and eliminated 
one (r)):

hold on
spy(str.Kc,'r')

Kc Eliminated stiffness matrix

Lc Eliminated load vector

Dc Eliminated damping matrix

Ec Eliminated mass matrix

Null Constraint null-space basis

Nullf Constraint force null-space matrix

ud Particular solution ud

uscale Scale vector

Property/Value Pairs for the property out.

PROPERTY EXPRESSION DESCRIPTION
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Load heat_radiation_1d.mph from the model library:

model = mphload('heat_radiation_1d.mph');

Extract the eliminated residual:

str = mphmatrix(model,'sol1','out',{'Lc'});

See also mphstate, mphxmeshinfo
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mphmaxPurpose Perform maximum of expressions.

Syntax [v1,...,vn] = mphmax(model,{e1,...,en},edim,...)
[v1,...,vn,unit] = mphmax(model,{e1,...,en},edim,...)

Description [v1,...,vn] = mphmax(model,{e1,...,en},edim,...) evaluates the 
maximum of the string expressions e1,...,en and returns the result in N matrices 
v1,...,vn with M rows and P columns. M is the number of inner solution and P 
the number of outer solution used for the evaluation. edim defines the element 
dimension: line, surface, volume or as an integer value. 

[v1,...,vn] = mphmax(model,{e1,...,en},edim,...) also returns the units 
of the maximum in a 1xN cell array.

The function mphmax accepts the following property/value pairs:

The property Dataset controls which data set is used for the evaluation. Data Sets 
contain or refer to the source of data for postprocessing purposes. Evaluation is 
supported only on Solution Data Sets.

The maximum expressions e1,...,en is evaluated for one or several solutions. 
Each solution generates an additional column in the returned matrix. The property 
Solnum and t control which solutions are used for the evaluation. The Solnum 
property is available when the data set has multiple solutions, for example in the case 
of parametric, eigenfrequency, or time-dependent solutions. The t property is 

TABLE 6-11:  PROPERTY/VALUE PAIRS FOR THE MPHMAX COMMAND.

PROPERTY PROPERTY VALUE DEFAULT DESCRIPTION

Dataset String active 
solution 
data set

Data set tag

Matrix off | on on Returns data as a matrix or 
as a cell

Outersolnum Positive integer 
array

1 Solution number for 
parametric sweep

Selection Integer vector | 
string | all

all Selection list or named 
selection

Solnum Integer vector | 
end | all

all Solution for evaluation

Squeeze on | off on Squeeze singleton 
dimensions

T Double array Time for evaluation
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available only for time-dependent problems. If Solnum is provided, the solutions 
indicated by the indices provided with the Solnum property are used. If t is provided 
solutions are interpolated. If neither Solnum nor t is provided, all solutions are 
evaluated.

Solnum is used to select the solution number when a parametric, eigenvalue or 
time-dependent solver has been used.

Outersolnum is used to select the outer solution number when a parametric sweep 
has been used in the study step node.

If the Matrix property is set to off the output will be cell arrays of length P 
containing cell arrays of length M.

Example Load micromixer.mph from the Model Library:

model = mphload('micromixer.mph');

Find the maximum x-velocity u at the outlet boundary and get its unit:

[flow unit]= mphmax(model,'u','surface','selection',136)

Load heat_transfer_axi.mph from the Model Library:

model = mphload('heat_transient_axi.mph');

Find the max normal heat flux along the external boundaries:

Q = mphmax(model,'ht.ndflux','line','selection',[2,3,4]);

See also mphmean, mphmin 
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mphmeanPurpose Perform mean of expressions.

Syntax [v1,...,vn] = mphmean(model,{e1,...,en},edim,...)
[v1,...,vn,unit] = mphmean(model,{e1,...,en},edim,...)

Description [v1,...,vn] = mphmean(model,{e1,...,en},edim,...) evaluates the means 
of the string expressions e1,...,en and returns the result in N matrices v1,...,vn 
with M rows and P columns. M is the number of inner solution and P the number 
of outer solution used for the evaluation. edim defines the element dimension: 
line, surface, volume or as an integer value. 

[v1,...,vn] = mphmean(model,{e1,...,en},edim,...) also returns the units 
of the maximum in a 1xN cell array.

The function mphmean accepts the following property/value pairs:

The property Dataset controls which data set is used for the evaluation. Data Sets 
contain or refer to the source of data for postprocessing purposes. Evaluation is 
supported only on Solution Data Sets.

The mean of expressions e1,...,en is evaluated for one or several solutions. Each 
solution generates an additional column in the returned matrix. The property 

TABLE 6-12:  PROPERTY/VALUE PAIRS FOR THE MPHMEAN COMMAND.

PROPERTY PROPERTY VALUE DEFAULT DESCRIPTION

Dataset String active 
solution 
data set

Data set tag

Intorder Positive integer 4 Integration order

Matrix off | on on Returns data as a matrix or 
as a cell

Method auto | 
integration | 
summation

auto Integration method

Outersolnum Positive integer 
array

1 Solution number for 
parametric sweep

Selection Integer vector | 
string | all

all Selection list or named 
selection

Solnum Integer vector | 
end | all

all Solution for evaluation

Squeeze on | off on Squeeze singleton 
dimensions

T Double array Time for evaluation
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Solnum and t control which solutions are used for the evaluation. The Solnum 
property is available when the data set has multiple solutions, for example in the case 
of parametric, eigenfrequency, or time-dependent solutions. The t property is 
available only for time-dependent problems. If Solnum is provided, the solutions 
indicated by the indices provided with the Solnum property are used. If t is provided 
solutions are interpolated. If neither Solnum nor t is provided, all solutions are 
evaluated.

Solnum is used to select the solution number when a parametric, eigenvalue or 
time-dependent solver has been used.

Outersolnum is used to select the outer solution number when a parametric sweep 
has been used in the study step node.

If the Matrix property is set to off the output will be cell arrays of length P 
containing cell arrays of length M.

Example Load micromixer.mph from the Model Library:

model = mphload('micromixer.mph');

Find the mean x-velocity u at the outlet boundary and get its unit:

[flow unit]= mphmean(model,'u','surface','selection',136)

Load heat_transfer_axi.mph from the Model Library:

model = mphload('heat_transient_axi.mph');

Find the mean normal heat flux along the external boundaries:

Q = mphmean(model,'ht.ndflux','line','selection',[2,3,4]);

See also mphmax, mphmin 
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mphmeshPurpose Plot a mesh in a MATLAB figure window.

Syntax mphmesh(model)
mphmesh(model,meshtag,...)

Description mphmesh(model) plots the mesh case in a MATLAB figure.

mphmesh(model,meshtag,...) plots the mesh case meshtag in a MATLAB 
figure.

The function mphmesh accepts the following property/value pairs: 

Example Load the example model shell_diffusion.mph from the Model Library:

model=mphload('shell_diffusion.mph');

Plot the model mesh:

mphmesh(model,)

Plot the mesh with a colored element and transparency set to 0.5:

mphmesh(model, 'mesh1', ...
          'edgecolor', 'b', ...
          'facealpha',0.5,...
          'meshcolor','r');

See also mphgeom, mphmeshstats, mphplot

TABLE 6-13:  PROPERTY/VALUE PAIRS FOR THE MPHMESH COMMAND

PROPERTY VALUE DEFAULT DESCRIPTION

Parent Double Parent axis

Edgecolor Char k Edge color

Edgelabels on | off off Show edge labels

Edgelabelscolor Char k Color for edge labels

Edgemode on | off on Show edges

Facealpha Double 1 Set transparency value

Facelabels on | off off Show face labels

Facelabelscolor Char k Color for face labels

Facemode on | off on Show faces

Meshcolor Char flat Color for face element

Vertexlabels on | off off Show vertex labels

Vertexlabelscolor Char k Color for vertex labels

Vertexmode on | off off Show vertices
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mphmeshstatsPurpose Return mesh statistics and mesh data information

Syntax stats = mphmeshstats(model)
stats = mphmeshstats(model, meshtag)
[stats,data] = mphmeshstats(model, meshtag)

Description stats = mphmeshstats(model) returns mesh statistics of the model mesh case in 
the structure str.

stats = mphmeshstats(model, meshtag) returns mesh statistics of a mesh case 
meshtag in the structure str.

[stats,data] = mphmeshstats(model, meshtag) returns in addition the mesh 
data information such as vertex coordinates and definitions of elements in the 
structure data.

The output structure stats contains the following fields:

The output structure data contains the following fields:

TABLE 6-14:  FIELDS IN THE STATS STRUCTURE

FIELD DESCRIPTION

Meshtag Mesh case tag

Isactive Is the mesh node active

Hasproblems Does the mesh have problems?

Iscomplete Is the mesh built to completion?

Sdim Space dimension

Types Cell array with type names

Numelem Vector with the number of elements for each type

Minquality Minimum quality

Meanquality Mean quality

Qualitydistr Quality distribution (vector)

Minvolume Volume/area of the smallest element

Maxvolume Volume/area of the largest element

Volume Volume/area of the mesh

TABLE 6-15:  FIELDS IN THE DATA STRUCTURE

FIELD DESCRIPTOIN

Vertex Coordinates of mesh vertices
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Example Load busbar.mph from the Model Library

model = mphload('busbar');

Show the mesh distribution in a figure

stats = mphmeshstats(model);
bar(linspace(0,1,20), stats.qualitydistr)

Show the element vertices in a plot

[stats,data] = mphmeshstats(model);
plot3(data.vertex(1,:), data.vertex(2,:), ...
data.vertex(3,:), '.')
axis equal
view(3)

Get the element types information

stats.types

Get the number of edge element, note that the edge type is the first type in the list

numedgeelem = stats.numelem(1)

See also mphmesh

Elem Cell array of definition of each element type

Elementity Entity information for each element type

TABLE 6-15:  FIELDS IN THE DATA STRUCTURE

FIELD DESCRIPTOIN
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mphminPurpose Perform minimum of expressions.

Syntax [v1,...,vn] = mphmin(model,{e1,...,en},edim,...)
[v1,...,vn,unit] = mphmin(model,{e1,...,en},edim,...)

Description [v1,...,vn] = mphmin(model,{e1,...,en},edim,...) evaluates the 
minimum of the string expressions e1,...,en and returns the result in N matrices 
v1,...,vn with M rows and P columns. M is the number of inner solution and P 
the number of outer solution used for the evaluation. edim defines the element 
dimension: line, surface, volume or as an integer value. 

[v1,...,vn] = mphmin(model,{e1,...,en},edim,...) also returns the units 
in a 1xN cell array.

The function mphmin accepts the following property/value pairs:

The property Dataset controls which data set is used for the evaluation. Data Sets 
contain or refer to the source of data for postprocessing purposes. Evaluation is 
supported only on Solution Data Sets.

The mean of expressions e1,...,en is evaluated for one or several solutions. Each 
solution generates an additional column in the returned matrix. The property 
Solnum and t control which solutions are used for the evaluation. The Solnum 
property is available when the data set has multiple solutions, for example in the case 
of parametric, eigenfrequency, or time-dependent solutions. The t property is 

TABLE 6-16:  PROPERTY/VALUE PAIRS FOR THE MPHMIN COMMAND.

PROPERTY PROPERTY VALUE DEFAULT DESCRIPTION

Dataset String active 
solution 
data set

Data set tag

Matrix off | on on Returns data as a matrix or 
as a cell

Outersolnum Positive integer 
array

1 Solution number for 
parametric sweep

Selection Integer vector | 
string | all

all Selection list or named 
selection

Solnum Integer vector | 
end | all

all Solution for evaluation

Squeeze on | off on Squeeze singleton 
dimensions

T Double array Time for evaluation
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available only for time-dependent problems. If Solnum is provided, the solutions 
indicated by the indices provided with the Solnum property are used. If t is provided 
solutions are interpolated. If neither Solnum nor t is provided, all solutions are 
evaluated.

Solnum is used to select the solution number when a parametric, eigenvalue or 
time-dependent solver has been used.

Outersolnum is used to select the outer solution number when a parametric sweep 
has been used in the study step node.

If the Matrix property is set to off the output will be cell arrays of length P 
containing cell arrays of length M.

Example Load micromixer.mph from the Model Library:

model = mphload('micromixer.mph');

Find the minimum x-velocity u at the outlet boundary and get its unit:

[flow unit]= mphmin(model,'u','surface','selection',136)

Load heat_transfer_axi.mph from the Model Library:

model = mphload('heat_transient_axi.mph');

Find the minimum normal heat flux along the external boundaries:

Q = mphmin(model,'ht.ndflux','line','selection',[2,3,4]);

See also mphmax, mphmean 
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mphmodelPurpose Return tags for the nodes and subnodes in the COMSOL model object.

Syntax mphmodel(model)
str = mphmodel(model,'-struct')

Description mphmodel(model) returns the tags for the nodes and subnodes of the object model.

str = mphmodel(model,'-struct') returns the tags for the nodes and subnodes 
of the object model as a MATLAB structure str.

The function mphmodel can be used when navigating the model object and learning 
about its structure. The mphmodel function is mainly designed for usage when 
working on the command line and one needs to learn what nodes are placed under 
a particular node.

Example Load transport_and_adsorption.mph from the Model Library:

model = mphload('transport_and_adsorption')

See what nodes are available under the model object:

mphmodel(model)

See what nodes are available under the geometry node:

mphmodel(model.geom)

Get the model information as a structure:

res = mphmodel(model, '-struct')

See also mphnavigator, mphsearch
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mphmodellibraryPurpose Graphical User Interface for viewing the Model Library.

Syntax mphmodellibrary

Description mphmodellibrary starts a GUI to visualize and access the example model available 
in the COMSOL Model Library. The model MPH-file can be loaded in MATLAB 
and the model documentation PDF-file is accessible directly. Models that are 
specific to LiveLink for MATLAB also contains the script M-file.
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mphnavigatorPurpose Graphical User Interface for viewing the COMSOL model object 

Syntax mphnavigator
mphnavigator(modelvariable)

Description mphnavigator opens the Model Object Navigator which is a graphical user 
interface that can be used to navigate the model object and to view the properties 
and methods of the nodes in the model tree.

The GUI requires that the COMSOL objest is stored in a variable in the base 
workspace (at the MATLAB command prompt) with the name model.

mphnavigator(modelvariable) opens the model object defined with the name 
modelvariable in Model Object Navigator.

Example Load busbar.mph from the Model Library:

model = mphload('busbar')

Navigate the model object that is accessible with the variable model

mphnavigator
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Load effective_diffusivity.mph from the Model Library and set the model 
object with the variable eff_diff:

eff_diff = mphload('effective_diffusivity');

Navigate the model object that is accessible with the variable eff_diff

mphnavigator(eff_diff)

See also mphgetexpressions, mphgetproperties, mphgetselection, 
mphmodel, mphsearch
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mphplotPurpose Render a plot group in a figure window.

Syntax mphplot(model,pgtag,...)
pd = mphplot(model,pgtag,...)
mphplot(pd,...)

Description mphplot(model,pgtag,...) renders the plot group tagged pgtag from the 
model object model in a figure window in MATLAB.

pd = mphplot(model,pgtag,...) also returns the plot data used in the MATLAB 
figure in a cell array pd. 

mphplot(pd,...) makes a plot using the post data structure pd that is generated 
using the function mpheval. Plots involving points, lines and surfaces are supported.

The function mphplot accepts the following property/value pairs:

Note: The plot on server option requires that you start COMSOL with MATLAB 
in graphics mode.

Only one color range bar and one legend bar is supported in a MATLAB figure. 
When the option plot on server is active, all active color range bar are displayed.

Example Load feeder_clamp.mph from the Model Library:

model = mphload('feeder_clamp.mph');

Plot the first plot group

mphplot(model,'pg1')

Plot the first plot group with the color range bar: 

TABLE 6-17:  PROPERTY/VALUE PAIRS FOR THE MPHPLOT COMMAND

PROPERTY VALUE DEFAULT DESCRIPTION

Colortable String Rainbow Color table used for plotting 
post data structure 

Index Positive 
integer

1 Index of variable to use plotting 
post data structure

Rangenum Positive 
Integer

none Color range bar (or legend) to 
display

Server on | off off Plot on server

Parent Double Set the parent axes
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mphplot(model,'pg1','rangenum',1)

Load fluid_valve.mph and plot on server (requires that you start COMSOL with 
MATLAB in graphics mode):

model = mphload('fluid_valve.mph');

Plot the second plot group on server:

mphplot(model,'pg2','server','on')

Load busbar.mph from the Model Library:

model = mphload('busbar.mph')

Extract temperature and electric potential data in the busbar domain:

pd = mpheval(model,{'T','V'},'selection',1);

Plot the electric potential data using the disco color table

mphplot(pd,'index',2,'colortable','disco')

See also colortable, mpheval
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mphsavePurpose Save a COMSOL model

Syntax mphsave(model)
mphsave(model, filename)

Description mphsave(model) saves the COMSOL model object model.

mphsave(model, filename) saves the COMSOL model object model to the file 
named filename.

If the file name is not provided, the model has to be saved previously on disk.

If the file name does not provide a path, the file is saved relatively to the current path 
in MATLAB.

The model can be saved as an mph-file, java-file or as an m-file. The file extension 
determines which format that is saved.

See also mphload
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mphsearchPurpose GUI for searching expressions in the COMSOL model object 

Syntax mphsearch(model)

Description mphsearch(model) opens a graphical user interface that can be used to search 
expressions in the model object model. Search using a text available in the name, 
expression or description of the variable.

See also mphgetexpressions, mphnavigator
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mphselectboxPurpose Select geometric entity using a rubberband/box.

Syntax n = mphselectbox(model,geomtag,boxcoord,entity,...)

Description n = mphselectbox(model,geomtag,boxcoord,entity,...) returns the indices 
of the geometry entities that are inside a selection domain (rectangle or box). This 
method looks only on the vertex coordinates and does not observe all points on 
curves and surfaces.

boxcoord set the coordinates of the selection domain, specified as a Nx2 array, 
where N is the geometry space dimension.

entity can be one of 'point', 'edge', 'boundary' or 'domain' following the 
entity space dimension defined below:

•  'domain': maximum geometry space dimension

•  'boundary': maximum geometry space dimension -1

•  'edges': 1(only for 3D geometry)

The function mphpselectbox accepts the following property/value pairs:

When a model uses form an assembly more than one vertex may have the same 
coordinate if the coordinate is shared by separate geometric objects. In that case one 
can use the adjnumber property in order to identify the domain that the vertices 
should be adjacent to.

Example Load busbar.mph from the Model Library:

model = mphload('busbar.mph')

Find domains that are inside the selection box defined by 
[0,0.05;0,-0.05;-0.05,0.05]:

n = mphselectbox(model,'geom1',...
[0 0.05;0 -0.05;-0.05 0.05],'domain');

Find boundaries inside the selection box that are adjacent to domain number 1:

n = mphselectbox(model,'geom1',...
[0,0.05;0,-0.05;-0.05,0.05],'boundary','adjnumber',1);

TABLE 6-18:  PROPERTY/VALUE PAIRS FOR THE MPHSELECTBOX COMMAND

PROPERTY VALUE DEFAULT DESCRIPTION

Adjnumber Scalar none Adjacent entity number
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Load effective_diffusivity.mph from the Model Library:

model = mphload('effective_diffusivity.mph');

Find the boundaries that are inside the selection rectangle defined by 
[3e-4,4e-4;4.5e-4,5.5e-4]:

n = mphselectbox(model,'geom1',...
[3e-4,4e-4;4.5e-4,5.5e-4],'boundary');

Find the boundaries that are inside the same selection rectangle:

n = mphselectbox(model,'geom1',...
[3e-4,4e-4;4.5e-4,5.5e-4],'point');

See also mphgetadj, mphgetcoords, mphselectcoords
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mphselectcoordsPurpose Select geometric entity using point coordinates

Syntax n = mphselectcoords(model,geomtag,coord,entity,...)

Description n = mphselectcoords(model,geomtag,coord,entity,...) finds geometry 
entity numbers based on their vertex coordinates.

One or more coordinate may be provided. The function searches for vertices near 
these coordinates using a tolerance radius. The list of the entities that are adjacent 
to such vertices is returned.

Coord is a NxM array where N correspond of the number of point to use and M the 
space dimension of the geometry.

Entity can be one of 'point', 'edge', 'boundary' or 'domain' following the 
entity space dimension defined below:

•  'domain': maximum geometry space dimension

•  'boundary': maximum geometry space dimension -1

•  'edges': 1(only for 3D geometry)

The function mphpselectcoords accepts the following property/value pairs:

When a model uses form an assembly more than one vertex may have the same 
coordinate if the coordinate is shared by separate geometric objects. In that case one 
can use the adjnumber property in order to identify the domain that the vertices 
should be adjacent to.

The radius property is used to specify the radius of the sphere/circle that the 
search should be within. A small positive radius (based on the geometry size) is used 
by default in order to compensate for rounding errors.

If the include property is 'all' then all vertices must belong to the entity in to be 
considered a match. If the Include property is 'any' then an entity is considered 
a match as long as any of the vertices are adjacent to the entity.

Examplee Load busbar.mph from the Model Library:     

TABLE 6-19:  PROPERTY/VALUE PAIRS FOR THE MPHSELECTCOORDS COMMAND

PROPERTY VALUE DEFAULT DESCRIPTION

Adjnumber Scalar none Adjacent entity number

Radius Scalar auto Search radius

Include all | any all Include all or any vertices
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model = mphload('busbar.mph');

Select the vertex near [0.095,0,0.1]:

n = mphselectcoords(model,'geom1',... [0.095,0,0.1],'point');

Select the edge from [0.095,0,0.1] to [0.095,0,0.01]:

n = mphselectcoords(model, 'geom1',...
[0.095,0,0.1;0.095,0,0.01]','edge');

Select edges that are adjacent to the points [0.095,0,0.1] and [0.095,0,0.01]:

n = mphselectcoords(model, 'geom1',...
[0.095,0,0.1;0.095,0,0.01]','edge',... 'include', 'any');

Select boundaries that are adjacent to the points [0.09,0,0.1] and [0.09,0,0.015] 
with a search radius of 0.01:

n = mphselectcoords(model,'geom1',...
[0.09,0,0.1;0.09,0,0]','boundary',... 'radius',0.01);

See also mphgetadj, mphgetcoords, mphselectbox
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mphshowerrorsPurpose Show messages in error nodes in the COMSOL model

Syntax mphshowerrors(model)
list = mphshowerrors(model)

Description mphshowerrors(model) shows the error and warning messages stored in the model 
and where they are located. The output is displayed in the command window.

list = mphshowerrors(model) returns the error and warning messages stored in 
the model and where they are located in the Nx2 cell array list. N corresponding to 
the number of errors or warning found in the model object. The first column 
contains the node of the error and the second column contain the error message.

See also mphnavigator
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mphsolinfoPurpose Get information about a solution object

Syntax info = mphsolinfo(model,...)
info = mphsolinfo(model,'solname',soltag,...)

Description info = mphsolinfo(model,...) returns information about the default solution 
obejct.

info = mphsolinfo(model,'solname',soltag,...) returns information about 
the solution obejct soltag.

The function mphsolinfo accepts the following property/value pairs:

The returned value info is a structure with the following content

TABLE 6-20:  PROPERTY VALUE PAIRS FOR THE MPHSOLINFO COMMAND

PROPERTY VALUE DEFAULT DESCRIPTION

Solname String Active solution 
object

Solution object tag

Dataset String Active 
solution data 
set

Data set tag

NU on | off off Get info about number 
of solutions

TABLE 6-21:  FIELDS IN THE INFO STRUCT

FIELD CONTENT

Solname Solution name

Size Size of the solution vector

Nummesh Number of meshes in the solution (for automatic 
remeshing)

Sizes Size of the solution vector for each mesh and number of 
timesteps/parameters for each mesh

Soltype Solver type (Stationary, Parametric, Time or Eigenvalue)

Solpar Name of the parameter

Sizesolvals Length of the parameter list

Solvals Values of the parameters, eigenvalues or timesteps

Paramsweepnames Parametric sweep parameter names

Paramsweepvals Parametric sweep parameter values

NUsol Number of solution vectors stored

NUreacf Number of reaction forces vectors stored
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You can use the function mphgetu to obtain the actual values of the solution vector. 
Note that these functions are low level functions and you most often would use 
functions such as mphinterp and mpheval to extract numerical data from a model.

Examplee Load stress_in_pulley.mph from the Model Library 

model = mphload('stress_in_pulley.mph');

Get the information of the active solution object

info = mphsolinfo(model);

Get the information of the second solution object

info = mphsolinfo(model,'solname',sol2);

See also mphgetu, mphxmeshinfo

NUadj Number of adjacency vectors stored

NUfsens Number of functional sensitivity vectors stored

NUsens Number of forward sensitivity vectors stored

TABLE 6-21:  FIELDS IN THE INFO STRUCT

FIELD CONTENT
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mphstartPurpose Connect MATLAB to a COMSOL server.

Syntax mphstart
mphstart(port)
mphstart(ipaddress, port)
mphstart(ipaddress, port, comsolpath)

Description mphstart creates a connection with a COMSOL server using the default port 
number (which is 2036).

mphstart(port) creates a connection with a COMSOL server using the specified 
port number port.

mphstart(ipaddress, port) creates a connection with a COMSOL server using 
the specified IP address ipaddress and the port number port.

mphstart(ipaddress, port, comsolpath) creates a connection with a 
COMSOL server using the specified IP address and port number using the 
comsolpath that is specified. This is useful if mphstart cannot find the location of 
the COMSOL Multiphysics installation.

mphstart can be used to create a connection from within MATLAB when this is 
started without using the COMSOL with MATLAB option. mphstart then sets up 
the necessary environment and connect to COMSOL.

Prior to calling mphstart it is necessary to set the path of mphstart.m in the 
MATLAB path or to change the current directory in MATLAB (for example, using 
the cd command) to the location of the mphstart.m file.

A COMSOL server must be started prior to running mphstart.
E R  6 :  C O M M A N D  R E F E R E N C E



mphstate
mphstatePurpose Get state-space matrices for dynamic system.

Syntax str = mphstate(model,soltag,'Out',{'SP'})
str = mphstate(model,soltag,'Out',{'SP1','SP2',...})

Description str = mphstate(model,soltag,'out',{'SP'}) returns a MATLAB structure 
str containing the state space matrix SP assembled using the solver node soltag 
and accessible as str.SP. SP being taken from the Out property list.

str = mphstate(model,soltag,'Out',{'SP1','SP2',...}) returns a 
MATLAB structure str containing the state space matrices SP1, SP2,... assembled 
using the solver node soltag and accessible as str.SP1and str.SP2. SP1 and SP2 
being taken from the Out property list.

The function mphstate accepts the following property/value pairs:

The property Sparse controls whether the matrices A, B, C, D, M, MA, MB, and Null 
are stored in the sparse format. 

The equations correspond to the system below:

where x are the state variables, u are the input variables, and y are the output 
variables.

TABLE 6-22:  PROPERTY VALUE FOR THE MPHSTATE COMMAND

PROPERTY VALUE DEFAULT DESCRIPTION

Out MA | MB | A | B | 
C | D |Mc |Null | 
ud | x0 

Output matrix

Keepfeature off | on off Keep the state-space feature in 
the model

Input String Input variables

Output String Output variables

Sparse off | on off Return sparse matrices

Initmethod init | sol Use linearization point

Initsol solname | zero solname Solution to use for 
linearization

Solmum Positive integer auto Solution number

Mcx· McAx McBu+=

y Cx Du+=


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A static linearized model of the system can be described by:

The full solution vector U can be then obtained from

where Null is the null space matrix, ud the constraint contribution and u0 is the 
linearization point, which is the solution stored in the sequence once the state space 
export feature is run. 

The matrices Mc and MA are produced by the same algorithms that do the 
finite-element assembly and constraint elimination in COMSOL Multiphysics. Mc 
and MA are the same as the matrices Dc (eliminated mass matrix) and Kc (Kc is the 
eliminated stiffness matrix). The matrices are produced from an exact residual vector 
Jacobian calculation (that is, differentiation of the residual vector with respect to the 
degrees of freedoms x) plus an algebraic elimination of the constraints. The matrix 
C is produced in a similar way; that is, the exact output vector Jacobian matrix plus 
constraint elimination.

The matrices MB and D are produced by a numerical differentiation of the residual 
and output vectors, respectively, with respect to the input parameters (the algorithm 
systematically perturbs the input parameters by multiplying them by a factor 
(1+10-8)).

The input cannot be a variable constraint in the model.

Example Load heat_transient_axi.mph from the Model Library

model = mphload('heat_transient_axi.mph');

Set the temperature condition using a parameter

model.param.set('Tinput','1000[degC]');
temp1 = model.physics('ht').feature('temp1');
temp1.set('T0',1,'Tinput');

Add a domain point probe at (0.28; 0.38)

pdom1 = model.probe.create('pdom1,'DomainPoint');
pdom1.model('mod1');
pdom1.setIndex('coords2','0.28',0,0);
pdom1.setIndex('coords2','0.38',0,1);

Extract the state-space matrix:

y D C McA  1– McB– u=

U Nullx ud u0+ +=
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str = mphstate(model,'sol1','out',... 
{'MA','MB','C','D'},'input','T0',... 'output','mod1.ppb1');
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mphversionPurpose Return the version number of COMSOL Multiphysics

Syntax v = mphversion
[v,vm] = mphversion(model)

Description v = mphversion returns the COMSOL Multiphysics version number that 
MATLAB is connected to as a string.

[v,vm] = mphversion(model) returns the COMSOL Multiphysics version 
number that MATLAB is connected to as a string in the variable v and the version 
number of the model in the variable vm.

See also mphload, mphsave
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mphviewselectionPurpose Display a geometric entity selection in a MATLAB figure.

Syntax mphviewselection(model,geomtag,number,'entity', entity,...)
mphviewselection(model,seltag,...)

Description mphviewselection(model,geomtag,number,'entity', entity,...) displays 
the geometric entity number of type entity in MATLAB figure including the 
representation of the geometry geomtag.

mphviewselection(model,seltag,...) displays the geometric entity selection 
seltag in a MATLAB figure including the representation of the geometry.

The function mphviewselection accepts the following property/value pairs:

TABLE 6-23:  PROPERTY VALUE/PAIRS FOR THE MPHVIEWSELECTION FUNCTION

PROPERTY VALUE DEFAULT DESCRIPTION

Edgecolor Char | RGB 
array

k Color for edges 

Edgecolorselected RGB array [1,0,0] Color for selected 
edges

Edgelabels on | off off Show edge labels

Edgelabelscolor Char | RGB 
array

g Color for edge labels

Edgemode on | off on Show edges

Entity Domain | 
boundary | 
edge | point

Set the selected entity 
type

Facealpha Double 1 Set transparency value

Facecolor RGB array [0.6,0.6,0.6] Color for face

Facecolorselected RGB array [1,0,0] Color for selected 
face

Facelabels on | off off Show face labels

Facelabelscolor Char | RGB 
array

b Color for face labels

Facemode on | off on Show faces

Geommode on | off on Show entire geometry

Marker . Vertex marker

Markercolor Char | RGB 
array

b Color for vertex 
marker

Markercolorselected Char | RGB 
array

r Color for selected 
vertex marker
253



mphviewselection

254 |  C H A P T
Example Load busbar.mph from the Model Library:

model = mphload('busbar')

Plot boundary number 3 using a yellow color

mphviewselection(model,'geom1',3,'entity',... 
'boundary','facecolorselected',[1 1 0],... 'facealpha', 0.5)

Plot edge 1 to 9 in green color

hold on
mphviewselection(model,'geom1',1:8,... 
'geommode','off','entity','edge',... 'edgecolorselected', [0 1 
0.5])

Plot the titanium blot domains in green color

mphviewselection(model,'sel1',... 'facecolorselected',[0 1 0])

See also mphgeom, mphselectbox, mphselectcoords

Markersize Int 12 Font size of marker

Parent Double Parent axis

Renderer Opengl | 
zbuffer

opengl Set the rendering 
method

Selection String | 
Positive 
integer array

Set selection name or 
entity number

Selectoralpha Double 0.25 Set selector 
transparency value

Selectorcolor RGB array [0,0,1] Color for selected 
marker

Showselector on | off on Show Selector

Vertexlabels on | off off Show vertex labels

Vertexlabelscolor Char | RGB 
array

r Color for vertex 
labels

Vertexmode on | off off Show vertices

TABLE 6-23:  PROPERTY VALUE/PAIRS FOR THE MPHVIEWSELECTION FUNCTION

PROPERTY VALUE DEFAULT DESCRIPTION
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mphxmeshinfoPurpose Extract information about the extended mesh.

Syntax info = mphxmeshinfo(model)

Description The Xmesh information provide information about the numbering of elements, 
nodes, and degrees of freedom (DOFs) in the extended mesh and in the matrices 
returned by mphmatrix and mphgetu

Information is only available on StudyStep and Variables features.

The function mphxmeshinfo accepts the following property/value pairs:

The function xmeshinfo returns a structure with the fields shown in the table below

Example Load busbar.mph from the Model Library:

model = mphload('busbar.mph')

Extract xmesh information for the active Solver feature:

info = mphxmeshinfo(model)

Extract xmesh information from the Study Step node st1

TABLE 6-24:  PROPERTY VALUE/PAIRS FOR THE MPHVIEWSELECTION FUNCTION

PROPERTY VALUE DEFAULT DESCRIPTION

Solname String Active 
solution 
object

Solution object tag

Studysteptag String Study step node tag

Meshcase Positive 
integer | 
String

First mesh Mesh case tag

TABLE 6-25:  FIELD IN THE RETURNED STRUCTURE FROM MPHXMESHINFO

FIELD DESCRIPTION

Solname Tag of the solution object

Ndofs Number of DOFs

Fieldnames Names of the field variables

Fieldndofs Number of DOFs per field name

Meshtypes Types of mesh element

Dofs Structure with information about the degrees of 
freedom

Nodes Struct with information about the nodes

Elements Struct with information about each element type
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info = mphxmeshinfo(model,'solname','sol1','studysteptag','st1')

See also: mphgetu, mphmatrix, mphsolinfo
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